
МИНИСТЕРСТВО СЕЛЬСКОГО ХОЗЯЙСТВА  
И ПРОДОВОЛЬСТВИЯ РЕСПУБЛИКИ БЕЛАРУСЬ 

 
Учреждение образования 

«БЕЛОРУССКИЙ ГОСУДАРСТВЕННЫЙ 
АГРАРНЫЙ ТЕХНИЧЕСКИЙ УНИВЕРСИТЕТ» 

 
 
 
 
 

Н. М. Матвейчук, А. Г. Сеньков  
 
 
 

ТЕОРИЯ АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ. 
ЛАБОРАТОРНЫЙ ПРАКТИКУМ 

 
Рекомендовано Учебно-методическим объединением  

по образованию в области автоматизации технологических  
процессов, производств и управления в качестве  

учебно-методического пособия для студентов учреждений  
высшего образования по направлению специальности  

1-53 01 01-09 «Автоматизация технологических процессов  
и производств (сельское хозяйство)» 

 
 
 
 
 
 
 
 
 
 
 

Минск 
БГАТУ 

2019 

http://www.bsatu.by/
http://www.bsatu.by/


 2 

УДК 681.5(07) 
ББК  32.965я7 
         М33 
 
 
 

Рецензенты :  
кафедра «Робототехнические системы»  

Белорусского национального технического университета 
(кандидат технических наук, доцент,  
заведующий кафедрой А. Р. Околов); 
кандидат технических наук, доцент,  

ученый секретарь РУП «НПЦ НАН Беларуси  
по механизации сельского хозяйства» Ю. Л. Салапура 

 
 
 
 
 
 
 
 
 

 
 
М33 

Матвейчук, Н. М. 
Теория автоматического управления. Лабораторный практикум :

учебно-методическое пособие / Н. М. Матвейчук, А. Г. Сеньков. –
Минск : БГАТУ, 2019. – 188 с. 

ISBN 978-985-25-0017-3. 
 
Приведен теоретический материал по математическому описанию звеньев 

и систем автоматического управления, синтезу непрерывных и дискретных систем 
автоматического регулирования и методические указания по выполнению  
лабораторных работ с использованием системы компьютерных расчетов MATLAB 
и входящего в ее состав пакета имитационного моделирования динамических 
систем Simulink.  
Для студентов учреждений высшего образования по направлению специальности 

1-53 01 01-09 «Автоматизация технологических процессов и производств (сельское 
хозяйство)». 

 
УДК 681.5(07) 
ББК 32.965я7 

 
ISBN 978-985-25-0017-3                                                                            © БГАТУ, 2019

http://www.bsatu.by/
http://www.bsatu.by/


 3 

СОДЕРЖАНИЕ 
 
 

ВВЕДЕНИЕ………………………………………………………………….4 
Модуль 1. ВВЕДЕНИЕ. ОСНОВЫ ТЕОРИИ  
АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ 

 
 

Лабораторная работа № 1. Изучение MATLAB на примерах  
моделирования отдельных элементов САР………………………………. 

 
5 

Лабораторная работа № 2. Изучение математического описания  
и методов получения статических характеристик линейных звеньев….. 

 
23 

Лабораторная работа № 3. Изучение математического описания  
и методов получения частотных характеристик линейных звеньев……. 

 
46 

Лабораторная работа № 4. Линеаризация гладких нелинейных  
характеристик звеньев систем автоматизации…………………………… 

 
66 

Лабораторная работа № 5. Идентификация объектов управления  
и средств автоматизации…………………………………………………... 

 
75 

Модуль 2. ЛИНЕЙНЫЕ НЕПРЕРЫВНЫЕ СИСТЕМЫ 
АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ 

 
 

Лабораторная работа № 6. Исследование разомкнутого  
и замкнутого управления………………………………………………….. 

 
95 

Модуль 3. ЛИНЕЙНЫЕ И НЕЛИНЕЙНЫЕ СИСТЕМЫ  
АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ 

 
 

Лабораторная работа № 7. Исследование систем  
с пропорциональным законом (П-законом) регулирования…………….. 

 
109 

Лабораторная работа № 8. Исследование систем с интегральным  
законом (И-законом) регулирования………………………………………

 
126 

Лабораторная работа № 9. Синтез систем автоматического  
регулирования……………………………………………………………… 135 
Лабораторная работа № 10. Исследование двухпозиционного  
регулятора и двухпозиционных систем…………………………………... 

 
148 

Лабораторная работа № 11. Исследование трехпозиционного  
регулятора и трехпозиционных систем…………………………………... 

 
163 

Модуль 4. ДИСКРЕТНЫЕ, ОПТИМАЛЬНЫЕ, РОБАСТНЫЕ, 
АДАПТИВНЫЕ И ИНТЕЛЛЕКТУАЛЬНЫЕ  
СИСТЕМЫ УПРАВЛЕНИЯ 

 
 

Лабораторная работа № 12. Исследование цифровых систем  
автоматического управления……………………………………………… 

 
174 

СПИСОК ЛИТЕРАТУРЫ…………………………………………………. 184 



 4 

ВВЕДЕНИЕ 
 
 
Лабораторный практикум содержит теоретический материал по 

математическому описанию звеньев и систем автоматического 
управления, синтезу непрерывных и дискретных систем автомати-
ческого регулирования, методические указания по выполнению 
лабораторных работ по дисциплине «Теория автоматического 
управления».  
Теория автоматического управления при изучении процессов 

управления абстрагируется от физических и конструктивных особен-
ностей систем и вместо реальных систем рассматривает их адекват-
ные математические модели. Основными методами исследования 
в теории автоматического управления являются математическое 
и компьютерное моделирование, теория дифференциальных и ло-
гических уравнений.  
Выполнение лабораторных работ по дисциплине «Теория авто-

матического управления» направлено на изучение математического 
описания и характеристик звеньев (модуль 1) и систем автоматиче-
ского управления (модуль 2), свойств и методов синтеза непрерыв-
ных (модуль 3) и цифровых (модуль 4) систем автоматического 
регулирования с типовыми линейными законами регулирования.  
Лабораторный практикум содержит теоретический материал 

и методические указания по выполнению лабораторных работ. 
При выполнении лабораторных работ предполагается широкое ис-
пользование системы компьютерных расчетов MATLAB и входя-
щего в ее состав пакета имитационного моделирования динамиче-
ских систем Simulink. 
В целях упрощения работы с лабораторным практикумом: 
– задания и порядок их выполнения выделены рамками. Вне ра-

мок располагаются теоретические сведения и поясняющие тексты; 
– названия блоков, команд, кнопок и обозначения, используе-

мые в MATLAB и Simulink, выделены шрифтом; 
– для англоязычных названий команд при их первом упомина-

нии в скобках приведен русскоязычный аналог. 
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МОДУЛЬ 1. ВВЕДЕНИЕ. ОСНОВЫ ТЕОРИИ  
АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ 

 
 

Лабораторная работа № 1 
ИЗУЧЕНИЕ MATLAB НА ПРИМЕРАХ МОДЕЛИРОВАНИЯ 

ОТДЕЛЬНЫХ ЭЛЕМЕНТОВ САР 
 
Цель работы: ознакомиться с системой компьютерных расче-

тов MATLAB для моделирования элементов систем автоматиче-
ского регулирования. 
Задание:  
1. Ознакомиться с основным окном MATLAB. 
2. Ознакомиться с работой с выражениями и переменными. 
3. Ознакомиться с математическим описанием линейных звеньев. 
4. Ознакомиться с построением графиков функций. 
5. Ознакомиться с созданием М-файлов. 
6. Ознакомиться с построением моделей в Simulink.  
7. Сделать выводы. 

Аппаратура, используемая в лабораторной работе 
Работа выполняется на персональных ЭВМ с использованием 

системы компьютерных расчетов MATLAB и входящего в ее со-
став пакета компьютерного моделирования Simulink.  

 
Выполнение работы 

1. Основное окно MATLAB 
Запуск MATLAB: из главного меню Windows Пуск→Все про-

граммы→MATLAB или двойным щелчком по соответствующей 
иконке на рабочем столе. Основное окно MATLAB показано на рис. 1. 
Основные элементы рабочего окна: 
– строка меню; 
– панель инструментов с кнопками и раскрывающимся списком; 
– окно Workspaсe (Рабочая область) – отображает рабочее про-

странство, т. е. используемые в работе переменные, константы, 
массивы и другие объекты, а также их размеры в байтах; 

– окно Command History (Команды) – окно, предназначенное 
для просмотра и повторного вызова ранее введенных команд;  
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– окно Command Window (Окно команд) – окно для ввода чи-
сел, выражений, переменных, формул и команд, для просмотра ре-
зультатов вычислений, для отображения текстов выполняемых про-
грамм, а также для вывода сообщений об ошибках. 

 

 
Рис. 1. Вид основного окна MATLAB 

 
Можно отобразить или скрыть соответствующие окна, поставив 

или сняв галочку в соответствующей сроке меню View (Вид) ос-
новного меню MATLAB. 
В начале работы все три подокна пустые. 
Сделайте активными по очереди все окна рабочей среды 

MATLAB. Скройте и затем снова включите окно Workspace. 
Работа в среде MATLAB может осуществляться в программном 

режиме или в командном (диалоговом). Основным элементом ко-
мандного режима работы с системой является окно Command 
Window.  
Сеанс работы с системой MATLAB называется сессией. Иными 

словами, сессия – это все то, что отображается в командном окне 
в процессе работы с системой. Команды сессии автоматически образу-
ют список, который выводится в окне Command History, а значения 
и размерность переменных сохраняются в окне Workspace. 
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Строка в текстовом поле Command Window, отмеченная сим-
волом приглашения >> с мигающим курсором, называется стро-
кой ввода или командной строкой. Она предназначена для ввода 
с клавиатуры команд, чисел, имен переменных и знаков операций, 
составляющих выражение. Для выполнения введенной команды 
или вычисления заданного выражения, следует нажать клавишу 
Enter (Ввод) – при этом курсор может находиться в любом месте 
командной строки.  
Результаты появляются в одной или нескольких строках ко-

мандного окна – строках вывода (без приглашающего символа 
>>). Для просмотра выполненных команд и результатов вычисле-
ний, не умещающихся на экране, имеются полосы горизонтальной 
и вертикальной прокрутки.  

 

2. Работа с выражениями и переменными в MATLAB 
Если результату операции не было присвоено имя, он автомати-

чески обозначается <ans>. 
Введите в командную строку 

>> 2 + 3 
и нажмите Enter. Убедитесь в том, что переменная ans появилась 
в окне Workspace. 
Окно Workspace содержит таблицу. При щелчке правой кноп-

кой мыши на строке с именем переменной в окне Workspace появ-
ляется всплывающий список команд, позволяющих переименовать 
переменные, удалить лишние, сохранить рабочую среду и т. д. Ко-
манда Open (Открыть) (или двойной щелчок по строке с именем 
переменной в окне Workspace) приводит к отображению этой пе-
ременной в матричном виде в отдельном окне Array Editor (Редак-
тор массивов). В этом окне в соответствующих полях задается раз-
мер матрицы – число ее строк и столбцов – и далее вводятся числа, 
выражения, переменные и функции в отдельные клетки появив-
шейся таблицы. Этот способ обеспечивает быстрый доступ 
к элементам матрицы и позволяет их вводить или редактировать 
в произвольном порядке. 
Откройте окно Array Editor для переменной ans двумя спо-
собами. 
При вычислении следующего непоименованного результата зна-

чение переменной ans меняется. 
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Ведите в командную строку  
>> 10 
и нажмите Enter. Откройте окно Array Editor для переменной ans 
и убедитесь в том, что переменная ans поменяла свое значение. 
Значение переменной ans можно использовать в вычислениях. 
Знаком присваивания является знак <=>. 
Введите в командную строку 

>> а = 18 - ans 
и нажмите Enter. Проверьте, что переменная a появилась в окне 
Workspaсe. 
При использовании команды disp(выражение), значение выра-

жения не присваивается переменной ans. 
Введите в командную строку 

>> disp(2^4) 
и нажмите Enter. Убедитесь в том, что переменная ans сохрани-
ла свое значение. 
Результат выполнения команды, заканчивающейся символом ;, 

на экран не выводится, но он сохраняется в памяти и может быть 
использован в последующих вычислениях. 
Введите в командную строку 

>> b = cos(pi); 
и нажмите Enter. Убедитесь в том, что переменная b появилась 
в окне Workspaсe. 
В одной командной строке можно ввести несколько команд, раз-

деляя их запятыми либо точками с запятой. Система MATLAB вы-
полняет каждую команду, за которой следует запятая, и отображает 
результаты в отдельных строках.  
Набрав в строке ввода имя переменной или disp(имя перемен-

ной) и нажав Enter, можно вывести значение любой переменной 
в командное окно. 
Введите в командную строку 

>> a, A = 2/3; disp(b) 
и нажмите Enter. Убедитесь в том, что переменная A появилась 
в окне Workspaсe. 
Если требуется ввести в окне Command Window команду, не 

помещающуюся на одной строке, перед нажатием клавиши Enter 
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следует ввести …, и продолжить набор команды на следующей 
строке (на ней не будет символа приглашения >>). 
Введите в командную строку  

>> с=.5+exp(1)+… 
А-b+2*a 
и нажмите Enter. Обратите внимание, что для отделения целой час-
ти числа используется точка, а не запятая (0 можно не вводить). 
Редактировать можно только выражения в командной строке. 

Вся остальная информация находится в зоне просмотра. В строке 
ввода можно перемещать курсор с помощью клавиш → и ←. 
Клавиши ↑ и ↓ служат для возврата в строку ввода ранее выпол-

ненных команд в целях их повторного выполнения или редактиро-
вания. Можно также копировать содержимое рабочего окна с по-
мощью мыши и затем вставлять его в строку ввода. 
С помощью клавиш ↑ и ↓ верните в строку ввода первую ко-
манду (2+3) и исправьте ее на (2-3). Нажмите Enter. Убедитесь, 
что при этом значение переменной а по-прежнему равно 8. 
Можно также выполнить ранее введенную команду двойным 

щелчком мыши на этой команде в окне Command History или 
 выделить в этом окне нужную последовательность команд с по-
мощью комбинации клавиш Shift+↑ и Shift+↓ и скопировать ее 
в командную строку. 
После вставки команд в строку ввода их можно редактировать, 

а выполняться они будут лишь после нажатия клавиши Enter.  
Причем если было скопировано сразу несколько строк, то при их 
редактировании можно использовать клавиши ↑ и ↓. 
Скопируйте из окна Command History три последние строки 

(начиная с символа с) и исправьте их следующим образом: 
>> с=.5+3-exp(1)+10e8+4.46e-3 
'2 – 3' 
Выражения, заключенные между двумя апострофами, не вычис-

ляются и чаще всего служат для вставки текста в графические объ-
екты и для описания символьных переменных. 
Для записи комплексных чисел в качестве мнимой единицы 

можно использовать как i, так и j. Следующие записи эквива-
лентны: 
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1 + i*2 ∼ 1 + j*2  ∼ 1 + 2*i  ∼ 1 + 2*j  ∼ 1 + 2i ∼ 1 + 2j. 

Если вместо числа переменная или мнимая единица расположе-
на перед числом, знак умножения обязателен. 
Введите в командную строку последовательно 

>>i 
>>j 
>>z = 1 + 2i 
Значения модуля ρ и фазы φ комплексного числа можно опреде-

лить с помощью встроенных функций ρ = abs(z) и  φ = angle(z). 
Введите в командную строку  

>> abs(z), angle(z) 
Для точного решения уравнений в MATLAB используется ко-

манда solve('уравнение'). 
Введите в командную строку выражение 

>> D = solve('x^3=-8') 
и нажмите Enter. Чтобы теперь обратиться к первому корню, 
нужно ввести его номер в скобках после имени переменной – 
массива корней: 
>> D(1) 
Если предварительно объявить  символьную переменную, мож-

но выражение не приравнивать к нулю, тогда апострофы не нужны. 
Введите в командной строке 

>>x = sym('x'); D = solve(x^2-2*x+4) 
Вектор – это упорядоченный перечень чисел, разделенных запя-

тыми или пробелами, заключенный в квадратные скобки. 
Введите в командную строку последовательно, каждый раз на-
жимая Enter: 
>> V1 = [-2 0 1 4] 
>> V2 = [1.3; 5.4; 6.9] 
>> V3 = [1,3,0;-2 -2 5] 
>> V1' 
Сделайте выводы о вводе матриц-строк, матриц-столбцов, 

транспонировании матриц. 
Откройте окно Array Editor для переменной V2 и замените 
число 5.4 числом 5.8. 
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Полином P(x) = a0xn + … + an–1x + an в MATLAB вводится 
и хранится в виде вектора, элементами которого являются коэффи-
циенты полинома (начиная со старшей степени): 

P = [a0 … an–1 an]. 

Вектор, элементы которого являются приближенными корнями 
заданного полинома, возвращает команда roots(P). 
Для ввода в MATLAB полинома 2x2 + 3x – 5 и нахождения его 
корней выполните следующие команды: 
>> P1=[2 3 -5] 
>> roots(P1) 
Введите в MATLAB полином x2 – 5 и найдите его корни. 
 
3. Математическое описание линейных звеньев в MATLAB 
Команда, задающая линейное звено с одним входом и одним вы-

ходом в виде передаточной функции, имеет следующий синтаксис: 

0 1 1 0 1 1([ , , , , ],[ , , , , ]),m m n ntf b b b b a a a a− −K K  

где 0 1 1, , , ,m mb b b b−K  и 0 1 1, , , ,n na a a a−K  – значения коэффициентов 
полиномов числителя и знаменателя передаточной функции звена 
(системы). 
 
Введите в MATLAB следующую передаточную функцию звена: 

( ) 3 2

144 288 .
15 62 48

sW s
s s s

+
=

+ + +
 

Найдите значения ее нулей (корней числителя) – команда zero 
и полюсов (корней знаменателя – характеристического полино-
ма) – команда pole. Введите в командную строку последователь-
но следующие команды: 
>> w = tf ([144 288], [1 15 62 48]) 
>> zero(w) 
>> pole(w) 
Переходная характеристика h(t) – это процесс изменения сиг-

нала на выходе системы при подаче на вход единичного ступенча-
того воздействия.  



 12 

Импульсная переходная характеристика w(t) – это процесс 
изменения  сигнала на выходе при подаче на вход δ-функции.  
Постройте в MATLAB временные характеристики системы, 
введя в командную строку последовательно следующие команды:  
>> step(w) 
>> impulse(w) 
и рассмотрите полученные графики. 
Время моделирования выбирается автоматически. При необхо-
димости его можно явно указать в команде 
>>step(w, t), 
где t – время моделирования, с. 

 
Построение асимптотических АЧХ и ФЧХ. При определении 

частотных характеристик подразумевается, что на входе и выходе 
системы сигналы являются гармоническими. 

Амплитудно-частотная характеристика (АЧХ) показывает, 
как изменяется отношение выходного сигнала к входному в зави-
симости от частоты. 

Фазо-частотная характеристика (ФЧХ) показывает измене-
ние сдвига фаз между входным и выходным сигналами в зависимо-
сти от частоты. 
Постройте частотные характеристики звена. 
По передаточным функциям можно получить графическое изо-
бражение логарифмических амплитудных и фазовых частотных 
характеристик – ЛАХ и ЛФХ, с помощью команды bode: 
>> bode(w) 
Используя ЛАЧХ и ЛФЧХ, можно оценить запасы устойчиво-
сти системы по амплитуде и по фазе с помощью команды 
>> margin(w) 
Для получения амплитудно- и фазочастотной характеристик 
системы, имеющей известную передаточную функцию, исполь-
зуется команда freqs с двумя аргументами: первый вектор пред-
ставляет собой коэффициенты числителя, начиная с коэффициен-
та у переменной s в старшей степени, а второй – коэффициенты 
знаменателя в той же последовательности.  
>> freqs([144 288], [1 15 62 48]) 
Графики имеют аналогичный вид, но на первом графике по оси 
ординат указаны значения амплитуды (magnitude) в абсолютных 
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единицах при логарифмическом масштабе по оси абсцисс (час-
тот) и автоматически нанесена сетка на оба графика. 
Для построения АФЧХ достаточно вызвать команду nyquist: 

>> nyquist(w) 
Чтобы отображались только положительные частоты, следует 
выполнить щелчок правой клавишей мыши по полученному графи-
ку и в пункте меню Show→Negative Frequencies убрать галочку. 
Команда очистки экрана clc стирает содержание командного 

окна MATLAB и размещает символ приглашения >> в левом верх-
нем углу пустого экрана. При этом остается неизменным содержи-
мое окон Command History и Workspace и можно продолжать 
пользоваться значениями переменных, полученных до ввода ко-
манды clc. Для удаления из памяти всех переменных используется 
команда clear. Если за ней через пробел указать список перемен-
ных, то только они будут удалены из памяти.  
Очистите экран, затем удалите из памяти вначале только пере-
менные V1, V2 и V3, а затем все остальные. 
По завершении сеанса работы с системой MATLAB все ис-

пользованные переменные теряются, однако можно сохранить 
содержимое рабочего пространства, использовав команду меню 
File/Save Workspace As…, и загрузить его в новой сессии. 

 

4. Построение графиков функций в MATLAB 
Построение графика функции одной переменной (или несколь-

ких таких графиков) в линейном масштабе осуществляется с по-
мощью команды plot(t, x) или plot(t, x, t, y). В скобках на первом 
месте стоит аргумент, на втором – функция. 
Для вычерчивания нескольких графиков в одном окне применя-

ется дополнительный параметр команды plot(), заключенный 
в апострофы и определяющий цвет линии, тип маркера и стиль ли-
нии (см. табл. 1). 
Символы, определяющие цвет, тип маркера, стиль линии и на-

ходящиеся внутри апострофов, могут располагаться в любой по-
следовательности. Внутри апострофов могут располагаться один, 
два или три таких символа. 
На график можно нанести: 
– координатную сетку (команда grid on); 
– подписи к осям абсцисс и ординат (команды xlabel(…), 

ylabel(…)); 
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– заголовок (команда title(…)); 
– легенду (команда legend(…)). 

 
Таблица 1 

Список параметров команды plot() 

Цвет Тип маркера Стиль линии 
y     желтый .     точка -     сплошная 
m    розовый о    кружок :     пунктирная 
c     голубой х    крестик -.    штрихпунктирная 
r     красный +    знак «плюс» --    штриховая 
g     зеленый s     квадрат  
b     синий d     ромб  
w    белый v    треугольник вершиной  

вниз 
 

k     черный ^    треугольник вершиной  
вверх 

 

 <    треугольник вершиной  
влево 

 

 >    треугольник вершиной  
вправо 

 

 p    пятиконечная звезда  
 h    шестиконечная звезда  

 
При составлении легенды следует учитывать, что порядок сле-

дования и количество аргументов команды legend(…), заключен-
ных в апострофы, должны быть согласованы по порядку следова-
ния функций и по их количеству. 
Последним дополнительным аргументом legend(…) может 

быть положение легенды в графическом окне, а именно: 
–1 – вне графика в правом верхнем углу; 
0 – выбирается лучшее положение в пределах графика так, что-

бы как можно меньше перекрывать сами графики; 
1 – в правом верхнем углу графика (это положение используется 

по умолчанию); 
2, 3, 4 – соответственно в верхнем левом углу, в нижнем левом 

углу и в нижнем правом углу графика. 
Легенду можно перетаскивать левой клавишей мыши. 
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Вычертите графики двух функций y1(t) = sint и y2(t) = sin3t при 
изменении t в пределах от –2π до 2π с шагом 0,1π. Для этого вве-
дите следующие команды: 
>> t=[-2*pi:0.1*pi:2*pi]; 
>> y1=sin(t); 
>> y2=sin(t).^3; 
>> plot(t,y1,'-*m',t,y2,'ok') 
>> grid on 
>> title('Periodic Functions') 
>> xlabel('Time, c') 
>> ylabel('Amplitude  (V)') 
>> legend('First','Second',4) 
Для сохранения графика в среде MATLAB следует: 
1) в выпадающем меню File графического окна выбрать строку 

Save As…; 
2) в появившемся окне указать, в какой папке и под каким име-

нем сохранить файл. 
Для экспорта графика в другое приложение Windows следует: 
1) в выпадающем меню File графического окна выбрать строку 

Export; 
2) в появившемся окне указать, в какой папке, под каким име-

нем и с каким расширением сохранить файл. При этом тип файла 
должен быть таким, чтобы с ним могло работать выбранное при-
ложение Windows. 
Экспортируйте полученный график в текстовый редактор 

Word, используя расширение .bmp. 
Команда plotyy(…)  выводит графики двух функций в одно окно 

с двумя осями ординат (справа и слева), имеющими подходящий 
масштаб. 
Введите в командную строку следующие команды: 

>> t=[0:0.01:2]; 
>> y=exp(2*t).*cos(10*t); 
>> x=100*sin(50*t); 
>> plotyy(t,x,t,y) 

 

5. Создание М-файлов 
М-файлы – это текстовые файлы (с расширением .m), содержа-

щие команды системы MATLAB. Их можно вызывать из команд-
ной строки или из другого М-файла. 
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Различают два типа М-файлов: файлы-программы (без входных 
и выходных переменных) и файлы-функции (с входными и выход-
ными переменными).  
При выполнении М-файл может использовать все определенные 

в системе переменные (имеющиеся в Workspace). В свою очередь, 
все переменные, созданные во время работы файла-сценария, ос-
таются в рабочем пространстве MATLAB и после окончания его 
выполнения (являются глобальными). Внутренние переменные, 
которые использует файл-функция, являются локальными – не со-
храняются в рабочей области, а если переменные с такими же име-
нами были в рабочей области ранее, их значения не изменятся. 
Для создания и редактирования М-файла следует выбрать пункт 

меню File→New→M-file. В результате на экране появится окно (с 
предлагаемым по умолчанию названием Untitled) для ввода после-
довательности команд.  
Для сохранения введенной программы в окне, в котором набра-

на программа, нужно выбрать пункт меню File→Save As…, в поя-
вившемся диалоговом окне сохранения файла указать папку и имя 
файла (английскими символами без пробелов) и нажать кнопку 
Сохранить. 

Выполнить набранную программу можно одним из следующих 
способов: 

– в окне с программой выбрать пункт меню Debug→Run либо 
нажать клавишу F5; 

– набрать в командной строке имя М-файла (без расширения) 
и нажать Enter. 
Создайте файл-функцию с именем myfun и следующим текстом: 

function y=myfun(x); 
y=cos(10*x).*(sin(x)+0.1*sin(100*pi*x)); 
Если при выводе графика функции трудно выбрать подходящий 

шаг дискретизации, то можно воспользоваться командой fplot('имя 
файла-функции', [a, b]), где первым входным аргументом являет-
ся имя файла-функции, а вторым – вектор, элементы которого есть 
границы отрезков. 
Введите в командную строку окна Command Window сле-
дующий текст: 
>> y=myfun(x); 
>>fplot('myfun', [0, 1]) 



 17 

6. Создание модели в Simulink 
Система имитационного моделирования Simulink – самое попу-

лярное расширение MATLAB. Пакет Simulink предназначен для 
математического моделирования линейных и нелинейных динами-
ческих систем и устройств, представленных своей функциональной 
блок-схемой (моделью). 

Simulink основывается на принципе визуального программиро-
вания, в соответствии с которым пользователь создает модель сис-
темы в виде структурной схемы из библиотеки стандартных бло-
ков. Таким образом, пользователю нет необходимости изучать язык 
программирования и численные методы. При моделировании сис-
тема выполняет необходимые вычисления в соответствии с задан-
ными настройками и выдает результаты в виде графиков и таблиц. 

Запуск пакета Simulink из MATLAB можно сделать одним из 
двух способов: 

– в окне ввода команд Command Window в строке ввода (спра-
ва от знака >>) набрать simulink и нажать клавишу Enter; 

– на панели инструментов MATLAB левой клавишей мыши на-

жать кнопку , расположенную слева кнопки справки . 
В результате этого откроется Simulink Library Brouser – окно 

интегрированного обозревателя (браузера) библиотеки стандарт-
ных блоков Simulink (показано на рис. 2). В данном окне содержит-
ся дерево компонентов библиотеки блоков Simulink.  

Библиотека блоков включает следующие основные разделы: 
− Continuous – линейные непрерывные блоки; 
− Discontinuities – нелинейные блоки; 
− Discrete – дискретные блоки; 
− Math operations – блоки математических операций; 
− Signal routing – блоки преобразования сигналов; 
− Sinks – регистрирующие блоки (приемники сигналов); 
− Sources – источники сигналов.  
Для просмотра того или иного раздела библиотеки достаточно 

выделить его мышью – в правой части окна Simulink Library 
Brouser появится набор пиктограмм блоков активного раздела биб-
лиотеки. 
Для создания новой модели необходимо в меню окна Simulink 

Library Brouser выполнить команду File→New→Model, или же 
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нажать на клавиатуре комбинацию клавиш Ctrl+N, или же левой 
клавишей мыши на панели инструментов окна Simulink Library 

Brouser нажать кнопку . В результате этого на экране появится 
новое чистое окно редактирования графической модели модели-
руемой системы или устройства. 

 

 
Рис. 2. Окно браузера библиотек Simulink 

 
Запустите пакет Simulink, откройте окно создания новой модели. 
Создайте в Simulink модель системы, состоящей из рассматри-
ваемого звена, источника ступенчатого сигнала и осциллографа 
(рис. 3). 

 

 
Рис. 3. Схема модели в окне Simulink 
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В окне Simulink Library Brouser в библиотеке Simulink на 
вкладке Sources найдите пиктограмму блока Step (Генератор 
ступенчатого сигнала), выделите его левой клавишей мыши и, не 
отпуская ее, перетащите данный компонент в окно редактирова-
ния модели (или выделите пиктограмму и затем в окне браузера 
выполните действие в меню Edit/Add to the current model).  
В окне Simulink Library Brouser в библиотеке Simulink на 
вкладке Sinks найдите блок Scope (Осциллограф) и перетащите 
в окно модели.  
В окне Simulink Library Brouser в библиотеке Simulink на 
вкладке Continuous найдите блок Transfer Fcn (Звено, заданное 
передаточной функцией) и перетащите его в окно модели. 
Двойным щелчком на пиктограмме откройте окно параметров 
блока Transfer Fcn и введите коэффициенты заданной переда-
точной функции (рис. 4). 

 

 
Рис. 4. Ввод параметров передаточной функции 

 
Для завершения создания схемы соедините выход блока Step со 
входом объекта (нажмите левой клавишей мыши на значок > вы-
хода блока Step и протяните до значка > входа блока Transfer 
Fcn), а выход объекта – со входом блока Scope (аналогично). 
Получите реакцию рассматриваемого звена на единичное сту-

пенчатое воздействие.  
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В меню окна редактирования модели выберите пункт Simulation→ 
→Simulation parameters (Параметры моделирования). В появив-
шемся окне задания параметров моделирования на вкладке 
Solver в поле Stop time (время окончания моделирования, вво-
дится в секундах) введите значение 100 (после проведения моде-
лирования это значение может быть уточнено), а на вкладке 
Workspace I/O отключите флажок Limit data point to last.  
В окне осциллографа в меню быстрого доступа по нажатию на 

кнопку Parameters  (справа от значка принтера) в появив-
шемся окне параметров осциллографа на вкладке Data history 
отключите флажок Limit data point to last.  
В меню окна редактирования модели выберите пункт 

Simulation→Start, в результате чего начнется процесс модели-
рования. Для прерывания процесса моделирования при выпол-
нении тех или иных условий используется блок Stop Simulation, 
срабатывающий при поступлении на его вход ненулевого сигнала. 
Результатом моделирования является график изменения вы-

ходного сигнала, отображаемый в окне осциллографа. Окно для 
наблюдения за сигналами (окно осциллограммы) открывается 
двойным щелчком  по элементу, что возможно на любой фазе мо-
делирования. 
Для сохранения результатов моделирования в рабочем простран-

стве MATLAB используется блок To Workspace (Рабочее простран-
ство) вкладки Sinks. После этого можно редактировать полученные 
графики или сохранять их в формате графического файла.  
Перенесите результаты моделирования в MATLAB и получите 
график переходной функции. 
Удалите линию соединения с блоком Scope. В окне Simulink 

Library Brouser в библиотеке Simulink  на вкладке Sinks найди-
те блок To Workspace и перетащите его в окно модели. Соеди-
ните выход объекта – со входом блока To Workspace (рис. 5). 

 

 
Рис. 5. Измененная схема модели в окне Simulink 
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После двойного щелчка мыши по пиктограмме блока  
To Workspace в открывшемся окне параметров (рис. 6) в соот-
ветствующих полях укажите имя выводимой переменной (на-
пример, simout) и формат данных Array (Массив).  

 

 
Рис. 6. Окно параметров блока To Workspace 

 
Запустите процесс моделирования. Результат будет записан 
в рабочую область MATLAB.  
Далее в командном окне MATLAB вызовите команду построе-
ния графиков: 
>>plot(simout) 
Выполните создание схемы и моделирование, взяв в качестве 
источника сигнала блок Sine Wave (вкладка Sources в библио-
теке Simulink) (самостоятельно).  

 
Содержание отчета 

1. Название лабораторной работы, цель, задание. 
2. Результаты решения уравнений х3 = –8, 2x2 + 3x – 5, x2 – 5. 
3. Нули и полюса передаточной функции. 
4. Графики переходной, импульсной переходной и частотных 

характеристик рассматриваемого звена. 
5. Схемы моделей в Simulink и графиков их переходных функций. 
6. Выводы. 
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Контрольные вопросы 
1. Приведите команды для решения уравнения, заданного в ва-

шем варианте, двумя способами, найдите точные и приближенные 
выражения для корней. 

2. Приведите команду ввода в MATLAB вектора (по вариантам). 
3. Приведите команду ввода в MATLAB передаточной функции 
( )W s  (по вариантам). Какие команды используются для построе-

ния переходной характеристики и АФЧХ этого звена? 
4. Начертите графики двух функций y1 = x и y2 = 2 (1 + e–x) в од-

ном окне с подходящим масштабом (0 ≤ x ≤ 1000). Оформление 
графиков функций выполните в соответствии с вариантом. 

 
Исходные данные по вариантам 

Вариант 1 2 3 4 5 
Уравнения х3 = –12 х3 = –27 х3 = –8 х3 = 64 х3 = 10 
Векторы 3.5

4.2
5.6
2

− 
 − 
 
 
 

 

4
3

8.3
6

 
 − 
 
 
 

 

33
44
66
6.2

 
 
 
 
 
 

 

4.5
4

5.5
6

 
 
 
 
 
 

 

3.5
4
5

6

 
 
 
 −
 
 

 

Переда-
точные  
функции 

( )W s  

2

20
30 50s s+ +

 2

3
6s s+ +

 2

20
4 2s s+ +

 2

1
6s +

 2

2
4s +

 

График 
первой 
функции 

Отдельные  
голубые  
квадраты 

Пунктирная 
зеленая  
линия 

Отдельные  
зеленые  
кружки 

Сплошная 
зеленая  
линия 

Отдельные 
желтые 
ромбы 

График 
второй 
функции 

Штриховая  
синяя  
линия 

Отдельные 
красные  
звездочки 

Пунктирная 
синяя  
линия 

Отдельные 
красные 
ромбы 

Сплошная 
черная 
линия 

 
 



 23 

Лабораторная работа № 2 
ИЗУЧЕНИЕ МАТЕМАТИЧЕСКОГО ОПИСАНИЯ 
И МЕТОДОВ ПОЛУЧЕНИЯ СТАТИЧЕСКИХ 
ХАРАКТЕРИСТИК ЛИНЕЙНЫХ ЗВЕНЬЕВ 

 
Цель работы: освоить методики получения математического 

описания и статических характеристик трех основных видов ли-
нейных звеньев: пропорционального (безынерционного) звена, апе-
риодического звена первого порядка (инерционного) и звена (чис-
того) запаздывания. 
Задание: 
1. Изучить математическое описание линейных звеньев. 
2. Получить экспериментальную статическую характеристику 

пропорционального звена путем моделирования. 
3. Рассчитать теоретическую статическую характеристику про-

порционального звена. 
4. Построить полученные статические характеристики в одних 

координатах.  
5. Сделать выводы о соответствии полученных эксперименталь-

ной и теоретической статических характеристик пропорционально-
го звена. 

6. Повторить пункты 2–5 для апериодического звена первого 
порядка. 

7. Повторить пункты 2–5 для звена чистого запаздывания. 
 

Аппаратура, используемая в лабораторной работе 
Работа выполняется на персональных ЭВМ с использованием 

системы компьютерных расчетов MATLAB и входящего в ее со-
став пакета компьютерного моделирования Simulink.  

Выполнение работы 

1. Математическое описание линейных звеньев 
Теория автоматического управления рассматривает технические 

объекты вне зависимости от их физической природы (механиче-
ские, электромеханические, тепловые, химико-технологические 
и т. п.) и при изучении процессов управления вместо реальных эле-
ментов рассматривает их адекватные математические модели. 
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Звено – простейший элемент системы управления. 
Звено направленного действия – звено, передающее сигнал 

только в одном направлении – со входа на выход. Входной сигнал 
звена может изменяться с течением времени и обозначается x(t), 
выходной сигнал звена также зависит от времени и обозначается y(t). 

Динамическим звеном называется часть системы управления, 
описываемая дифференциальным (или иным) уравнением опреде-
ленного вида. 

Линейным звеном называется звено, описываемое линейным 
дифференциальным (или иным) уравнением. 
Математическое описание звена представляет собой уравнение, 

связывающее входной и выходной сигналы звена. 
Получить математическое описание элемента (звена, системы) 

можно теоретическим способом – исходя из законов физики 
(закон сохранения энергии, массы, импульса, законы Кирхгофа 
и т. д.). Полученные таким образом математические модели опи-
сывают внутренние связи в объекте и, как правило, наиболее 
точны.  
Для удобства проектирования, анализа систем все многообразие 

элементарных звеньев разбивают на группы – типовые виды дина-
мических звеньев. Звенья одной группы описываются одинаковы-
ми (дифференциальными) уравнениями. 

 

Простейшие типовые звенья 
Пропорциональное (усилительное, безынерционное) звено 

усиливает входной сигнал в K раз (K – коэффициент усиления). 
Уравнение звена  

у(t) =Kх(t).                                            (1) 

Пример усилительного звена – механические передачи, усилители.  
Апериодическое (инерционное) звено первого порядка. 

Уравнение звена 

( ) ( ) ( )dy tT y t Kx t
dt

+ = ,                                   (2) 

где Т – постоянная времени, с; 
K – коэффициент преобразования (усиления). 
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Пример апериодического звена первого порядка – RC-цепочка, 
датчики.  
Запаздывающее звено (звено чистого запаздывания). Выход-

ная величина повторяет входную величину с некоторым запазды-
ванием. Уравнение звена  

( ) ( )y t x t= − τ ,                                         (3) 

где τ – время запаздывания, с. 
 

Пример – ленточный транспортер, конвейер. 
Выходной сигнал звена в реальных условиях, очевидно, сущест-

венно зависит от формы входного сигнала ( )x x t= . При анализе 
работы звеньев принято использовать так называемые типовые 
входные воздействия, которые являются математическими моде-
лями часто встречающихся реальных воздействий: 

– единичное ступенчатое воздействие (функция Хевисайда), 
обозначаемое следующим образом:  

( )
0, при 0,

1
1, при 0.

t
t

t
<

=  ≥
                                     (4) 

Следует заметить, что ступенчатый сигнал можно получить на 
практике. Например, включение в некоторый момент времени 
в помещении электронагревателя на некоторую постоянную мощ-
ность можно рассматривать как ступенчатое управляющее воздей-
ствие на объект управления (помещение). Подача постоянного 
электрического напряжения на вход электродвигателя постоянного 
тока путем замыкания идеального электрического ключа также 
представляет собой ступенчатое воздействие;  

– импульсное воздействие (дельта-функция, функция Дирака):  

( ) ( )
, при 0,

0, при 0,
t

x t t
t

∞ =
= δ =  ≠

                            (5) 

при этом, согласно определению:  

( ) 1t dt
+∞

−∞

δ =∫ .                                     (6) 
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Это идеальный сигнал, который равен нулю во всех точках, кро-
ме 0t = , где он уходит в бесконечность, причем его площадь (ин-
теграл по всей оси времени) равна единице. 
Дельта-функция связана с единичным ступенчатым воздействи-

ем выражением 

( ) ( )1t t′δ = ,                                         (7) 

т. е. дельта-функция равна производной от ступенчатого воздействия; 
– гармоническое воздействие: 

( ) ( )sinxx t A t= ω ,                                  (8) 

где Ax – амплитуда;  
ω – круговая частота, рад/с. 

 
Временные характеристики звена 
Переходная функция звена h(t) – реакция звена на единичное 

ступенчатое воздействие. На рис. 7 показан типовой вид переход-
ной характеристики апериодического звена первого порядка.  

 

 
Рис. 7. Единичное ступенчатое входное воздействие и соответствующая ему  

переходная функция апериодического звена первого порядка 
 

Ступенчатый сигнал легко получить на практике, поэтому пере-
ходную функцию звена можно получить экспериментально.  

Импульсная переходная функция w(t) – реакция звена на им-
пульсное воздействие (дельта-функцию). Импульсная переходная 
функция линейного звена связана с его переходной функцией вы-
ражением 

( ) ( )w t h t′= .                                          (9) 
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Режимы работы звеньев 
В теории автоматического управления принято выделять два 

режима работы элементов и систем автоматики: статический и ди-
намический. 

Статическим (установившимся) называется такой режим ра-
боты, при котором входная и выходная величины данного элемента 
неизменны во времени, т. е. ( ) constx t =  и ( ) consty t = . 

Динамическим режимом работы (переходным процессом) на-
зывается режим работы элементов (систем) автоматики при изме-
няющихся во времени входном воздействии и выходной величине, 
т. е. при ( )x x t=  и ( )y y t= . 
Поведение звеньев (систем) автоматики в реальных условиях 

представляет собой сочетание переходного и установившегося 
режимов. После окончания переходного процесса звено приходит 
к статическому режиму работы (рис. 8). 

 

 
Рис. 8. Переход от одного установившегося режима к другому 

 
Статической характеристикой звена (системы) называется 

зависимость между постоянным входным воздействием и посто-
янной выходной величиной звена (системы) в установившемся ре-
жиме (после окончания переходного процесса). 
Статическая характеристика обычно изображается графически 

в плоскости координат (х, y). 
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Статическая характеристика полностью характеризует поведе-
ние динамического звена в установившемся режиме. 

Статические характеристики простейших типовых звеньев: 
– пропорциональное (усилительное, безынерционное) звено:  

у =K х; 

– апериодическое (инерционное) звено первого порядка: 

у = K х; 

– запаздывающее звено (звено чистого запаздывания): 

у = х. 

2. Получение экспериментальной статической  
характеристики пропорционального (безынерционного) 
звена путем моделирования  

В качестве исследуемого звена рассмотрим следующий дели-
тель напряжения (рис. 9). 

 

 
Рис. 9. Исследуемая схема пропорционального звена: 

U1 – входное воздействие, U2 – выходная величина  
 
Создайте схему исследуемого пропорционального звена 
в Simulink. Запустите систему компьютерного моделирования 
MATLAB и пакет Simulink. Откройте окно создания новой моде-
ли (см. выполнение лабораторной работы № 1).  
В открывшемся окне создайте графическую модель заданной 
электрической цепи (приблизительный вид показан на рис. 10). 

1) Сопротивление R1. В окне Simulink Library Brouser в биб-
лиотеке SimPowerSystems на вкладке Elements (Элементы) 
найдите блок Series RLC Branch, выделите его левой клавишей 
мыши и, не отпуская ее, перетащите данный компонент в окно  
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редактирования модели. Данный блок представляет собой после-
довательное соединение активного сопротивления R, индуктив-
ности L и емкости C, однако, задав соответствующие параметры 
блока, можно моделировать каждый из этих трех элементов в от-
дельности. Необходимо задать параметры блока. Для этого левой 
клавишей мыши следует дважды щелкнуть по нему. В появив-
шемся окне Block Parameters: Series RLC Branch введите сле-
дующие значения параметров: для параметра Resistance R 
(Ohms) значение сопротивления R1 (по вариантам); для парамет-
ра Inductance L (H) – нулевое значение индуктивности 0; для 
параметра Capacitance C (F) – значение электрической емкости 
inf, равное бесконечности.  
Нажатием кнопок Apply и OK закрепите введенные параметры 
блока. В результате значок блока изменится и примет вид, соот-
ветствующий только одному активному сопротивлению. Назва-
ние блока по умолчанию автоматически задано как Series RLC 
Branch и отображается под ним. Для задания названия блока 
щелкните левой клавишей мыши по надписи Series RLC Branch, 
войдите в строку редактирования надписи и замените надпись 
Series RLC Branch на R1; выход из строки редактирования 
надписи осуществляется щелчком левой клавишей мыши на сво-
бодном пространстве окна модели.  

 

 
Рис. 10. Схема для получения статической характеристики  

пропорционального звена в Simulink 
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2) Сопротивление R2 задается аналогично. Далее, для поворота 
значка сопротивления, чтобы он располагался вертикально, не-
обходимо щелкнуть по нему один раз правой клавишей мыши 
и в появившемся всплывающем меню выбрать пункт Format→ 
→Rotate block. 

3) Соедините блоки R1 и R2. Подведите курсор мыши к выхо-
ду блока R1 и, нажав левую клавишу мыши, соедините выход 
R1 с входом блока R2.  

4) Вольтметр для измерения выходного напряжения. На вкладке 
Measurements (Измерители) в библиотеке SimPowerSystems в 
окне Simulink Library Brouser выберите блок Voltage Measurement 
(Блок измерения напряжения) и перетащите его в окно модели. 
Начальное название элемента измените на Voltmeter U2. Вход 
«–» вольтметра соедините с выходом блока R2. Затем подведите 
курсор мыши к входу «+» вольтметра и, нажав левую клавишу 
мыши, соедините его с линией соединения блоков R1 и R2. 

5) Источник постоянного напряжения. Для подачи постоянного 
напряжения на вход звена следует использовать источник посто-
янного напряжения и выключатель. 
На вкладке Electrical Sources в библиотеке SimPowerSystems 
в окне Simulink Library Brouser выберите блок DC Voltage Source 
(Источник постоянного напряжения) и перетащите его в окно 
модели. Название блока DC Voltage Source измените на U1. 
Вход блока U1 соедините с линией соединения блоков R1 
и Voltmeter U2. 

6) Для замыкания электрической цепи используется блок 
Breaker (Выключатель) на вкладке Elements в библиотеке 
SimPowerSystems в окне Simulink Library Brouser. Данный 
элемент моделирует устройство включения и выключения тока. 
Выключатель Breaker может управляться внешним управляю-
щим сигналом, подаваемым на управляющий вход с. Замыкание 
входного и выходного контактов выключателя 1 и 2 выполняется 
при подаче на вход с единичного сигнала, а размыкание – при 
подаче нулевого сигнала. Устройство имеет встроенную ис-
крогасящую RC-цепь, включенную параллельно контактам 
выключателя. 
Перетащите блок Breaker в окно модели (название оставьте 

Breaker). Двойным щелчком левой клавишей мыши на значке 
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блока откройте окно задания его параметров и для параметра 
Snubber resistance Rom (Ohms) (Сопротивление выключателя 
в разомкнутом состоянии) вместо значения 106 введите inf 
(бесконечность), после чего нажмите кнопки Apply и OK. 
Входной контакт выключателя 1 соедините с выходом источ-
ника напряжения U1, а выходной контакт 2 – со входом блока 
резистора R1. 

7) Для замыкания выключателя используется блок Step на 
вкладке Sources в библиотеке Simulink. Данный блок модели-
рует ступенчатое изменение сигнала. Перетяните его левой кла-
вишей мыши в окно модели и соедините с управляющим входом 
c выключателя. Выполните двойной щелчок левой клавишей 
мыши на блоке Step и откройте окно задания его параметров. 
В соответствии с заданными по умолчанию значениями пара-
метров, сигнал на выходе блока будет изменяться от начального 
значения (Initial value) 0 до конечного значения (Final value) 1 
в момент времени (Step time) 1 с от начала процесса моделиро-
вания. Оставьте все параметры блока Step без изменения и на-
жмите кнопку OK. 

8) На соединительной линии блоков U1 и R2 щелкните правой 
клавишей мыши, во всплывающем окне выберите пункт 
Signal Properties и в появившемся окне в поле Signal name 
в качестве названия сигнала введите 0 (эта линия – нулевая – со-
ответствует нулевому потенциалу).  
После этого на вкладке Connectors в библиотеке 

SimPowerSystems в окне Simulink Library Brouser выберите 
блок Ground (input) и перетащите его в окно редактирования 
модели. Щелкнув по нему правой клавишей мыши и выбрав 
пункт Format→Show name всплывающего меню, измените на-
звание с Ground (input) на 0. После этого вход блока 0 левой 
клавишей мыши соедините с нулевой линией. 

9) Вольтметр для измерения входного напряжения. На вкладке 
Measurements в библиотеке SimPowerSystems в окне Simulink 
Library Brouser выберите блок Voltage Measurement и перета-
щите его в окно модели. Начальное название элемента измените 
на Voltmeter U1. Вход «–» вольтметра соедините с нулевой ли-
нией. Вход блока «+» вольтметра, нажав левую клавишу мыши, 
соединим с линией соединения блоков R1 и Breaker. 
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10) Осциллограф. На вкладке Sinks в библиотеке Simulink 
в окне Simulink Library Brouser выберите блок Scope и перета-
щите его в окно модели (название оставьте Scope). Двойным 
щелчком левой клавишей мыши на значке блока Scope откройте 
окно Scope, моделирующее экран реального осциллографа (рис. 
11). В окне осциллографа в меню быстрого доступа нажмите кноп-

ку Parameters  (справа от значка принтера) и в появившемся 
окне параметров осциллографа в графе Number of Axes по-
ставьте значение 2, а на вкладке Data history отключите флажок 
Limit data point to last. Нажмите кнопки Apply и OK. 
Теперь блок Scope имеет два входа. Выходы блоков Voltmeter 

U1 и Voltmeter U2 соедините соответственно с верхним 
и нижним входами блока Scope. 
Сохраните созданную модель (например, под именем 

const_voltage_prop.mdl) на жесткий диск в рабочую папку, вы-
брав в меню окна редактирования модели пункт File→Save 
as…  

 

 
Рис. 11. Определение установившегося выходного значения напряжения  

по экрану осциллографа 
 

Выполните моделирование схемы. Для этого сначала задайте 
значение постоянного напряжения U1, подаваемого на вход це-
пи. Двойным щелчком левой кнопкой мыши на блоке источни-
ка напряжения U1 откройте окно задания его параметров  
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и в поле для параметра Amplitude (V) – напряжение источника 
в вольтах – введите значение 2. Подтвердите ввод нажатием 
кнопок Apply и OK. 
В меню окна редактирования модели выберите пункт 

Simulation→Simulation parameters, в появившемся окне зада-
ния параметров моделирования на вкладке Solver в поле Stop 
time  введите значение 5, а на вкладке Workspace I/O отключите 
флажок Limit data point to last. Нажмем кнопки Apply и OK.  
В меню окна редактирования модели выберите пункт 

Simulation→Start, в результате чего начнется процесс модели-
рования.  
При этом на экране появится предупреждающее сообщение 
о том, что созданная модель содержит нелинейные элементы (это 
относится к блоку выключателя Breaker), поэтому для коррект-
ного моделирования необходимо использовать компьютерные 
методы решения дифференциальных уравнений «ode23tb» или 
«ode15s». Таким образом Simulink запрашивает на это разреше-
ние пользователя. Следует нажать кнопку OK. 
Результатом моделирования являются графики изменения на-

пряжений U1 на входе цепи и U2 на выходе цепи, отображаемые 
соответственно в верхнем и нижнем окнах осциллографа (рис. 11). 
Как видно из графиков, в момент времени t = 1 c от начала модели-
рования замыкается выключатель и постоянное входное напряже-
ние 2 В подается на вход электрической цепи. В этом момент вход-
ное напряжение меняется на заданное (2 В). В этот же момент 
в цепи устанавливается постоянное значение выходного напряже-
ния 2U , отличное по величине от U1. Таким образом, выходной 
сигнал рассматриваемого пропорционального звена полностью 
повторяет входной сигнал по форме, но отличается от него по 
значению. 
Для определения величины выходного напряжения по экрану 

осциллографа можно воспользоваться экранной лупой по оси Y. 
Проведите компьютерное моделирование схемы, изменяя зна-
чения постоянного входного напряжения U1 от –6 до +6 В 
с шагом 2 В. Для каждого значения U1 определите соответст-
вующее установившееся значение выходного напряжения U2. 
Данные опытов внесите в строку U2Э табл. 2.  
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Таблица 2 

Результаты измерений и расчетов для построения экспериментальной  
и теоретической статической характеристики звена 

U1, В –6 –4 –2 0 2 4 6 
U2Э, В        
KЭ  
KТ  
U2Т, В        

 
Рассчитайте значение коэффициента передачи по формуле 

2 1K U U= ∆ ∆ ,                                    (10) 

где 2 2max 2minU U U∆ = − , 1 1max 1minU U U∆ = −  – разность между 
максимальным и минимальным измеренными значениями соот-
ветственно выходного и входного напряжений. Полученное зна-
чение внесите в строку KЭ табл. 2. 

 

3. Расчет теоретической статической характеристики  
пропорционального звена 

Вывод уравнения звена. В нашем случае необходимо найти за-
висимость U2 от U1. Для этого воспользуемся законом Ома: 

1 1 2

2 2

( ) ( ) ( ),
( ) ( ),

U t R R I t
U t R I t

= +
 =

 

где I(t) – значение силы тока в цепи. 
 
Разделив почленно второе уравнение на первое и сократив, по-

лучим 
2 2

1 1 2

( )
( )

U t R
U t R R

=
+

, 

откуда 

2
2 1

1 2

( ) ( ).RU t U t
R R

=
+
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В теории автоматического управления принято в уравнениях 
входные переменные располагать в левой части, а выходные – 
в правой части уравнения. Кроме того, принято преобразовывать 
уравнение так, чтобы коэффициент при самой выходной величине 
(в нашем случае U2) был равен 1. 
Постоянный коэффициент при входной величине U1 обозначим  

2

1 2

.R K
R R

=
+

                                      (12) 

Окончательно получим 

2 1( ) ( ).U t K U t=                                     (13) 

Статическая характеристика рассматриваемого звена: 

2 1U K U= .                                         (14) 

Рассчитайте теоретический коэффициент передачи звена KТ по 
формуле (12) и внесите в строку KТ табл. 2. 
Рассчитайте расчетные значения U2Т по теоретической форму-
ле статической характеристики (14) для следующих значений 
постоянного входного напряжения U1, В: –6, –4, –2, 0, 2, 4, 6.  
Результаты внесите в строку U2Т табл. 2. 

4. Построение полученных статических характеристик  
пропорционального звена 

Постройте экспериментальную статическую характеристику 
( )2Э 1U f U=  пропорционального звена по результатам модели-

рования. 
Постройте теоретическую статическую характеристику U2Т = 

= KТ U1 пропорционального звена в одних координатах с экспе-
риментальной. 

5. Выводы о соответствии полученных экспериментальной 
и теоретической статических характеристик  
пропорционального звена 

Запишите полученные формулы экспериментальной и теорети-
ческой статических характеристик пропорционального звена, 
подставив значения коэффициентов усиления из табл. 2. Сделайте 
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выводы о соответствии экспериментальной и расчетной стати-
стических характеристик друг другу. 

 
6. Получение экспериментальной и теоретической  
статических характеристик апериодического звена  
первого порядка (инерционного) 

 

Получение экспериментальной статической  
характеристики апериодического звена первого порядка 
В качестве исследуемого звена рассмотрим следующий элек-

трический RC-фильтр (рис. 12). 
 

 
Рис. 12. Исследуемая схема апериодического звена первого порядка: 

U1 – входное воздействие, U2 – выходная величина 
 

Создайте схему исследуемого апериодического звена первого 
порядка в Simulink. 
Внесите следующие изменения в модель const_voltage_prop, 
созданную при получении статической характеристики пропор-
ционального звена: в окне Simulink Library Brouser в библиоте-
ке SimPowerSystems на вкладке Elements найдите блок 
Series RLC Branch, выделите его левой клавишей мыши и, не 
отпуская ее, перетащите данный компонент в окно редактирова-
ния модели, расположив левее элемента R2. Левой клавишей 
мыши выполните двойной щелчок по элементу Series RLC 
Branch и в появившемся окне Block Parameters: Series RLC 
Branch введите следующие значения параметров: для параметра 
Resistance R (Ohms) – нулевое значение сопротивления 0; 
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для параметра Inductance L (H) – нулевое значение индуктивно-
сти 0; для параметра Capacitance C (F) – значение электриче-
ской емкости C (по вариантам). Нажатием кнопок Apply и OK 
закрепите введенные параметры блока. В результате значок бло-
ка изменится и примет вид, соответствующий только одному 
конденсатору. Для поворота значка конденсатора, чтобы он рас-
полагался вертикально, необходимо щелкнуть по нему один раз 
правой клавишей мыши и в появившемся всплывающем меню 
выбрать пункт Format→Rotate block, затем Format→Flip block. 
При необходимости растяните значок, выделив его левой клави-
шей мыши и потянув за угловой квадрат. 
Чтобы задать название блока, щелкните левой клавишей мыши 
по надписи Series RLC Branch, войдите в строку редактиро-
вания надписи и замените надпись Series RLC Branch на С. 
Выход из строки редактирования надписи осуществляется щелч-
ком левой клавишей мыши на свободном пространстве окна  
модели.  
Далее выполним включение блока C в исследуемую схему. 
Вначале выделите линию, соединяющую блок R1 и блок 
Voltmeter U2 и удалите ее, нажав клавишу Delete. 
Для соединения входа блока С необходимо использовать блок 

T connector, расположенный на вкладке Connectors  в библио-
теке SimPowerSystems в окне Simulink Library Brouser. Пере-
тащим его левой клавишей мыши в окно редактирования модели 
const_voltage_prop, расположив правее блока R1 над блоком C. 
Далее щелкнем по нему правой клавишей мыши и во всплываю-
щем меню выберем пункт Format→Show name, в результате 
над значком элемента появится его название T connector, задан-
ное автоматически. Измените название блока с T connector на 
Unit 1. Далее подведите курсор мыши к выходу блока R1 и, на-
жав левую клавишу мыши, соедините выход  с левым входом 
блока Unit 1. Выход блока С аналогичным образом соедините 
с нижним входом блока Unit 1, выход блока Unit 1 – со входом 
вольтметра Voltmeter U2, вход блока C – с нулевой линией.  
Сохраните созданную модель под новым именем (например, 
под именем const_voltage_a1p.mdl) в рабочую папку, выбрав 
в меню окна редактирования модели пункт File→Save as… 
Приблизительный вид создаваемой схемы показан на рис. 13. 
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Рис. 13. Схема для получения статической характеристики  
апериодического звена первого порядка в Simulink  

 
Выполните моделирование схемы так же, как и при изучении 
пропорционального звена, задав значение постоянного входного 
напряжения U1, равное 2 В, и время моделирования, равное 
100 с. Результирующие графики изменения входного и выходно-
го напряжений для определения установившегося значения име-
ют вид, показанный на рис. 14.  

 

 
Рис. 14. Графики изменения входного и выходного напряжений  

для апериодического звена первого порядка  
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Как видно из графика, замыкание выключателя в момент време-
ни t = 1 c от начала моделирования приводит к подаче на вход элек-
трической цепи постоянного входного напряжения 2 В. В цепи на-
чинается переходный процесс, отражающийся в нижнем окне 
осциллографа, после окончания которого устанавливается посто-
янное значение выходного напряжения 2U  (в примере на рис. 14 
эта величина равна 2 В). 
Для определения величины выходного напряжения по экрану 

осциллографа можно воспользоваться экранной лупой по оси Y. 
Проведите компьютерное моделирование схемы, изменяя зна-
чения постоянного входного напряжения U1 от –6 до +6 В 
с шагом 2 В. Для каждого значения U1 определите соответст-
вующее установившееся значение выходного напряжения U2. 
Постройте таблицу, аналогичную табл. 2. Данные опытов внеси-
те в строку U2Э таблицы. 
Рассчитайте значение коэффициента передачи по формуле (10). 
Полученное значение внесите в строку KЭ таблицы. 

 

Получение теоретической статической характеристики 
апериодического звена первого порядка 
Вывод уравнения звена. В нашем примере необходимо най-

ти зависимость U2 от U1. Поскольку сила тока через конденсатор 
не постоянна по времени, для напряжения на конденсаторе по-
лучаем 

2 1
0

1 ( ) ,
tqU i t dt

C C
= = ∫  

откуда 

2
1

1 ( ),dU i t
dt C

=  

следовательно, 

2
1( ) .dUi t C

dt
=  

С другой стороны, учитывая 1 2( ) ( ) ( )i t i t i t= + , получаем 
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11 2 1 2 1 2 1 2

2 2 2 1
1 2 1 2

2 2

( ) ( ( ) ( ))

1 ,

RU U U i t R U i t i t R U

dU U dU RC R U CR U
dt R dt R

= + = + = + + =

   
= + + = + +   

   

 

где 
1RU  и U2 – падение напряжений на сопротивлении R1 и емкости C. 

 
Получаем искомое математическое описание заданного звена: 

1 2 2 2
2 1

1 2 1 2

( ) ( ) ( ).
C R R dU t RU t U t
R R dt R R

+ =
+ +

                 (15) 

Постоянный коэффициент при первой производной 2dU
dt

, имею-

щий размерность [c], обозначим  

1 2

1 2

C R R T
R R

=
+

;                                       (16) 

коэффициент при входной величине U обозначим  

2

1 2

RK
R R

=
+

.                                       (17) 

Окончательно получим 

2
2 1

( ) ( ) ( ).dU tT U t KU t
dt

+ =

                          

 (18) 

Коэффициенты при производных выходной величины называют 
постоянными времени (в нашем случае это T). Они имеют раз-
мерность времени. Коэффициенты при входной величине (в нашем 
случае K) называют коэффициентами передачи. 
Расчет статической характеристики звена. В статическом 

режиме после завершения переходного процесса сигналы U1 и U2  
постоянны и не зависят от t, т. е. производная 1 0dU dt = . Таким об-
разом, приравняв нулю производную 2 0dU dt =  в уравнении (18), 
получим статическую характеристику рассматриваемого звена: 

2 1U K U= .                                         (19) 
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Внесите теоретический коэффициент передачи апериодического 
звена первого порядка KТ из формулы (17) в строку KТ таблицы. 
Рассчитайте расчетные значения U2Т по теоретической форму-
ле (19) статической характеристики  для следующих значений 
постоянного входного напряжения U1, В: –6, –4, –2, 0, 2, 4, 6.  
Результаты внесите в строку U2Т таблицы. 
Постройте экспериментальную статическую характеристику  

U2Э = f(U1) апериодического звена первого порядка по результа-
там моделирования. 
Постройте теоретическую статическую характеристику U2Т = KТ U1 
апериодического звена первого порядка в одних координатах 
с экспериментальной. 
Запишите полученные формулы экспериментальной и теорети-
ческой статических характеристик апериодического звена первого 
порядка, подставив значения коэффициентов усиления из табли-
цы. Сделайте выводы о соответствии экспериментальной 
и расчетной статистических характеристик друг другу. 

 

7. Получение экспериментальной и теоретической  
статических характеристик звена чистого запаздывания 

Получение экспериментальной статической  
характеристики звена чистого запаздывания 
В качестве примера исследуемого звена рассмотрим трубу с венти-

лятором (рис. 15). 
 

 
Рис. 15. Пример звена запаздывания 

 
Создайте схему исследуемого звена запаздывания в Simulink. 
Запустите систему компьютерного моделирования MATLAB, 
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выполните запуск пакета Simulink и откройте окно создания но-
вой модели (см. выполнение лабораторной работы № 1).  
В окне Simulink Library Brouser в библиотеке Simulink на 
вкладке Sources найдите пиктограмму блока Step, выделите его 
левой клавишей мыши и, не отпуская ее, перетащите данный 
компонент в окно редактирования модели.  
Далее в окне Simulink Library Brouser в библиотеке Simulink 
на вкладке Sinks найдите блок Scope и перетащите его в окно 
модели (название блока оставьте Scope). Двойным щелчком ле-
вой клавишей мыши на значке блока Scope откройте окно осцил-
лографа Scope, в меню быстрого доступа нажмите кнопку 

Parameters  (справа от значка принтера) и в появившемся ок-
не параметров осциллографа  в графе Number of Axes поставьте 
значение 2, а на вкладке Data history отключите флажок Limit 
data point to last. Нажмите кнопки Apply и OK. 
В окне Simulink Library Brouser в библиотеке Simulink на вкладке 

Continuous отыщите блок Transport Delay (Звено запаздывания) 
и перетащите его в окно модели. Двойным щелчком на пиктограмме 
откройте окно параметров блока Transport Delay, где следует вве-
сти значение временной задержки в соответствии с вариантом. 
Соедините выход блока Step со входом звена запаздывания, 
а выход звена – с нижним входом блока Scope. Верхний вход 
блока Scope соедините с линией, соединяющей блоки Step 
и Transport Delay. 
Сохраните созданную модель в рабочую папку на жесткий 
диск (напрмер, под именем const_delay.mdl), выбрав в меню 
окна редактирования модели пункт File→Save as… 
Вид создаваемой графической модели показан на рис. 16. 
 

  
Рис. 16. Схема для получения статической характеристики  

звена запаздывания в Simulink  
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Выполните моделирование схемы, задав время моделирова-
ния 10 с.  
Результирующие графики изменения значений входной и вы-

ходной величин для определения установившегося значения имеют 
вид, показанный на рис. 17.  
Как видно из графиков, в момент времени t = 1 c от начала мо-

делирования происходит подача единичного ступенчатого входно-
го воздействия. В цепи начинается переходный процесс, отражаю-
щийся в нижнем окне осциллографа, после окончания которого 
устанавливается постоянное значение выходной величины. Таким 
образом, выходной сигнал рассматриваемого звена запаздывания 
полностью повторяет входной сигнал по форме и значению, но от-
стает от него на заданную величину запаздывания. 

 

 
Рис. 17. Графики изменения значения входной и выходной величин  

звена запаздывания 
 

Для определения величины выходного напряжения по экрану 
осциллографа можно воспользоваться экранной лупой по оси Y. 
Проведите компьютерное моделирование схемы, изменяя зна-
чения постоянного входного напряжения U1 от –6 до +6 В 
с шагом 2 В. При этом значения входной амплитуды следует зада-
вать непосредственно в блоке Step в поле Final value. Для каждо-
го значения U1 определите соответствующее установившееся 
значение выходного напряжения U2. Постройте таблицу, анало-
гичную табл. 2, для исследования звена чистого запаздывания. 
Данные опытов внесите в строку U2Э таблицы.  
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Рассчитайте значение коэффициента передачи по формуле (10). 
Полученное значение внесите в строку KЭ таблицы. 

 

Получение теоретической статической характеристики  
звена чистого запаздывания 
Уравнение звена имеет вид 

( ) ( ),y t x t= − τ                                          (20) 

где τ – величина запаздывания, которая в рассматриваемом приме-
ре зависит от геометрических параметров трубопровода, с.  
 
Имеем 

,L
v

τ =                                               (21) 

где L – длина трубопровода, м; 
v – скорость потока воздуха в трубе, м/с. 

 
Расчет статической характеристики звена. В статическом 

режиме после завершения переходного процесса сигналы y и x по-
стоянны и не зависят от t. Статическая характеристика чистого за-
паздывания звена: 

y x= .                                             (22) 

Определите значение теоретического коэффициента KТ пере-
дачи звена чистого запаздывания из формулы (22) и внесите 
в соответствующую строку таблицы. 
Рассчитайте теоретические значения U2Т по формуле (22) ста-
тической характеристики для следующих значений постоянного 
входного напряжения U1, В: –6, –4, –2, 0, 2, 4, 6. Результаты вне-
сите в строку U2Т таблицы. 
Постройте экспериментальную статическую характеристику 

( )2 1ЭU f U=  звена чистого запаздывания по результатам моде-
лирования. 
Постройте теоретическую статическую характеристику U2Т = KТ U1 
звена чистого запаздывания в одних координатах с экспери-
ментальной. 
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Запишите полученные формулы экспериментальной и теоре-
тической статических характеристик звена чистого запаздыва-
ния, подставив значения коэффициентов усиления из таблицы. 
Сделайте выводы о соответствии экспериментальной и расчетной 
статических характеристик друг другу. 

 
Содержание отчета 

1. Название лабораторной работы, цель, задание. 
2. Результаты исследования пропорционального звена:  

1) данные для построения экспериментальной и теоретиче-
ской статических характеристик (табл. 2);  

2) графики экспериментальной и теоретической статических 
характеристик;  

3) вывод о соответствии экспериментальной и теоретической 
статических характеристик друг другу. 

3. Результаты исследования апериодического звена первого по-
рядка.  

4. Результаты исследования звена чистого запаздывания.  
 

Контрольные вопросы 
1. Дайте определение звена, линейного звена. 
2. Перечислите типовые входные воздействия. Какие из них ис-

пользовались при выполнении работы? 
3. Какие режимы работы звеньев вы знаете? Поясните понятия: 

переходный и установившийся режим. 
4. Дайте определение статической характеристики. 
5. Изложите методику получения статических характеристик 

линейных звеньев теоретическим и экспериментальным методами. 
6. Опишите полученные графики. 

 
Исходные данные по вариантам 

Вариант R1, Ом R2, Ом С, Ф τ, с 
1 1000  1000  0,001  3  
2 1000  2000  0,001  4  
3 1000  3000  0,001  5  
4 1000  4000  0,001  6  
5 1000  5000  0,001  7  
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Лабораторная работа № 3 
ИЗУЧЕНИЕ МАТЕМАТИЧЕСКОГО ОПИСАНИЯ 

И МЕТОДОВ ПОЛУЧЕНИЯ ЧАСТОТНЫХ 
ХАРАКТЕРИСТИК ЛИНЕЙНЫХ ЗВЕНЬЕВ 

 
Цель работы: освоить методики получения частотных характе-

ристик трех основных видов линейных звеньев: пропорционально-
го (безынерционного) звена, апериодического звена первого поряд-
ка (инерционного) и звена (чистого) запаздывания. 
Задание: 
1. Изучить получение частотных характеристик линейных звеньев. 
2. Получить экспериментальные частотные характеристики про-

порционального звена путем моделирования. 
3. Рассчитать теоретические частотные характеристики пропор-

ционального звена. 
4. Построить полученные частотные характеристики пропор-

ционального звена.  
5. Сделать выводы о соответствии полученных экспериментальных 

и теоретических частотных характеристик пропорционального звена. 
6. Повторить пункты 2–5 для апериодического звена первого 

порядка. 
7. Повторить пункты 2–5 для звена чистого запаздывания. 

Аппаратура, используемая в лабораторной работе 
Работа выполняется на персональных ЭВМ с использованием 

системы компьютерных расчетов MATLAB и входящего в ее со-
став пакета компьютерного моделирования Simulink.  

Выполнение работы 

1. Частотные характеристики линейных звеньев 
Если на линейное звено (систему) подать гармоническое воз-

действие вида (8), то после окончания переходного процесса на 
выходе звена установится также гармонический сигнал: 

( ) ( )sinyy t A t= ω + ϕ ,                                (23) 

где Ay – амплитуда выходного сигнала;  
φ – разность фаз между выходным и входным сигналами, рад. 
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Физические свойства линейных звеньев (систем) таковы, что 
частота входного и выходного сигналов одинакова. Амплитуда вы-
ходного сигнала при постоянной амплитуде входного сигнала 
и разность фаз между выходным и входным сигналами зависят от 
частоты (рис. 18). 

 
Рис. 18. Входной и выходной гармонические сигналы  

линейного звена 
 

Амплитудной частотной характеристикой (АЧХ) называет-
ся зависимость отношения амплитуд выходного и входного гармо-
нических сигналов от частоты в установившемся режиме: 

( ) y

x

A
A

A
ω = .                                         (24) 

Фазовой частотной характеристикой (ФЧХ) называется за-
висимость разности фаз φ(ω) между выходным и входным сигна-
лами от частоты в установившемся режиме. 
Одному периоду колебаний выходного сигнала Tn соответствует 

разность фаз в радианах, равная 2π. Поэтому разность фаз по гра-

фику можно рассчитать из пропорции ( ) 2

n nT
ϕ ω π

=
ϕ

: 

( ) 2 n

nT
π ϕ

ϕ ω = ,                                      (25) 

где φn – отставание выходного сигнала от входного, с. 

t, c

u(t), B x(t) 

y(t) 

 φn 

Ax 

Ay 
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Амплитудно-фазовой частотной характеристикой (АФЧХ) 
называется совместная амплитудная и фазовая частотная характе-
ристика. 
АЧХ, ФЧХ и АФЧХ называются частотными характеристи-

ками звена и определяют реакцию звена на гармоническое входное 
воздействие в зависимости от его частоты. 
Расчет частотных характеристик звена. В выражении переда-

точной функции звена ( )W s  выполним подстановку s j= ω  и полу-
чим частотную передаточную функцию ( )W jω . После избавления 
от возможной мнимости в знаменателе, можем представить частот-
ную передаточную функцию в виде комплексного выражения  

( ) ( ) ( )W j U j Vω = ω + ω ,                             (26) 

где U(ω) – действительная часть частотной передаточной функции; 
V(ω) – мнимая часть частотной передаточной функции. 

 
Как действительная U(ω), так и мнимая V(ω) части частотной 

передаточной функции W(jω) представляют собой выражения, за-
висящие только от частоты ω. 
Применив формулу Эйлера, частотную передаточную функцию 

можно представить в виде 

( ) ( ) ( )jW A e ⋅ϕ ωω = ω , 

где A(ω) – амплитуда частотной передаточной функции (соответ-
ствует АЧХ); 
φ(ω) – фаза частотной передаточной функции (соответствует 

ФЧХ), рад. 
 
Тогда для вычисления АЧХ и ФЧХ получаем следующие  

формулы: 

( ) 2 2( ( )) ( ( ))A U Vω = ω + ω ;                            (27) 

( ) ( )arctg
( )

V
U

ω
ϕ ω =

ω
.                                   (28) 
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Построение графиков АЧХ, ФЧХ и АФЧХ 
При построении графиков АЧХ и ФЧХ по оси абсцисс отклады-

вают значения частоты ω от 0 до ∞, а по оси ординат – соответст-
вующие значения A(ω) или φ(ω). 
График АФЧХ, называемый также годографом Найквиста, 

объединяет на одной плоскости АЧХ и ФЧХ. Его можно строить 
двумя способами: используя прямоугольные декартовы или поляр-
ные координаты. 
При построении графика АФЧХ в прямоугольных декартовых 

координатах по известным значениям U(ω) и V(ω) на комплексной 
плоскости для каждого значения частоты ω по горизонтальной 
оси следует откладывать значения действительной части частотной 
передаточной функции U(ω), а по вертикальной оси – соответст-
вующие значения мнимой части V(ω). 
При построении графика АФЧХ в полярных координатах по из-

вестным значениям A(ω) и φ(ω) на комплексной плоскости для ка-
ждого значения частоты ω, поступают следующим образом:  

– значение ФЧХ φ(ω) откладывают как угол от положительного 
направления оси абсцисс; 

– на построенном луче откладывают длину АЧХ A(ω) для этой 
частоты и получают точку; 

– точки, полученные при изменении частоты ω от 0 до ∞, соеди-
няют плавной линией. 

 

2. Получение частотных характеристик  
пропорционального (безынерционного) звена 

Создайте в надстройке Simulink пакета MATLAB схему для 
получения частотных характеристик пропорционального (безы-
нерционного) звена. 
Запустите систему компьютерного моделирования MATLAB 
и пакета Simulink (см. выполнение лабораторной работы № 1).  
Откройте модель, созданную при исследовании статических 
характеристик пропорционального звена при выполнении лабо-

раторной работы № 2, нажав на кнопку  Открыть панели ин-
струментов основного окна MATLAB или выбрав в меню основ-
ного окна MATLAB пункт File→Open… 
Для моделирования подачи гармонического напряжения на вход 
исследуемой электрической цепи внесите в модель следующие 
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изменения: удалите блок U1 источника постоянного напряжения, 
блок Breaker, блок Step подачи ступенчатого управляющего 
сигнала.  
Удалить блок из схемы можно одним из двух способов: 
1) выделить данный блок однократным щелчком правой клави-

шей мыши и во всплывающем меню выбрать пункт Clear; 
2) выделить данный блок однократным щелчком левой клави-

шей мыши и затем нажать на клавиатуре клавишу Delete. 
Далее на место удаленных блоков нужно вставить источник пе-
ременного гармонического напряжения. Для этого на вкладке 
Electrical Sources в библиотеке SimPowerSystems в окне 
Simulink Library Brouser выберите блок AC Voltage Source 
(Источник переменного напряжения) и перетащите его в окно 
с моделируемой схемой. Название блока AC Voltage Source из-
мените на U1. Вход блока U1 соедините с нулевой линией, а вы-
ход – со входом блока R1. Задайте параметры источника U1. 
Двойным щелчком левой клавишей мыши по нему откройте ок-
но задания параметров блока Block parameters: U1 и в полях 
Peak amplitude (V) и Frequency (Hz) введите значения, соот-
ветственно, амплитуды (в вольтах) – 5, и частоты (в герцах) – 
0.66. Подтвердите ввод нажатием кнопок Apply и OK. 
Примерный вид полученной модели изображен на рис. 19. 

 

 
Рис. 19. Схема для получения частотных характеристик  

пропорционального звена в Simulink 
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Сохраните созданную модель в рабочую папку под другим 
именем (например, под именем sin_voltage_prop.mdl). 
Запустив процесс моделирования (пункт меню Simulation→Start), 

увидим результат: в окне осциллографа на рис. 20 отображаются 
гармонические сигналы пропорционального звена: изменение на-
пряжений U1 и U2 на входе и выходе цепи. 
 

 
Рис. 20. Входной и выходной гармонические сигналы 

 
Для нахождения амплитуды входного сигнала Ах следует на 

верхнем графике измерить по вертикальной оси расстояние от 
верхней точки любого периода до нуля (см. рис. 20), или, что то же 
самое, расстояние от нижней точки любого периода до нуля (мож-
но также измерить расстояние от верхней до нижней точки одного 
периода и разделить пополам). 
Амплитуда выходного сигнала Ау находится аналогично, но из-

мерения проводятся на нижнем графике. 
Для измерения отставания φn следует заметить одну и ту же точ-

ку (например, минимум (см. рис. 20), максимум или ноль) для со-
ответствующих периодов на верхнем и нижнем графиках и опреде-
лить координаты этих точек по горизонтальной оси. Затем нужно 
из координаты точки на верхнем графике вычесть координату со-
ответствующей точки на нижнем графике. 
Заметим, что для исследуемого звена разность фаз (и отстава-

ние, см. рис. 20) будет равна нулю для всех частот. 

Тп 

Ах 

Ау 
φп 
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Период выходного сигнала Тn измеряется по нижнему графику – 
это будет расстояние (по горизонтальной оси) между двумя сосед-
ними максимумами (см. рис. 20) или минимумами выходного гар-
монического сигнала. 
Проведите компьютерное моделирование схемы для значений 
частоты переменного гармонического входного напряжения U1 
(0.16, 0.33, 0.66, 1.57, 3.77 Гц) и для значения амплитуды вход-
ного напряжения 5 В. Для каждого значения частоты определи-
те по экрану осциллографа амплитуды входного Ах и выходного 
Ау сигналов в единицах вертикальной шкалы экрана (в вольтах), 
а также отставание φn и период выходного сигнала Тn в едини-
цах горизонтальной шкалы экрана (в секундах). Результаты 
внесите в графы Ах, Ау, φn и Тn табл. 3.  
Для более точных измерений по экрану осциллографа можно 

воспользоваться экранной лупой как по оси Х, так и по оси Y. 
Рассчитайте АЧХ по формуле (24), результаты расчетов для 
всех рассмотренных частот внесите в строку А(ω) табл. 3. 
Рассчитайте ФЧХ по формуле (25), результаты расчетов для 
всех рассмотренных частот внесите в строку φ(ω) табл. 3. 

 
Таблица 3 

Результаты измерений и расчетов для построения экспериментальных 
и теоретических частотных характеристик звена 

ω, с–1 0 0.16 0.33 0.66 1.57 3.77 ∞ 

Aр(ω)        

φр(ω)        

Ax, В –      – 

Ay, В –      – 

Tn –      – 

φn –      – 

A(ω)         

φ(ω)        
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3. Получение теоретических частотных характеристик  
пропорционального (безынерционного) звена 

Получение передаточной функции звена. Выполним преобра-
зование Лапласа уравнения (13): 

( ) ( )2 1U s K U s= . 

Найдем отношение изображений выходного U2(s) и входного 
U1(s) сигналов и получим передаточную и частотную передаточ-
ную функции звена: 

( ) ( )
( )

2

1

U s
W s K

U s
= = .                                  (29) 

Расчет частотных характеристик звена. В выражении (29) пе-
редаточной функции выполним подстановку s j= ω  и получим 

( ) 0W K K jω = = +  

В результате получилось комплексное выражение вида 

( ) ( ) ( )W U jVω = ω + ω , 

где K – действительная часть частотной передаточной функции, 
( )U Kω = ; 

V – мнимая часть частотной передаточной функции, V(ω) = 0. 
 
Тогда для АЧХ и ФЧХ по формулам (27) и (28) получаем соот-

ветственно 

( ) 2 20 ;A K Kω = + =                                (30) 

( ) 0arctg arctg0 0
K

ϕ ω = = = .                          (31) 

Проведите расчет теоретических значений Ар(ω) и φр(ω) для 
значений частоты переменного гармонического входного напря-
жения U1 (0, 0.16, 0.33, 0.66, 1.57, 3.77, ∞ Гц) и значения входной 
амплитуды (5 В) по формулам (30) и (31), предварительно рассчи-
тав K по формуле (12). Результаты занести в строки Ар(ω) и φр(ω) 
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табл. 3, продублировав их в строках А(ω) и φ(ω) для значений 
А(0) и φ(0) (при ω = 0) и А(∞) и φ(∞) (при ω = ∞). 

 

4. Построение полученных частотных характеристик  
в одних координатах 

Постройте следующие графики: 
– по результатам расчета A(ω) и Aр(ω) – экспериментальную 
и теоретическую АЧХ (в одних координатах); 

– по результатам расчета φ (ω) и φ р(ω) – экспериментальную 
и теоретическую ФЧХ (в одних координатах); 

– экспериментальную и теоретическую АФЧХ (в одних коор-
динатах). 
Общий вид графиков АЧХ и ФЧХ пропорционального звена по-

казан на рис. 21. 
 

 
а                                                                         б 

Рис. 21. Общий вид графиков АЧХ (а) и ФЧХ (б) пропорционального звена 
 

Общий вид графика АФЧХ для пропорционального звена пока-
зан на рис. 22.  

 

 
Рис. 22. Общий вид графика АФЧХ пропорционального звена 
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Получите графики АЧХ, ФЧХ и АФЧХ пропорционального 
звена с помощью инструмента Powergui. 
Для получения частотных характеристик исследуемой цепи 

используется специальный блок Powergui, расположенный в биб-
лиотеке SimPowerSystems. Данный блок содержит в себе не-
сколько полезных инструментов для выполнения анализа электри-
ческих схем (расчет схемы векторным методом, расчет 
установившегося режима, расчет частотных характеристик и т. д.).  
Поместите блок Powergui в окно с исследуемой схемой (на 
рис. 20 он обозначен как Powergui-Continuous). Затем выполни-
те по нему двойной щелчок левой клавишей мыши, в результате 
чего откроется окно (название окна совпадает с именем файла 
созданной модели), отображающее все инструменты анализа, 
входящие в блок Powergui. Вам потребуется инструмент LTI-
Viewer (Анализатор линейных стационарных систем), для от-
крытия которого выполните щелчок левой клавишей мыши на 
кнопке Use LTI-Viewer. В появившемся окне Powergui link to 
LTI view показаны имеющиеся входы System inputs и выходы 
System outputs системы. По умолчанию в качестве входа и вы-
хода модели выбраны первые элементы в списках. Измените вы-
бранный выход U_Voltmeter U1 на U_Voltmeter U2 и нажмите 
кнопку Open new LTI-Viewer. 
В открывшемся окне инструмента LTI-Viewer по умолчанию 
показан рассчитанный автоматически график переходной функ-
ции анализируемой схемы. Для отображения графиков АЧХ 
и ФЧХ правой клавишей мыши щелкните один раз на белом поле 
с графиком и во всплывающем меню выберите пункт Plot 
Types→Bode. Верхний из двух появившихся графиков – график 
АЧХ, а нижний – ФЧХ системы. Щелкните на одном из графи-
ков правой клавишей мыши и во всплывающем меню поставьте 
галочку в пункте Grid (отображение сетки на графиках). Повто-
рив щелчок правой клавишей мыши, выберите пункт Properties 
всплывающего меню, на вкладке Units задайте единицы измере-
ния по осям графиков: для частоты в поле Frequency in выбери-
те значение Hz (в герцах), для отношения амплитуд сигналов на 
входе и выходе схемы в поле Magnitude in вместо dB (децибел) 
выберите значение absolute. Вид полученных графиков показан 
на рис. 23. 
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Рис. 23. Примерный вид графиков АЧХ и ФЧХ пропорционального звена 

 
Для получения графика АФЧХ исследуемой схемы следует 
щелкнуть по одному из графиков правой кнопкой мыши и во 
всплывающем меню выбрать пункт Plot Types→Nyquist. Далее 
следует повторить щелчок правой клавишей мыши по полученному 
графику и в пункте меню Show→Negative Frequencies убрать га-
лочку. Полученный график имеет вид, показанный на рис. 24. 

 

 
Рис. 24. Примерный вид графика АФЧХ пропорционального звена 
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5. Выводы о соответствии полученных экспериментальных 
и теоретических частотных характеристиках  
пропорционального звена 

Сравните графики АЧХ, ФЧХ и АФЧХ пропорционального 
звена, полученные различными способами, и сделайте выводы об 
их соответствии. 

 
6. Получение экспериментальных и теоретических  
частотных характеристик апериодического звена первого 
порядка (инерционного) 

Измените модель апериодического звена первого порядка, соз-
данную при выполнении лабораторной работы № 1, для получения 
частотных характеристик аналогично тому, как это было прове-
дено при выполнении пункта 2 данной лабораторной работы. 
Приблизительный вид схемы для получения частотных характе-

ристик апериодического звена первого порядка показан на рис. 25. 
 

 
Рис. 25. Схема для получения частотных характеристик апериодического  

звена первого порядка в Simulink 
 

Сохраните созданную модель в рабочую папку под другим 
именем (например, под именем sin_voltage_a1p.mdl). 
Запустив процесс моделирования (пункт меню Simulation→Start), 

увидим результат: в окне осциллографа на рис. 26 отображаются 



 58 

гармонические сигналы – изменение напряжений U1 и U2 на входе 
и выходе цепи. 
 

 
 

Рис. 26. Расчет частотных характеристик апериодического звена первого порядка 
 

Проведите компьютерное моделирование схемы и измерения 
амплитуды входного Ах и выходного Ау сигналов, отставания φn 
и периода Тn аналогично тому, как это было сделано при выпол-
нении пункта 2 лабораторной работы. Постройте таблицу, анало-
гичную табл. 3, для исследования апериодического звена первого 
порядка. Результаты внесите в графы Ах, Ау, φn и Тn таблицы.  
Заметим, что в этом случае разность фаз уже будет отлична от 

нуля и различна для разных частот. 
Рассчитайте АЧХ по формуле (24), результаты расчетов для 
всех рассмотренных частот внесите в строку А(ω) таблицы. 
Рассчитайте ФЧХ по формуле (25), результаты расчетов для 
всех рассмотренных частот внесите в строку φ(ω) таблицы. 

 
Получение теоретических частотных характеристик  
апериодического звена первого порядка (инерционного) 
Получение передаточной функции звена. Выполним преобра-

зование дифференциального уравнения (15): 

( ) ( ) ( )2 2 1Ts U s U s K U s+ = . 

Найдем отношение изображений выходного U2(s) и входного 
U1(s) сигналов и получим передаточную и частотную передаточ-
ную функции звена: 

Ах 

Ау 
Тп φп 
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( ) ( )
( )

2

1 1
U s KW s
U s T s

= =
+

.                              (32) 

Расчет частотных характеристик звена. В выражении переда-
точной функции (32) выполним подстановку s j= ω  и преобразуем 
его следующим образом: 

( ) ( )( )
( )( ) ( )( )

1
1 1 1

K j TKW
T j j T j T

− ω
ω = = =

ω + + ω − ω
 

( )
( ) ( ) ( )2 2 22

.
1 1 1

K j K T K K Tj
T T T

+ − ω − ω
= = +

+ ω + ω + ω
 

В результате получилось комплексное выражение вида 

( ) ( ) ( )W U jVω = ω + ω , 

где U(ω) – действительная часть частотной передаточной функции: 

( )
( )21
KU
T

ω =
+ ω

; 

V(ω) – мнимая часть частотной передаточной функции: 

( )
( )21
K TV

T
− ω

ω =
+ ω

. 

Тогда для АЧХ и ФЧХ по формулам (27) и (28) получаем соот-
ветственно 

( )
( ) ( ) ( )

2 2

2 2 21 1 1

K K T KA
T T T

   − ω
   ω = + =
   + ω + ω + ω   

;        (33) 

( ) ( )

( )

( )
2

2

1
arctg arctg

1

K T
T

TK
T

− ω
+ ω

ϕ ω = = − ω

+ ω

.                 (34)  
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Проведите расчет теоретических значений Ар(ω) и φр(ω) для зна-
чений частоты переменного гармонического входного напряжения 
U1 (0, 0.16, 0.33, 0.66, 1.57, 3.77, ∞ Гц) и значения входной ампли-
туды (5 В) по формулам (33) и (34), предварительно рассчитав Т 
и K по формулам (16) и (17). Результаты занесите в строки Ар(ω) 
и φр(ω) таблицы, продублировав их в строках А(ω) и φ(ω) для 
значений А(0) и φ(0) (при ω = 0) и А(∞) и φ(∞) (при ω = ∞). 
Постройте следующие графики: 
– по результатам расчета A(ω) и Aр(ω) – экспериментальную 
и теоретическую АЧХ (в одних координатах); 

– по результатам расчета φ (ω) и φр(ω) – экспериментальную 
и теоретическую ФЧХ (в одних координатах); 

– экспериментальную и теоретическую АФЧХ (в одних коор-
динатах). 
Общий вид графиков АЧХ и ФЧХ апериодического звена перво-

го порядка показан на рис. 27, а АФЧХ – на рис. 28. 
 

 
а                                                                        б 

Рис. 27. Общий вид графиков АЧХ (а)  
и ФЧХ (б) апериодического звена первого порядка 

 

 
Рис. 28. Общий вид графика АФЧХ апериодического звена первого порядка 
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Получите графики АЧХ, ФЧХ и АФЧХ апериодического звена 
первого порядка с помощью инструмента Powergui, аналогично 
тому, как это было проведено при исследовании пропорциональ-
ного звена. 
Получаемые графики частотных характеристик приведены на 

рис. 29 а, б. 
 

    
а                                                                     б 

Рис. 29. Графики частотных характеристик апериодического звена  
первого порядка: а) АЧХ и ФЧХ; б) АФЧХ 

 
Сравните графики АЧХ, ФЧХ и АФЧХ апериодического звена 
первого порядка, полученные различными (тремя) способами, 
и сделайте выводы об их соответствии. 

 
7. Получение экспериментальных и теоретических  
частотных характеристик звена чистого запаздывания 

Измените модель звена чистого запаздывания, созданную при 
выполнении лабораторной работы № 1, для получения частот-
ных характеристик: удалите блок Step подачи ступенчатого 
управляющего сигнала. 
Это можно сделать одним из двух способов: 
1. выделить данный блок однократным щелчком правой клави-

шей мыши и во всплывающем меню выбрать пункт Clear; 
2. выделить данный блок однократным щелчком левой клави-

шей мыши и затем нажать на клавиатуре клавишу Delete. 
На место удаленного блока поставьте источник гармоническо-
го входного сигнала.  
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Для этого в окне Simulink Library Brouser в библиотеке 
Simulink на вкладке Sources найдите пиктограмму блока Sin 
Wave (Генератор синусоидального сигнала), выделите его левой 
клавишей мыши и, не отпуская ее, перетащите данный компо-
нент в окно редактирования модели.  
Выход блока Sin Wave соедините со входом блока Transport 

Delay. Двойным щелчком левой клавишей мыши по нему от-
кройте окно задания параметров блока Sin Wave и в поле 
Amplitude и Frequency (rad/s) введите значения, соответственно, 
амплитуды – 2, и частоты – 1. Подтвердите ввод нажатием кно-
пок Apply и OK. 
Приблизительный вид полученной модели показан на рис. 30. 

 

  
Рис. 30. Схема для получения частотных характеристик  

звена запаздывания в Simulink  
 

Сохраните созданную модель на жесткий диск под другим 
именем (например, под именем sin_voltage_delay.mdl). 
При запуске процесса моделирования (пункт меню 

Simulation→Start) для времени моделирования, равного 15 с, в ок-
не осциллографа на рис. 31 отобразятся гармонические сигналы – 
изменение входного и выходного сигналов. 
При этом для получения экспериментальных характеристик зна-

чения входных амплитуды и частоты следует задавать непосредст-
венно в блоке Sin Wave. 
Проведите компьютерное моделирование схемы и измерения 
амплитуды входного Ах и выходного Ау сигналов, отставания φn 
и периода Тn аналогично тому, как это было сделано при выполне-
нии пункта 2 лабораторной работы. Постройте таблицу, анало-
гичную табл. 3, для исследования звена чистого запаздывания. 
Результаты внесите в графы Ах, Ау, φn и Тn таблицы.  
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Рассчитайте АЧХ по формуле (24), результаты расчетов для 
всех рассмотренных частот внесите в строку А(ω) таблицы. 
Рассчитайте ФЧХ по формуле (25), результаты расчетов для 
всех рассмотренных частот внесите в строку φ(ω) таблицы. 

 

 
Рис. 31. Расчет частотных характеристик звена запаздывания 

 
Теоретические частотные характеристики звена  
запаздывания 
Получение передаточной функции звена. Выполним преобра-

зование Лапласа уравнения (20): 

( ) ( )sY s e X s−τ= . 

Найдем отношение изображений выходного Y(s) и входного X(s) 
сигналов и получим передаточную и частотную передаточную 
функции звена: 

( ) ( )
( )

sY s
W s e

X s
−τ= = .                                 (35) 

Расчет частотных характеристик звена. В выражении переда-
точной функции (35) выполним подстановку s j= ω  и преобразуем 
его следующим образом: 

( ) .jW e− τωω =  

φп Ах 

Ау 

Тп 
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Тогда для АЧХ и ФЧХ получаем, соответственно, следующие 
формулы: 

( ) 1A ω = ;                                          (36) 

( )ϕ ω = −τ ω .                                       (37) 

Проведите расчет теоретических значений Ар(ω) и φр(ω) для 
значений частоты переменного гармонического входного напря-
жения U1 (0, 0.16, 0.33, 0.66, 1.57, 3.77, ∞ Гц) и значения входной 
амплитуды (5 В) по формулам (36) и (37) (значение времени  
запаздывания τ соответствует варианту). Результаты занести 
в строки Ар(ω) и φр(ω) таблицы, продублировав их в строках А(ω) 
и φ(ω) для значений А(0) и φ(0) (при ω = 0) и А(∞) и φ(∞) (при 
ω = ∞). 

 

Постройте следующие графики: 
– по результатам расчета A(ω) и Aр(ω) – экспериментальную 
и теоретическую АЧХ (в одних координатах); 

– по результатам расчета φ (ω) и φ р(ω) – экспериментальную 
и теоретическую ФЧХ (в одних координатах); 

– экспериментальную и теоретическую АФЧХ (в одних коорди-
натах). 
Общий вид графиков АЧХ и ФЧХ звена запаздывания показан 

на рис. 32 а, а графика АФЧХ – на рис. 32, б. 
 

 
а                                                          б 

Рис. 32. Примерный вид графиков АЧХ и ФЧХ (а)  
и АФЧХ (б) звена запаздывания 
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Содержание отчета 
1. Название лабораторной работы, цель, задание. 
2. Результаты исследования пропорционального (безынерционно-

го) звена:  
1) данные для построения экспериментальных и теоретических 

частотных характеристик (табл. 3);  
2) графики экспериментальных и теоретических АЧХ, ФЧХ 

и АФЧХ, а также графики характеристик, полученных с помощью 
компонента Powergui;  

3) выводы о соответствии экспериментальных характеристик 
теоретическим. 

3. Результаты исследования апериодического звена первого по-
рядка (инерционного).  

4. Результаты исследования звена запаздывания.  
 

Контрольные вопросы 
1. Дайте определение: АЧХ, ФЧХ, АФЧХ. 
2. Как называется график АФЧХ? Как он строится? 
3. Изложите методику получения частотных характеристик ли-

нейных звеньев теоретическим и экспериментальным методами. 
4. Опишите полученные графики. 

 
Исходные данные 

Вариант R1, Ом R2, Ом С, Ф τ, с 
1 1000  1000  0,001  3  
2 1000  2000  0,001  4  
3 1000  3000  0,001  5  
4 1000  4000  0,001  6  
5 1000  5000  0,001  7  
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Лабораторная работа № 4 
ЛИНЕАРИЗАЦИЯ ГЛАДКИХ  

НЕЛИНЕЙНЫХ ХАРАКТЕРИСТИК ЗВЕНЬЕВ  
СИСТЕМ АВТОМАТИЗАЦИИ 

 
Цель работы: освоить методику линеаризации гладких нели-

нейных характеристик звеньев систем автоматизации на примере 
резистивного моста как устройства сравнения. 
Задание: 
1. Провести линеаризацию нелинейного уравнения статической 

характеристики резистивного моста графоаналитическим методом. 
2. Провести линеаризацию нелинейного уравнения статической 

характеристики резистивного моста аналитическим методом. 
3. Сделать выводы о соответствии линеаризованных статиче-

ских характеристик друг другу. 

Аппаратура, используемая в лабораторной работе 
При выполнении лабораторной работы используется лаборатор-

ный стенд, содержащий панель лабораторных работ (рис. 33) 
и схему исследуемого резистивного моста (рис. 34).  
Для измерения напряжения питания схемы UП и выходного 

напряжения разбаланса моста UМ используются имеющиеся на 
панели лабораторных работ вольтметры V1 и V2. Для имитации 
датчика (Rд) и задатчика (Rзад) используются магазины сопро-
тивлений. Для включения в мост магазинов сопротивлений 
и соединения моста с вольтметрами стенда используется ком-
плект проводов с наконечниками. 

 
Выполнение работы 

1. Линеаризация нелинейного уравнения  
статической характеристики резистивного  
моста графоаналитическим методом 

Получение экспериментальных данных 
Соедините проводами с наконечниками выходы напряжения 
питания моста UП (рис. 1) с входами «–» и 15 В вольтметра 
стенда.  
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Рис. 33. Панель лабораторных работ 

1 – тумблер и сигнальная лампа «Сеть», предназначенные для включения  
и индикации наличия питания; 2 – вольтметры V1 и V2;  

3 – гнезда входов вольтметров с пределами измерений 15 В или 3 В;  
4 – переключатель выбора частоты ω, с–1 и ручка А плавного регулирования  
амплитуды напряжения; 5 – ручки регулирования уровней напряжения  

для первого источника – U1; для второго – U2; 6 – гнезда выходов генератора  
синусоидального напряжения обозначены sin и гнезда выходов первого  
и второго источников питания обозначены соответственно U1 и U2 

 

 
Рис. 34. Схема исследуемого резистивного моста 

2 
1 
 
 
 
 
 
 
 
 
 
3 
 
 
6 

5 

4 

Uм Uп 

R1 R2 

Rзад Rд 



 68 

Включите питание лабораторного стенда и измерьте напряже-
ние питания моста UП с помощью вольтметра стенда. Выключите 
питание лабораторного стенда. 
Запишите значение напряжения питания моста UП и указанные 
на стенде значения сопротивлений R1 и R2. 
Подсоедините к схеме на панели лабораторных работ магази-
ны, имитирующие датчик и задатчик (см. рис. 34). Подсоедините 
выход моста (UМ) к вольтметру стенда. Установите на соответст-
вующем магазине значение сопротивления RД 0 датчика, при ко-
тором будет проводиться линеаризация (по вариантам). 
Включите питание лабораторной установки и сбалансируйте 
мост магазином, имитирующим задатчик. 
Изменяя сопротивление RД датчика от 0 до 4 кОм через 200 Ом 
и от 4 кОм до 9 кОм через 1 кОм, снимите зависимость UМ(RД) 
с заполнением табл. 4. 

 
Таблица 4 

Экспериментальная зависимость напряжения на выходе моста  
от изменения сопротивления датчика 

RД, Ом 0 200 400 … 7000 8000 9000 
UМ, В    …    

 
Линеаризация статической характеристики моста  
по экспериментальным данным 
Идея графоаналитического метода линеаризации заключается 

в замене исходной нелинейной характеристики звена ( )y f x=  ли-
нейной функцией в окрестностях некоторой точки с координатами 
x0, y0, соответствующей заданному режиму работы. При этом ли-
нейная характеристика является касательной к исходной нелиней-
ной в этой точке (рис. 35).  
Коэффициент передачи находится как отношение Δy/Δx для 

любых двух точек касательной в точке линеаризации. 
Постройте график полученной экспериментальной нелинейной 
характеристики моста, откладывая по оси абсцисс значения зада-
ваемых сопротивлений, а по оси ординат – измеряемого напря-
жения разбаланса моста.  



 69 

 
Рис. 35. Нелинейная статическая характеристика 

 
Проведите касательную в точке баланса моста. Перенесите ко-
ординаты в точку линеаризации.  
Определите по графику значения MU∆  и ДR∆ , при которых 
график касательной практически совпадает с графиком статиче-
ской характеристики моста, построенным по экспериментальным 
данным. 
Рассчитайте коэффициент KМ моста как отношение  

M M ДK U R= ∆ ∆ .                                  (38) 

Запишите линеаризованное уравнение моста вида  

M Э М ДU K R= ∆ , 

подставив рассчитанный коэффициент пропорциональности KМ. 
 

2. Линеаризация нелинейного уравнения статической  
характеристики резистивного моста аналитическим методом 

По математическому описанию элементы и системы автоматики 
делятся на линейные и нелинейные. 

Линейными элементами (звеньями) называются элементы авто-
матики, математически описываемые линейными дифференциаль-
ными уравнениями. 

y = f(x)

x

y

x0

y0
∆x 

∆y 

y-y0 = k⋅(x-x0)  или  ∆y = k⋅∆x
y – y0 = k (x – x0) или 
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Линейными системами автоматического управления называ-
ются системы, состоящие только из линейных элементов. 
В общем случае для линейного элемента (или системы) взаимо-

связь входного сигнала u и выходного сигнала y математически 
описывается дифференциальным уравнением вида: 

1 1

0 1 1 0 11 1... ... ,
n n m m

n n mn n m m

d y d y dy d u d ua a a a y b b a u
dt dt dt dt dt

− −

−− −+ + + + = + + +  (39) 

где a0, a1, …, an и b0, b1, …, bm – некоторые постоянные коэф-
фициенты; 

n – порядок системы, m n< . 
 
Нелинейными элементами называются элементы, описывае-

мые нелинейными уравнениями. 
Система, содержащая хотя бы один нелинейный элемент, явля-

ется нелинейной. 
Резистивный мост (рис. 36) часто используется как элемент 

сравнения, если в системе применяется омический датчик регули-
руемой величины. Датчик включается в одно из плеч моста. Сопро-
тивление датчика Rд является входным сигналом моста. В качестве 
задатчика регулируемой величины используется одно из сопротив-
лений, образующих мост (Rзад), которое выполняется переменным. 
Выходным сигналом моста является напряжение Uм. В состоянии 
баланса моста напряжение на выходе моста равно нулю. 

 

 
Рис. 36. Измерительный резистивный мост 

Rд 

+UП 

Uм 

Rзад 

R1 R2 

U1 U2 

i1 i2 
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Получим уравнение резистивного моста, используя законы 
Кирхгофа: 

П
1 1 ЗАД ЗАД

1 ЗАД

П
2 2 Д Д

2 Д

,

,

UU i R R
R R

UU i R R
R R

= =
+

= =
+

 
П П

M 1 2 ЗАД Д
1 ЗАД 2 Д

U UU U U R R
R R R R

= − = −
+ +

,            (40) 

где Uм – напряжение на выходе моста, В; 
Uп – напряжение питания на выходе моста, В; 
R1, R2, Rзад, Rд – сопротивления, образующие мост, Ом. 

 
Связь между сопротивлением задатчика и заданным значением 

регулируемой величины определяется условием равновесия моста: 

Д 0 2 1 ЗАД 0R R R R− = , 

тогда 

2 Д 0
ЗАД

1

R R
R

R
= ,                                       (41) 

где RД 0 – сопротивление датчика при заданном значении регули-
руемой величины (задается преподавателем). 

 
Линеаризацию проводим в окрестности точки, для которой зна-

чение входного сигнала равно Д 0R , а соответствующее значение 
выходного сигнала равно M 0U . 

Теоретической основой линеаризации является разложение 
функции в ряд Тейлора в окрестностях точки с координатами x0, y0: 

( ) ( ) ( )( ) ( ) ( )20
0 0 0 0 ...

2!
y x

y x y x y x x x x x
′′

′= + − + − +  

Если отклонения входного и выходного сигналов от заданных 
значений x0, y0 достаточно малы, то при разложении в ряд Тейлора 
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можно учитывать только линейные члены, а остальными пренеб-
речь: 

( ) ( ) ( )( )0 0 0y x y x y x x x′≈ + − .                         (42) 

Обозначив отклонения сигналов от номинальных значений как 
0x x x∆ = − , 0y y y∆ = − , а также ( )0y x k′ = , получаем линейное 

уравнение: 

y k x∆ = ∆ . 

Линеаризуем уравнение моста аналитическим методом. Разло-
жим функцию (40) в ряд Тейлора в окрестностях точки с координа-
тами RД 0, UМ 0: 

Д Д 0

П П
M M 0 ЗАД Д Д Д 0

1 ЗАД 2 Д

( ) 0
R R

U UU U R R R R
R R R R

=

′ 
= + − − =  + + 

. 

Получаем 

( ) ( )
( )

Д Д 0

2 Д Д
M M 0 П Д Д 02

2 Д

1 0 1
0 ( ) 0

R R

R R R
U U U R R

R R
=

 + − + − = − − =
 + 

, 

( )
Д Д 0

П 2
M M 0 Д Д 02

2 Д

( ) 0
R R

U RU U R R
R R

=

− = − − =
+

, 

( )
П 2

M M 0 Д Д 02

2 Д 0

( ) 0U RU U R R
R R

− = − − =
+

. 

Обозначим Д Д Д 0R R R∆ = − ; M M M 0U U U∆ = − . 
Получаем 

( )
2

M Д2
2 Д 0

U RU R
R R

Π∆ = − ∆
+

, 
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или 

M М ДU K R∆ = ∆ , 

где Kм – коэффициент передачи моста: 

( )
П 2

М 2
2 Д 0

.U RK
R R

= −
+

                                  (43) 

При использовании моста как элемента сравнения, нулевому от-
клонению регулируемой величины от заданного значения (нулево-
му отклонению сопротивления датчика от его сопротивления RД 0 
при заданном значении регулируемой величины) должен соответ-
ствовать нулевой выходной сигнал моста. Поэтому линеаризацию 
проводим в точке баланса моста при UM0 = 0. При этом линеаризо-
ванное уравнение имеет вид 

M М ДU K R= ∆ .                                       (44) 

Запишите в общем виде линеаризованное уравнение статиче-
ской характеристики резистивного моста (44), полученное ана-
литическим методом. 
Рассчитайте по формуле (43) значение коэффициента пропорцио-
нальности с использованием значений R1, R2, Rзад, Uп, полученных 
при выполнении пункта 1, и подставьте в полученное уравнение.  
Запишите линеаризованное уравнение моста вида  

M М ДTU K R= ∆ , 

подставив рассчитанный коэффициент пропорциональности Kм. 
Постройте в одних координатах с графиком, полученным при 
выполнении пункта 1, график полученного линеаризованного 
уравнения статической характеристики резистивного моста. 

3. Сделайте вывод о соответствии линеаризованных  
статических характеристик друг другу 

 
Содержание отчета 

1. Название лабораторной работы, цель, задание. 
2. Значения исходных данных: напряжения питания моста Uп, 

сопротивлений R1 и R2, сопротивления Rд 0 датчика, при котором 
будет проводиться линеаризация. 
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3. Экспериментальные данные (табл. 4). 
4. Графики нелинейной статической характеристики и линеари-

зованных статических характеристик, полученных двумя методами. 
5. Расчет коэффициента передачи моста на основе графоанали-

тического метода. 
6. Линеаризованное уравнение моста, полученное графоанали-

тическим методом. 
7. Расчет коэффициента передачи моста аналитическим методом. 
8. Линеаризованное уравнение моста, полученное аналитическим 

методом.  
9. Выводы о соответствии линеаризованных статических ха-

рактеристик, полученных аналитическим и графоаналитическим 
методами. 

 
Контрольные вопросы 

1. Дайте определение линеаризации непрерывно дифференци-
руемых (гладких) характеристик элементов автоматики. 

2. При каких условиях нелинейные характеристики могут быть 
линеаризованы? 

3. Перечислите методы линеаризации гладких нелинейных ха-
рактеристик. 

4.  Изложите порядок линеаризации аналитическим методом. 
5.  Изложите порядок линеаризации путем графоаналитической 

обработки экспериментально полученной нелинейной характе-
ристики. 

6. В каком диапазоне сопротивлений и напряжений можно ис-
пользовать линеаризованные статические характеристики моста, 
полученные при выполнении лабораторной работы? 

 
Исходные данные по вариантам 

Вариант R1, Ом R2, Ом RД0, Ом 
1 2000  2000  1000  
2 2000  2000  1200  
3 2000  2000  1400  
4 2000  2000  1600  
5 2000  2000  1800  
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Лабораторная работа № 5 
ИДЕНТИФИКАЦИЯ ОБЪЕКТОВ УПРАВЛЕНИЯ  

И СРЕДСТВ АВТОМАТИЗАЦИИ 

Цель работы: освоить методику приближенной идентификации 
линейных звеньев по виду переходной характеристики, методику 
компьютерной идентификации линейных звеньев. 
Задание:  
1. Получить экспериментальную переходную характеристику 

сушильного шкафа. 
2. Провести идентификацию звена по виду переходной характе-

ристики и получить математическое описание звена. 
3. Провести идентификацию звена с помощью инструмента 

System Identification пакета MATLAB и получить математическое 
описание звена. 

4. Сравнить передаточные функции, полученные в результате 
расчетов и компьютерной идентификации. Сделать выводы. 

Аппаратура, используемая в лабораторной работе 
В качестве объекта идентификации используется учебный су-

шильный шкаф типа ШСУ (рис. 37), имеющий объем сушильной 
камеры 10 л и максимальную температуру нагрева 150 ºС. Для из-
мерения температуры воздуха внутри шкафа установлена термопа-
ра ТХА(К)–1199, предназначенная для измерения температур 
в диапазоне от –40 до +800  ºС.  

 

 
 

Рис. 37. Шкаф сушильный учебный 

 

тумблер включения/выключения 
шкафа 
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Для возможности передачи данных измерения на компьютер, 
термопара подключена к измерителю-регулятору СОСНА-003МД, 
расположенному на лабораторном стенде. Универсальный вход 
измерителя-регулятора дает возможность подключать без дополни-
тельного согласования термопреобразователи сопротивления, тер-
моэлектрические преобразователи (термопары) и преобразователи 
с выходными унифицированными сигналами тока или напряжения. 
Значение температуры внутри шкафа отображается на панели из-
мерителя СОСНА-003МД. 
Работа выполняется с использованием персональных ЭВМ, на 

которых установлена система компьютерных расчетов MATLAB 
с входящим в ее состав пакетом компьютерного моделирования 
Simulink и компьютерной программой SysView2, которая выполня-
ет считывание и сохранение данных о температуре внутри шкафа 
с измерителя СОСНА-003МД на компьютер.  

Выполнение работы 

1. Получение экспериментальной переходной  
характеристики сушильного шкафа 

Проведение измерений 
Включите питание стенда выключателем QF. 
Закройте дверцу сушильного шкафа. В начале эксперимента 
сушильный шкаф должен быть полностью остывшим: темпера-
тура внутри шкафа должна быть равна наружной температуре.  
Запустите компьютерную программу, которая выполняет счи-
тывание и сохранение данных о температуре внутри шкафа 
с измерителя СОСНА-003МД на компьютер. Для этого на ком-
пьютере нужно открыть папку c:\Sosna_003MD\SysView2\ и за-
пустить на выполнение файл SysView.exe. На экране компьютера 
появится окно (рис. 38). 
В появившемся рабочем окне программы SysView следует ука-
зать интервал опроса датчика температуры Δt. Оставьте без из-
менений предлагаемое по умолчанию значение 5 с.  
Программа SysView по умолчанию выполняет сохранение дан-

ных в текущую папку (c:\Sosna_003MD\SysView2\) в текстовый 
файл с именем 307_080917 COM1 Прибор1.txt.  
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Если файл с таким именем уже существует в каталоге, удалите его. 
Включите тумблером сушильный шкаф (см. рис. 37) и одно-
временно запустите начало измерений в программе SysView: на-
жмите левой клавишей мыши на кнопку Запуск (см. рис. 38). 

 

 
Рис. 38. Рабочее окно программы SysView 

 
При включении электронагревателя выделяемая им тепловая 

мощность скачкообразно изменяется от 0 Вт и составляет около 
100 Вт. Температура внутри печки θ начинает повышаться. Изме-
ритель СОСНА-003МД выполняет измерение температуры θ внут-
ри сушильного шкафа в дискретные моменты времени kt k t= ∆  
(k = 0, 1, 2, …), через определенный интервал времени Δt, называе-
мый интервалом дискретизации (например, каждые 5 с). Результа-
ты измерений отображаются на панели измерителя СОСНА-
003МД, а также передаются в компьютер и сохраняются в файле 
в виде таблицы.  
Измерения проводите до тех пор, пока температура в шкафу 
изменяется. 

кнопка Запуск 

кнопка Останов 
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Остановите измерения, нажав левой клавишей мыши на кнопку 
Останов (см. рис. 38) и закройте окно программы SysView. Вы-
ключите тумблером сушильный шкаф и питание стенда выклю-
чателем QF. 
Отыщите в папке c:\Sosna_003MD\SysView2\ файл с именем 

307_080917 COM1 Прибор1.txt и откройте его двойным щелчком 
левой клавишей мыши по имени файла. Проверьте файл на на-
личие строк со словами нет ответа. Вручную замените такие 
записи на подходящие по смыслу значения измеряемой темпера-
туры. Далее нужно заменить имеющиеся в файле запятые, отде-
ляющие целую часть числа от дробной, на точки. Для этого вы-
полните команду меню Правка→Заменить…, в появившемся 
диалоговом окне Замена в поле Что введите запятую, а в поле 
Чем – точку, и нажмите кнопку Заменить все. 
Сохраните файл в вашей рабочей папке под новым именем. 
Для этого выполните команду меню Файл→Сохранить 
как…, в появившемся диалоговом окне следует указать папку c:\ 
MATLAB6p5\work\..., в которой будет храниться файл (вместо 
многоточия указать название вашей рабочей папки), а в строке 
Имя файла – указать имя файла с расширением .txt. Имя файла 
необходимо набирать английскими символами без пробелов. 
В качестве имени файла, например, можно задать фамилию сту-
дента, выполняющего лабораторную работу. После ввода имени 
файла левой клавишей мыши нажмите кнопку ОК. 

Построение в пакете MATLAB экспериментальной  
переходной характеристики сушильного шкафа 
Выполните запуск MATLAB (см. выполнение лабораторной 
работы № 1). В появившемся главном окне программы MATLAB 
выберите пункт меню File→New→M-file. В результате на экране 
появится окно (с предлагаемым по умолчанию названием 
Untitled) для ввода последовательности команд М-файла. 
В данном окне с клавиатуры введите следующий текст програм-
мы, выполняющей построение графика переходной функции: 
clear all;  
close all;  
clc; 
experiment_data=load('c:\MATLAB6p5\work\....txt'); 
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% загрузка файла с массивом данных эксперимента –  
% вместо многоточия введите путь к файлу и имя  
% сохраненного рабочего файла 
y = experiment_data( : , 3) ; % данные изменения температуры -  
                                          % 3-й столбец загруженного массива 
N = length(y);  % длина массива значений температуры 
y = y - y(1);  % вычитание начального значения температуры 
Dt = 5;  % интервал опроса 
t_beg = 0;  % начальное значение времени 
t_end = Dt*(N-1);  % конечное значение времени 
t = [t_beg : Dt : t_end ]';   
% массив моментов времени, в которые производились  
% измерения температуры 
U = 220; 
u = U*ones(size(y)); 
% управляющее воздействие - изменение напряжения  
% на нагревательном элементе сушильного шкафа 
%-------------------- 
% построение графика переходной функции сушильного  
% шкафа 
figure(1); 
hold on; 
plot( t, y, 'k', 'LineWidth', 2 );   
% задание масштаба графика по осям x и y 
axis( [ t_beg  (t_end+10)   0  100] ); 
grid on; % отображать сетку графика 
xlabel( '{\itt}, c' ); % подпись по оси x 
ylabel( '{\ity}({\itt}), c' ); % подпись по оси y 
Y_st = y(N); % установившееся значение переходной функции 
plot( t, Y_st*ones(size(t)), 'b--', 'LineWidth', 0.5); 
legend( '{\ity}({\itt})' , '{\ity}_s_t' ); 

 

Сохраните введенную программу, выбрав в меню окна редак-
тирования модели untitled пункт File→Save as… После ввода 
имени файла левой кнопкой мыши нажмите кнопку Сохранить. 
Произведите запуск и выполнение набранной программы кла-
вишей F5, либо в окне с программой выберите пункт меню 
Debug→Run.  
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В результате выполнения набранной последовательности ко-
манд на экране появится окно Figure No. 1, содержащее график 
экспериментальной переходной функции сушильного шкафа. 
Примерный вид полученного графика показан на рис. 39. 
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Рис. 39. График экспериментальной переходной характеристики  

сушильного шкафа 
 

Полученный график включите в отчет. 
 
2. Проведение идентификации звена по виду  
переходной характеристики 

Выбор звена, которым описывается сушильный шкаф 
и определение значений его параметров 
Сравнивая полученный график экспериментальной переходной 
характеристики с графиками переходных функций, приведенны-
ми во втором столбце табл. 5, определите, на какой из них наи-
более похож полученный график.  
Выпишите из первого столбца табл. 5 название этого звена 
и общий вид его переходной и передаточной функций. 
Путем графоаналитической обработки экспериментальной пе-
реходной функции (как показано в табл. 5) оцените значения  
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параметров выбранного звена (постоянных времени и, при нали-
чии, времени запаздывания). 

 
Таблица 5 

Математические выражения и графики переходных функций  
наиболее распространенных на практике линейных динамических звеньев 

Апериодическое звено 1-го порядка 
Передаточная функция: 

( ) ;
1

KW s
T s

=
+

 

переходная функция:
 ( ) ( )1

t
Th t K e

−
= −  

t

Y

Yуст

касательная при t = 0

T  
Апериодическое звено 1-го порядка с чистым запаздыванием 
Передаточная функция: 

( )
1

sK eW s
T s

−τ

=
+

; 

переходная функция:

 ( ) ( )

0, при ,

1 , при
t

T

t
h t

K e t
− −τ

< τ
=   − ≥ τ   

 
t

Y

Yуст

касательная при t = τ

Tτ  
Апериодическое звено 2-го порядка 

Передаточная функция: 

( ) ( )( )3 41 1
KW s

T s T s
=

+ +
; 

переходная функция: 

( ) 3 43 4

3 4 3 4

3 4

1 ,

при

t t
T TT Th t K e e

T T T T

T T

− − 
= − +  − − 

>
  

t

Y

Yуст

касательная в точке перегиба

точка перегиба

T4 T3 + T4

Т τ 
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Значения постоянной времени находятся путем построения ка-
сательных к графику: в начале координат – для апериодического 
звена первого порядка, в точке начала изменения выходной вели-
чины – для апериодического звена первого порядка с запаздывани-
ем, в точке перегиба – для апериодического звена второго порядка. 
Коэффициент передачи K рассчитывается по формуле 

уст

вх

Y
K

u
= ,                                            (45) 

где Yуст – изменение температуры в сушильном шкафу при на-
греве, ºС; 

ивх – изменение входного воздействия, т. е. напряжения, пода-
ваемого на нагревательный элемент при включении сушильного 
шкафа, вх 220u = В. 

 
Например, если для построенного графика принято решение 

о том, что исследуемое звено описывается апериодическим звеном 
первого порядка, то после дополнительных построений (рис. 40) будет 
получено, что значение постоянной времени звена Т = 1000 с. 

 

 
Рис. 40. Графоаналитическое определение параметров звена 
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Для расчета коэффициента передачи найдем по графику устано-
вившееся значение выходной величины – 41 ºС. Получим 

41 0,186
220

K = ≈  ºС/В, 

т. е. с ростом величины входного напряжения на 1 В значение ус-
тановившейся температуры увеличится на 0,186 ºС. 
Рассчитайте по формуле (45) значение коэффициента передачи. 

Построение графика расчетной переходной  
характеристики сушильного шкафа 
В окне MATLAB с набранной программой построения графика 
добавьте следующий текст: 
% построение графика расчетной переходной функции  
% коэффициент преобразования входного сигнала  
% в выходной 
K = Y_st/U; 
Коэффициент преобразования входного сигнала в выходной (из-

менение напряжения на нагревательном элементе в изменение тем-
пературы внутри шкафа) будет общим параметром, одинаковым 
для любого из трех рассматриваемых динамических звеньев.  
Далее выберите и добавьте строки в зависимости от выбран-
ного типа звена:  
а) Если по графику установлено, что экспериментальная пере-
ходная функция соответствует апериодическому звену 1-го по-
рядка, введите значение постоянной времени и математическую 
формулу для переходной функции звена (после символов Т = 
нужно ввести рассчитанное по графику значение постоянной 
времени).  
% для апериодического звена 1-го порядка 
T =    ; % постоянная времени, сек. 
h = K*U*(1 - exp(-t/T)); % расчетная переходная функция 
б) Если экспериментальная переходная функция соответствует 
апериодическому звену 1-го порядка с запаздыванием, введи-
те значения постоянной времени, времени запаздывания, и мате-
матическую формулу для переходной функции звена (после сим-
волов Т = и tau =  нужно ввести определенные по графику 
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значения постоянной времени и времени запаздывания, соответ-
ственно):  
% для апериодического звена 1-го порядка с запаздыванием 
T =    ; % постоянная времени, сек. 
tau =    ; % время запаздывания, сек. 
h = sign(real(t>tau))*K*U.*(1 - exp(-(t-tau)/T));  
в) Если экспериментальная переходная функция соответствует 
апериодическому звену 2-го порядка, введите значения посто-
янных времени T3, T4 и математическую формулу для переход-
ной функции звена (после символов Т3 = и Т4 = нужно ввести 
рассчитанные по графику значения постоянных времени):  
% для апериодического звена 2-го порядка 
T3 =    ; 
T4 =    ; 
h = K*U*( 1 - T3/(T3-T4)*exp(-t/T3) + T4/(T3-T4)*exp(-t/T4) ); 

 

После этого введите команды, выполняющие построение кри-
вой расчетной переходной функции на графике, а также опреде-
ляющие максимальное расхождение (в процентах от установив-
шегося значения управляемой величины) между расчетной 
и экспериментальной кривыми:  
% расхождение между экспериментальной и расчетной  
% кривыми в процентах от установившегося значения 
delta = abs(h-y)/Y_st*100;  
% максимальное расхождение кривых  
[delta_max, i] = max( delta );  
figure(1); 
hold on; 
% расчетная переходная функция сушильного шкафа  
plot( t, h, 'r', 'LineWidth', 2 );  
plot( t(i), y(i), 'ro', t(i), h(i), 'ro'); 
line([t(i) t(i)], [y(i)  h(i)], 'Color', 'r', 'LineWidth', 2, 'LineStyle', ':'); 
text(mean(t), min([y(i) h(i)]), strcat('{\delta}_m_a_x = 
',num2str(round(delta_max)),' %'),... 
'FontWeight','bold', 'BackgroundColor', 'white'); 
Нажмите клавишу F5.  
В результате на графике отобразится дополнительно кривая рас-

четной переходной функции выбранного звена, а также значение 
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максимального расхождения между расчетной и эксперименталь-
ной кривыми (рис. 41). 
 

0 200 400 600 800 1000 1200 1400 1600 1800 2000
0

5

10

15

20

25

30

35

40

45

50

t, c

y(
t),

 c

δmax =7%

y(t)
yst

 
Рис. 41. Пример графика расчетной переходной характеристики  

с указанием значения максимального расхождения между экспериментальной  
и расчетной характеристиками 

 
Если по графику получено, что максимальное расхождение 
между экспериментальной и расчетной характеристиками со-
ставляет более 5 %, следует внести изменения в М-файл: подоб-
рать другие параметры звена (или изменить тип звена) и повто-
рить построение графика, добиваясь, чтобы максимальное 
расхождение не превысило значения 5 %. 
Полученный график, с указанием максимального расхождения 
между расчетной и экспериментальной переходными характери-
стиками, включить в отчет. 
Для найденных оптимальных параметров звена (для которых 
максимальное расхождение между экспериментальной и расчет-
ной переходными характеристиками составило не более 5 %)  
записать переходную и передаточную функции звена, описы-
вающего нагрев сушильного шкафа, подставив найденные зна-
чения параметров, с указанием типа звена. 
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3. Проведение идентификации звена с использованием  
инструмента System Identification пакета MATLAB 

Расчет теоретических переходных характеристик  
сушильного шкафа путем компьютерной идентификации 
Для решения задач идентификации динамических объектов 

в программе MATLAB-Simulink предназначен специальный раздел – 
System Identification (Идентификация систем).  
Для запуска раздела System Identification необходимо в MATLAB 
в окне ввода команд Command Window в командной строке 
(справа от знака >>) набрать слово ident и нажать Enter.  
В результате на экране появится окно графического интерфейса 

раздела System Identification, вид которого показан на рис. 42. 
 

 
Рис. 42. Вид окна графического интерфейса раздела System Identification 

 
Зададим в качестве моделей звеньев, описывающих нагрев су-

шильного шкафа, последовательно апериодические звенья первого 
и второго порядков и для каждого из них получим график расчет-
ной переходной характеристики сушильного шкафа путем компью-
терной идентификации. 
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Укажите исходные данные для выполнения идентификации. 
Для этого в левом верхнем углу окна в выпадающем списке Data 
(Данные) выберите вариант Import.  
Это приведет к открытию диалогового окна, показанного на 
рис. 43. Введите в нем имя u в поле Input (Вход), y – в поле 
Output (Выход), в поле Starting time (Начальный момент време-
ни) введите 0, а в поле Samp. interv. (Интервал дискретизации) 
введите выбранное при проведении эксперимента значение ин-
тервала опроса (5 с), в строке Data Name (Имя данных) укажите 
произвольное название (например, Heater). 
Нажмите кнопку Import. Далее нажатием кнопки Close (За-
крыть) закройте окно импорта данных. 

 

 
Рис. 43. Диалоговое окно импорта данных 

 
Указанные действия приведут к появлению в верхнем левом уг-

лу окна интерфейса значка в виде цветной линии, сопровождаемого 
надписью Heater (рис. 44). Это означает, что импортируемые дан-
ные введены в среду интерфейса. Сообщения об этих данных также 
появляются в значках Working Data (Рабочие данные) и Validation 
Data (Данные для проверки модели). 
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Рис. 44. Окно графического интерфейса раздела System Identification  

с загруженными данными 
 

Для нахождения передаточной функции объекта вначале необ-
ходимо указать вид математической модели объекта. Так как на-
чальными данными являются входной сигнал u и выходной сигнал 
y исследуемого объекта, а также различные шумы, всегда присут-
ствующие при экспериментальных измерениях, то следует выбрать 
модель типа «вход–выход» (по-английски Output–Error, т. е. «вы-
ход–ошибка», сокращенно OE): 

( ) ( )
( ) ( ) ( )B z

y t u t nk e t
F z

= − + , 

где ( ) 1 2
1 2 3 ... nb

nbB z b b z b z b z− − −= + + + + ; 

( ) 1 2
1 21 ... na

naF z f z f z f z− − −= + + + + ; 
e(t) – дискретный белый шум.  
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В окне ident: Untitled интерфейса идентификации в выпадаю-
щем списке Estimate (Оценивание) выберите вариант 
Parametric models… (так как оцениваются значения параметров 
передаточной функции объекта), что приведет к появлению диа-
логового окна, показанного на рис. 45. 
В данном окне в выпадающем списке Structure выберите 
пункт OE:[nb nf nk], соответствующий модели «вход–выход».  

 

 
Рис. 45. Диалоговое окно задания параметрической модели 

 
Далее необходимо задать порядок модели – целочисленные зна-

чения nb, nf и nk, определяющие, соответственно, порядок поли-
номов B(z) и F(z), а также интервал времени чистого запаздывания.  
Для задания значений, соответствующих апериодическому зве-
ну 1-го порядка: 1nf = , 1nb = ,  1nk = , нажмите кнопку 
Order Editor (Редактор порядка модели) и в появившемся диало-
говом окне (рис. 46) во всплывающих списках Poles (Число по-
люсов передаточной функции), Zeros + 1 (Число нулей переда-
точной функции + 1) и Delay (Запаздывание, выраженное 
числом интервалов дискретизации) выберите, соответственно, 
значения 1nf = ,  1nb = ,  1nk = , после чего нажмите кнопку 
Close (Закрыть).  
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Рис. 46. Диалоговое окно задания порядка параметрической модели 

 
В диалоговом окне Parametric models… в поле Orders (Поря-

док модели) появятся три единицы, а в поле Name (Имя модели) – 
заданное автоматически имя oe111.  
Для оценки передаточной функции объекта нажмите кнопку 

Estimate (Оценить). 
В результате в основном окне интерфейса ident: Untitled в его 

правой части Model Views (Вид моделей) появится значок с надпи-
сью oe111, означающий, что выбранная модель построена.  
Установите флажок Model Output (Выход модели). 
В появившемся окне (рис. 47) будут получены две кривые: 

экспериментальная и рассчитанная теоретически для выбранной 
модели. В правой части окна показывается степень совпадения 
(Best fits) рассчитанной кривой графика с экспериментальной (на 
рис. 47 это значение равно 95,3741 %). Значение 100 % соответст-
вует точному совпадению. 

 

 
Рис. 47. График теоретической переходной характеристики апериодического звена 
первого порядка с указанием степени совпадения с экспериментальной 
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Задайте теперь в качестве модели апериодическое звено 2-го 
порядка. Для этого в диалоговом окне Parametric models… на-
жмите кнопку Order Editor и в появившемся диалоговом окне в 
выпадающем списке Poles задайте значение 2nf = , ячейки 
Zeros + 1 и Delay оставьте без изменения: 1nb = ,  1nk = ; после 
чего нажмите кнопку Close (Закрыть).  
В результате в диалоговом окне Parametric models… в поле 

Orders  появятся значения 1, 2, 1, а в поле Name  – заданное авто-
матически имя модели oe121.  
Для оценки передаточной функции объекта нажмите кнопку 

Estimate (Оценить). 
В результате в основном окне интерфейса ident: Untitled в правой 

части Model Views появится значок построенной модели oe121, 
а в окне Model Output – еще одна рассчитанная кривая, соответст-
вующая модели oe121, и для нее также будет указана степень сов-
падения с экспериментальной кривой (рис. 48).  

 

 
Рис. 48. График теоретических переходных характеристик  
апериодических звеньев первого и второго порядка  
с указанием степени совпадения с экспериментальной 

 
Сравнив оба значения, можно сделать вывод, что более точное 

совпадение с экспериментальными данными обеспечивает модель 
апериодического звена 2-го порядка. 
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Получение выражения для передаточной функции звена,  
полученного в результате компьютерной идентификации  
Преобразуйте полученную модель oe121 в передаточную 
функцию. Для этого скопируйте построенную модель oe121 
из окна интерфейса идентификации в рабочее пространство пе-
ременных MATLAB: в окне интерфейса ident: Untitled в правой 
части Model Views нажмите на значке модели oe121 левой 
клавишей мыши и перетащите его на значок To Workspace 
(В рабочее пространство), расположенный в этом же окне по 
центру.  
В результате в основном окне MATLAB на вкладке Workspace 

появится соответствующая строка с указанием имени переменной 
модели (oe121), ее размера и типа – idpoly object (Объект модели).  
Данная идентификационная модель является дискретной. Это 

связано с тем, что, как было показано выше, при передаче сигнала 
датчика температуры на компьютер в измерителе СОСНА-003МД 
выполняется его аналого-цифровое преобразование, т. е. преобра-
зование из аналоговой (непрерывной) в цифровую (дискретную) 
форму. 
Поэтому сначала необходимо выполнить обратное преобразова-

ние дискретной модели в непрерывную с помощью функции 
MATLAB d2c(), (digital-to-continuous).  
В окне команд Command Window основного окна MATLAB 
в командной строке (справа от знака >>) введите команду: 
>> continuous_oe121 = d2c(oe121) 
В результате в MATLAB будет выполнено преобразование дис-

кретной модели в непрерывную и отображена информация сле-
дующего вида: 

Continuous-time IDPOLY model: y(t) = [B(s)/F(s)]u(t) + e(t) 
B(s) = 1.367e-005 s + 9.172e-006                            
F(s) = s^2 + 0.01272 s + 2.599e-005                         
Estimated using PEM from data set Шкаф суш.                 
Loss function 0.192328 and FPE 0.193385 
Далее необходимо преобразовать непрерывную модель в пере-

даточную функцию.  
В командной строке MATLAB введите команду 

>> trfunc_oe121 = tf(continuous_oe121, 'measured') 
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Функция MATLAB tf() преобразует объект модели (типа 
idpoly object) в передаточную функцию (в объект типа tf – transfer 
function). В результате будет получено выражение для передаточ-
ной функции исследуемого объекта. 
Запишите в отчет полученную передаточную функцию. 

Расчет постоянных времени передаточной функции звена, 
полученного в результате компьютерной идентификации 
Для найденной передаточной функции определите, чему равны 

значения постоянных времени T3, T4 апериодического звена 2-го 
порядка. Для этого сначала определите корни знаменателя переда-
точной функции.  
В командной строке MATLAB введите следующие команды: 

>> denominator = trfunc_oe121.den{1}      % знаменатель 
>> r = roots(denominator)     % корни знаменателя 
>> T3 = -1/r(2) 
>> T4 = -1/r(1) 
Сравните полученные значения постоянных времени со значе-
ниями T3, T4, определенными ранее по графику. 

Построение графика переходной функции сушильного шкафа, 
полученной в результате компьютерной идентификации 
В окне команд Command Window в командной строке введите 
следующие команды: 
>> y_id = sim(u, oe121); 
>> figure(1); 
>> plot(t, y_id, 'g', 'LineWidth', 2); 
В результате в окне Figure No. 1 будет построен график. 
 

4. Сделайте выводы о соответствии передаточных  
функций, полученных в результате расчетов  
и компьютерной идентификации 

 
Содержание отчета 

1. Название лабораторной работы, цель, задание. 
2. График экспериментальной переходной функции сушильного 

шкафа. 
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3. График расчетной переходной функции сушильного шкафа 
с указанием максимального расхождения между расчетной и экс-
периментальной кривыми. 

4. Формулы расчетных передаточной и переходной функций 
сушильного шкафа с указанием типа звена. 

5. График переходной функции сушильного шкафа, полученный 
в результате компьютерной идентификации, с указанием макси-
мального расхождения между расчетной и экспериментальной  
кривыми. 

6. Передаточная функция сушильного шкафа, полученная в ре-
зультате компьютерной идентификации, и значения постоянных 
времени звена. 

7. Выводы о соответствии передаточных функций, полученных 
в результате расчетов и компьютерной идентификации. 

 
Контрольные вопросы 

1. Дайте определение идентификации. 
2. Почему возникает задача идентификации? 
3. Изложите методику идентификации линейных объектов по 

переходной функции. 
4. Как понять, что идентификация произведена успешно? Что 

делать в противном случае? 
5. Запишите дифференциальное уравнение, которым описывает-

ся сушильный шкаф. 
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МОДУЛЬ 2. ЛИНЕЙНЫЕ НЕПРЕРЫВНЫЕ СИСТЕМЫ 
АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ 

 
 

Лабораторная работа № 6 
ИССЛЕДОВАНИЕ РАЗОМКНУТОГО 
И ЗАМКНУТОГО УПРАВЛЕНИЯ 

 
Цель работы: ознакомиться с принципом действия систем ав-

томатического управления (САУ) разомкнутого и замкнутого типа. 
Изучить принцип действия системы автоматического управления 
на основе температурной  зависимости. 
Задание:  
1. Собрать схему для исследования температурной зависимости. 
2. Исследовать влияние нагрева на величину сопротивления тер-

морезистора. 
2. Построить разомкнутую систему автоматического регулиро-

вания и исследовать ее работу. 
3. Построить замкнутую систему автоматического регулирова-

ния и исследовать ее работу. 

Аппаратура, используемая в лабораторной работе 

В работе используется специализированный учебный стенд 
«НТЦ-09.11 Основы автоматизации». Корпус стенда состоит из 
стола и жестко соединенной с ним настольной приставки с лицевой 
панелью, на которой изображена принципиальная электрическая 
схема и установлена коммутационная и исследуемая аппаратура. 
Питание стенда осуществляется от однофазной сети 220 В 50 Гц. 

Потребляемая мощность не более 200 Вт. 
Принципиальная электрическая схема на лицевой панели стен-

да, для удобства выполнения работ, разделена на функциональные 
блоки. На лицевой панели расположены:  

• тумблер включения питания стенда; 
• индикатор наличия сетевого напряжения; 
• выводы блоков питания +5 В, +12 В, –12 В;  
• индикаторы наличия напряжения на выходах;  
• исследуемые механизмы и элементы; 
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• двигатель постоянного тока с возбуждением от постоянного 
магнита с закрепленным на валу датчиком частоты вращения; 

• нагревательный элемент в виде проволочного резистора, с за-
крепленным на нем термосопротивлением.  
На панели установлены коммутационные гнезда, коммутацион-

ная аппаратура, а также органы управления, позволяющие изме-
нять параметры элементов при проведении лабораторной работы. 
Для сборки исследуемых схем используются перемычки, при 

помощи которых производится коммутация соответствующих 
гнезд, выведенных на лицевую панель стенда (рис. 49). 

 

 
Рис. 49. Лицевая панель лабораторного стенда 

 
Необходимые измерения производятся с помощью сигнальных 

светодиодов, мультиметра, осциллографа. 
 

Выполнение работы 

1. Исследование температурной зависимости 
Соберите схему, в которой аналоговый сигнал преобразуется 
в сигнал, который при допустимых значениях термосопротивления 
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имеет значение 1, а при превышении величины заданного сопро-
тивления значение 0 (рис. 50). 
В схему входят: терморезистор Т, резистор R2, переменный ре-

зистор R4, операционный усилитель СА1, логический элемент D1.1 
и сигнальная лампа накаливания Н2. 

 

 
Рис. 50. Общий вид исследуемой схемы 

 
Основная часть элементов, используемых при сборке этой схе-

мы, расположена с левой стороны стенда. Для сборки схемы: 
– с помощью перемычки соедините входы логического элемен-
та D1.1 (рис. 51); 

 

 
Рис. 51. Внешний вид логического элемента D1.1 

 
– с помощью перемычки соедините выход операционного уси-
лителя СA1 (рис. 52) с входом логического элемента D1.1; 

– с помощью перемычки организуйте обратную связь в опера-
ционном усилителе СА1; 
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Рис. 52. Внешний вид функционального блока СA1 

 
– с помощью длинной перемычки соедините терморезистор Т 

(расположен на стенде справа, внешний вид показан на рис. 53) 
и резистор R2; 

 

 
Рис. 53. Внешний вид коммутационных гнезд терморезистора  

и источника питания 5 В 
 

– подключите перемычкой терморезистор Т к источнику пита-
ния 5 В (см. рис. 53); 

– перемычкой соедините резисторы R2 и Т со входом операци-
онного усилителя СА1. 
Включите питание стенда и электрической схемы тумблером SA3. 

 

Вращая ручку переменного сопротивления R4 (рис. 54), убеди-
тесь в том, что при увеличении значения переменного сопротив-
ления R4 лампочка H2 загорается, а при уменьшении – гаснет. 
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Рис. 54. Переключатель переменного сопротивления R4 

 
Поясните, почему так происходит. 
Выключите стенд, отсоедините терморезистор Т от сети пита-
ния и от резистора R2. 

 

2. Исследование влияния нагрева на величину  
сопротивления терморезистора 

С помощью мультиметра измерьте и запишите значение сопро-
тивления терморезистора Т при комнатной температуре. 
С помощью перемычек подключите нагревательный элемент 

EK (выходы нагревательного элемента ЕK расположены на стен-
де справа, рядом с выходами терморезистора Т, внешний вид по-
казан на рис. 55) к питающей сети 15 В. 

 

 
Рис. 55. Внешний вид коммутационных гнезд нагревательного элемента 

 
При подключении нагревательного элемента ЕK происходит на-

грев терморезистора, т. к. терморезистор расположен в  непосред-
ственной близости от нагревательного элемента на стенде (взаим-
ное расположение показано на рис. 56). 
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Рис. 56. Внешний вид нагревательного элемента и терморезистора 
 

Подключите мультиметр для измерения сопротивления термо-
резистора (полученная схема показана на рис. 57).  

 

 
Рис. 57. Схема для исследования сопротивления терморезистора 
 

Измерьте зависимость сопротивления терморезистора от време-
ни. Для этого включите стенд и снимите показания мультиметра 
через каждые 5 с. Результаты измерений занесите в табл. 6. 

 

Таблица 6 

Данные для построения переходной характеристики терморезистора 

t, с R, Ом 

0  

5  

10  

… … 
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Выключите стенд. 
Остудите терморезистор Т до исходного значения сопротивления. 
Постройте переходную характеристику терморезистора. 
 
3. Исследование разомкнутой системы автоматического  
регулирования 

Соберите схему, изображенную на рис. 58 (можно не ис-
пользовать переменный резистор R1). Для этого, не отключая 
нагревательный элемент ЕK от сети питания, восстановите 
схему, собранную при выполнении пункта 1 данной работы. 
Установите значение переключателя R4 в центральное поло-
жение (см. рис. 54). Тем самым задается требуемое значение 
температуры. 

 

 
Рис. 58. Общий вид схемы исследуемой разомкнутой системы регулирования 

 
В собранной схеме аналоговый сигнал датчика температуры 

преобразуется в сигнал, который при допустимых значениях тем-
пературы имеет значение 1, а при превышении температуры – зна-
чение 0. 
Включите стенд, начнется нагрев терморезистора Т. При вклю-
чении стенда сигнальная лампа Н2 должна гореть. Убедитесь 
в том, что при нагревании терморезистора Т выше температуры, 
определенной положением переключателя переменного сопро-
тивления R4, лампа накаливания Н2 погаснет. 
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Выключите стенд. Остудите терморезистор Т до исходного 
значения сопротивления. 
Функциональная схема системы – это наглядное графическое 

изображение системы в виде взаимосвязанных элементов, выпол-
няющих определенную функцию. 
Элементы функциональной схемы изображаются прямоугольни-

ками, связи между ними указываются линиями со стрелками, соот-
ветствующими направлению прохождения сигнала. Вместо термина 
«сигнал» используют также термин «переменная», «входное воз-
действие» и «выходная величина». 
Наименование функционального элемента в сокращенной фор-

ме указывается внутри соответствующего прямоугольника. Над 
линиями связи указывают обозначение сигнала. Под схемой или 
в тексте сокращения и обозначения расшифровываются. 
Для того, чтобы изобразить функциональную схему изучаемой 

разомкнутой системы автоматического регулирования, следует оп-
ределить отдельные элементы устройства и их функциональное 
назначение. 
В общем случае система автоматического управления имеет 

структуру, изображенную на рис. 59. 
 

 
Рис. 59. Общая структура системы автоматического управления 

 
Физический сигнал Y о состоянии объекта управления по каналу 

обратной связи поступает на измерительное устройство (датчик, 
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в качестве которого может выступать термопара, терморезистор, 
датчик уровня, скорости и др. для разных систем), которое выдает 
информационный сигнал на устройство сравнения, где он сравни-
вается с входным значением (заданным уровнем сигнала, задатчи-
ком, уставкой) управляемого параметра. При отклонении управ-
ляемого параметра от заданной величины возникает сигнал 
рассогласования (сигнал ошибки) e, поступающий в устройство 
управления (регулятор), которое по заложенному в нем алгоритму 
обрабатывает информацию и вырабатывает сигнал управления u, 
который поступает на вход исполнительного устройства. Испол-
нительное устройство состоит из исполнительного механизма (это 
может быть электромотор с редуктором, пневмоцилиндры и др.) 
и регулирующего органа (кран, вентиль, заслонка и др.). Исполни-
тельное устройство воспринимает маломощный сигнал управления 
и вырабатывает управляющее воздействие U, открывая определен-
ным образом каналы передачи энергии (электрическая энергия, то-
пливо, сжатый воздух и т. п.) от окружения к объекту управления 
(это может быть печь, электромотор, резервуар и др.). 
В каждой конкретной системе указанные функциональные эле-

менты представлены конкретными устройствами. Некоторые функ-
циональные элементы в системе могут отсутствовать. В систему 
могут быть введены дополнительные устройства, такие как меха-
низмы передачи движения, промежуточные преобразователи, уст-
ройства местной обратной связи и т. д. 
Сигнал с задатчика:  
– может быть постоянным для поддержания постоянства регу-

лируемого параметра температуры, давления, уровня жидкости 
и т. д. (системы стабилизации);  

– может изменяться во времени по определенной программе 
(программное регулирование);  

– может изменяться во времени в соответствии с измеряемым 
внешним процессом (следящее регулирование).  
В этих случаях системы автоматического управления называют 

системами автоматического регулирования (САР). 
Системы автоматического управления (регулирования) с обрат-

ной связью называются замкнутыми системами (или системами 
управления по отклонению), а системы без обратной связи –  
разомкнутыми. 
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В разомкнутых системах при формировании управляющего воз-
действия на объект учитывается только заданное значение регули-
руемой величины. Общий вид функциональной схемы разомкнутой 
САР показан на рис. 60. 

 

 
Рис. 60. Общий вид функциональной схемы разомкнутой САР: 

ЗУ – задающее устройство; У – усилитель; ИУ – исполнительное устройство; 
g – задающее воздействие; U – управляющее воздействие; Y – выходная величина;  

F – возмущающее воздействие; ОУ – объект управления 
 

В результате рассмотрения устройства и работы системы можно 
сделать выводы о реализованном принципе управления (в боль-
шинстве САР используется принцип управления по отклонению 
(по ошибке)) и о виде системы (является ли она стабилизирующей, 
программной, следящей). 
Изобразите функциональную схему изучаемой разомкнутой 
системы автоматического регулирования. 
Перечислите все элементы системы, опишите связи между эле-
ментами, определите функцию, выполняемую каждым элемен-
том, составьте функциональную схему.  
Опишите работу системы. 
В рассматриваемом случае объектом регулирования является 

помещение, температура в котором регулируется нагревательным 
элементом и измеряется при помощи терморезистора, являющегося 
датчиком температуры. В качестве регулирующего органа высту-
пает нагревательный элемент, при включении производящий нагрев 
помещения. Поскольку автоматическое отключение нагревательно-
го элемента не предусмотрено, в данном случае имеет место ра-
зомкнутое управление. 
Все остальные элементы собранной схемы: компаратор А1, 

сравнивающий сигналы, поступающие от датчика температуры Т 
и задатчика температуры R4, регулирующий орган D1.1, передаю-
щий сигнал на индикатор, представленный лампой накаливания Н2, 
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представляют собой цепь индикации, не влияющей непосредственно 
на регулирование. 
Примерный вид функциональной схемы исследуемой системы 

разомкнутого управления показан на рис. 61. 
 

 
 

Рис. 61. Вид функциональной схемы разомкнутой системы 
 

4. Исследование замкнутой системы автоматического  
регулирования 

Разработайте систему автоматического управления работой 
двигателя на основе температурной зависимости таким образом, 
чтобы нагрев автоматически отключался при достижении верх-
ней предельной температуры. Обратную связь осуществите 
с помощью транзистора VT2 (рис. 62). 
Для этого в схему, собранную при выполнении пункта 2 дан-
ной работы, внесите следующие изменения.  

– поменяйте у нагревательного элемента ЕK и терморезистора 
Т источники питания: подключите нагревательный элемент ЕK 
к сети питания напряжением 5 В, а терморезистор Т к сети пита-
ния напряжением 5 В; 

– отключите нагревательный элемент ЕK от коммутационного 

гнезда  и с помощью перемычки соедините его с выходом 
транзистора VT2 (расположен на стенде правее сигнальной лам-
пы накаливания Н2); 

– выход функционального блока СА1 соедините перемычкой 
с входом транзистора VT2.  
Установите значение переключателя R4 в центральное поло-
жение (см. рис. 54). Тем самым задается требуемое значение 
температуры. 
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З 
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Рис. 62. Общий вид схемы исследуемой замкнутой системы регулирования 

 
Включите стенд и убедитесь в том, что при нагревании термо-
резистора Т до заданной температуры нагревательный элемент 
ЕK отключается и терморезистор Т начинает остывать, после че-
го нагревательный элемент ЕK снова включается и начинает на-
гревать терморезистор Т.  
Таким образом, происходит поддержание температуры, задан-

ное значение которой устанавливается с помощью переменного 
сопротивления R4.  
В данной работе объектом управления выступает помещение, 

температура в котором повышается при включении нагревательно-
го элемента, и понижается при его выключении. Изменение темпе-
ратуры фиксируется с помощью терморезистора (датчик), сигнал 
с которого поступает на операционный усилитель (компаратор) 
А1, в котором происходит сравнение значений напряжения, посту-
пающего от резистора R2, соединенного с терморезистором Т, и с 
резистора R4 (задатчика). Таким образом, с помощью датчика тем-
пературы организована обратная связь в рассматриваемой схеме. 
Если полученная разность положительна, что соответствует зна-

чению температуры в помещении меньше заданного, сигнал 
с выхода функционального блока СА1 поступает на вход логиче-
ского элемента D1.1 (регулирующий орган блока индикации) и на 
вход транзистора VT2 (исполнительный механизм основной цепи). 
При этом в цепи индикации загорается сигнальная лампа накали-
вания Н2, а в основной цепи продолжается нагрев помещения  
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с помощью нагревательного элемента ЕK (регулирующий орган ос-
новной цепи воздействий).  
Если же полученная разность отрицательна (значение темпера-

туры в помещении превысило заданное), сигнал на выходе функ-
ционального блока СА1 отсутствует. При этом в цепи индикации 
гаснет сигнальная лампа накаливания Н2, а в основной цепи  про-
исходит отключение нагревательного элемента ЕK от сети – пре-
кращается нагрев помещения.  
Примерный вид функциональной схемы построенной системы 

замкнутого управления показан на рис. 63. 
 

 
Рис. 63. Вид функциональной схемы замкнутой системы 

 
В системе реализован принцип управления по отклонению (по 

ошибке). Система является стабилизирующей. 
Изобразите функциональную схему изучаемой замкнутой сис-
темы автоматического регулирования на основе температурной 
зависимости. 
Сделайте выводы о работе построенных схем. 

 
Содержание отчета 

1. Название лабораторной работы, цель, задание. 
2. Данные для построения экспериментальной зависимости тер-

мосопротивления от времени (табл. 6). 

цепь индикации 

СУ ОУ 

Д 

ИМ РО 

Л РО1 

З 
U Q θ 

UR2 

UR4 

UD1.1 

ΔU 

 
θ 



 108 

3. График экспериментальной переходной функции термосопро-
тивления ( )R f t= . 

4. Функциональная схема построенной разомкнутой системы 
автоматического регулирования на основе температурной зависи-
мости. 

5. Функциональная схема построенной замкнутой системы авто-
матического регулирования на основе температурной зависимости. 

7. Выводы о работе построенных схем. 
 

Контрольные вопросы 
1. Перечислите основные принципы управления. 
2. Дайте определение функциональной схемы. 
3. Перечислите основной функциональный состав систем авто-

матического регулирования. 
4. Опишите полученные схемы. 
5. Обоснуйте необходимость температурно-зависимого включе-

ния станков, приборов и установок. Какой конкретный процесс 
может быть смоделирован в ходе выполнения опыта? 
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МОДУЛЬ 3. ЛИНЕЙНЫЕ И НЕЛИНЕЙНЫЕ СИСТЕМЫ 
АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ 

 
 

Лабораторная работа № 7 
ИССЛЕДОВАНИЕ СИСТЕМ С ПРОПОРЦИОНАЛЬНЫМ 

ЗАКОНОМ (П-ЗАКОНОМ) РЕГУЛИРОВАНИЯ 
 

Цель работы: исследовать свойства САР с П-законом регули-
рования. 
Задание:  
1. Изучить законы регулирования и показатели качества регули-

рования САР. 
2. Построить компьютерную модель замкнутой САР с П-законом 

регулирования, используя пакет компьютерного моделирования 
Simulink.  

2. Исследовать зависимость показателей качества регулирования 
САР от значения коэффициента усиления П-регулятора.  

3. Сделать выводы о свойствах САР с П-законом регулирования. 

Аппаратура, используемая в лабораторной работе 
Работа выполняется на персональных ЭВМ с использованием 

среды компьютерного моделирования MATLAB Simulink.  
 

Выполнение работы 

1. Изучение законов регулирования и показателей  
качества регулирования САР 

Показатели качества регулирования САР 
О качестве регулирования САР судят по графику ее переходной 

функции, т. е. по реакции системы на единичное ступенчатое изме-
нение задающего или возмущающего воздействия, полученному 
экспериментально либо путем компьютерного моделирования. 
Для численной характеристики точности САР используют 4 ос-

новных показателя качества (рис. 64).  
1) Установившаяся (статическая) ошибка регулирования – 

это разность между заданным значением управляемой величины  
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и ее установившимся значением после окончания процесса регули-
рования: 

СТ ЗАД УСТe y y= − .                                   (46) 

 

 
Рис. 64. Переходная функция САР по задающему воздействию: 

yЗАД – заданное значение управляемой величины; 
yУСТ – установившееся (статическое) значение управляемой величины;   

tРЕГ – время регулирования;   
yМАХ – наибольшее отклонение регулируемой величины в переходном процессе 

 
2) Перерегулирование:  

MAX УСТ

УСТ

100 %
y y

y
−

σ = .                               (47) 

Выражение в числителе формулы для определения перерегули-
рования называют динамической ошибкой регулирования – это 
максимальное в процессе регулирования отклонение регулируемо-
го параметра от конечного состояния равновесия. На графике 
рис. 64 динамическая ошибка равна разности: 

Д MAX УСТe y y= − .                                     (48) 

3) Время регулирования – это отрезок времени с момента на-
чала регулирования (момент, когда произошло внешнее задающее 
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или возмущающее воздействие) до момента, когда отличие регу-
лируемого параметра от конечного состояния равновесия yУСТ ста-
новится не более ±5 % от конечного значения yУСТ (либо от вели-
чины динамической ошибки eД в случае, если конечное значение 
УСТ 0y = ).  

4) Интегральный показатель качества J – определяется по 
следующей формуле: 

( )2

0

J e t dt
∞

= ∫ .                                      (49) 

Данный показатель качества служит обобщением сразу трех 
предыдущих показателей. Чем меньше перерегулирование, стати-
ческая ошибка и время регулирования, тем меньше значение инте-
грала J и выше качество работы САР. 

Законы регулирования САР 
Устройство управления, называемое также регулятором, вы-

полняет основные функции управления, путем выработки сигнала 
управления u в зависимости от ошибки, т. е. ( )u u e= . 

Ошибкой регулирования (рассогласованием) называется раз-
ность между заданным значением управляемой величины и ее фак-
тическим значением в момент времени t: 

( ) ( ) ( )ЗАДe t y t y t= − .                                 (50) 

В установившемся режиме, соответствующем номинальным 
значениям задающего и возмущающего воздействий (yЗАД = yЗАД 0 
и F = F0), значение управляемой величины y = yЗАД 0 и, соответст-
венно, значение ошибки равно нулю (е = 0). 
При изменении задающего или возмущающего воздействия на 

входах системы, значение управляемой величины также изменяет-
ся. В системе появляется ошибка регулирования e(t) ≠ 0 и происхо-
дит процесс регулирования, в результате которого ошибка e(t) 
уменьшается. 
Изменение ошибки регулирования e(t) связано с изменением за-

дающего и возмущающего воздействий следующим выражением: 

( ) ( ) ( ) ( ) ( )ЗАДe y e Fe s W s y s W s F s= + ,                  (51) 
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где We y (s) – передаточная функция ошибки САР по задающему 
воздействию: 

( ) ( )
( ) ( ) ( )ЗАД 0 ОС

1 ;
1e y

e s
W s

y s W s W s
= =

+
                  (52) 

We F (s) – передаточная функция ошибки САР по возмущающему 
воздействию:

 
( ) ( )

( )
( )

( ) ( )0 ОС

;
1

F
e F

e s W s
W s

F s W s W s
= =

+
                      (53) 

W0(s) – передаточная функция прямой ветви структурной схе-
мы САР;  

WОС(s) – передаточная функция цепи обратной связи;  
WF(s) – передаточная функция возмущающего воздействия на 

объект управления. 
 
Закон регулирования – это математическая зависимость между 

сигналом рассогласования (ошибкой) e(t) и управляющим воздей-
ствием на объект U(t) без учета инерционности регулятора и эле-
ментов исполнительного устройства: 

( ) ( )( )U t f e t= .                                     (54) 

Закон регулирования определяет основные качественные и ко-
личественные характеристики системы. 
Различают линейные и нелинейные законы регулирования. Кро-

ме того, эти законы могут быть реализованы в непрерывном виде 
или в цифровом. Цифровые законы регулирования реализуются 
путем построения регуляторов с помощью средств вычислительной 
техники (микроЭВМ или микропроцессорных систем). 
В инженерной практике наибольшее применение имеют типовые 

линейные законы регулирования: пропорциональный (П), интегральный 
(И), пропорционально-интегрально-дифференциальный (ПИД). 

Пропорциональный закон (П-закон) регулирования САР 
При пропорциональном законе регулирования математическая 

зависимость между сигналом ошибки e(t) и управляющим воздей-
ствием на объект U(t) имеет следующий вид: 
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( ) ( )pU t K e t= .                                    (55) 

Соответственно, передаточная функция регулятора равна 

( ) ( )
( )РЕГ p

U s
W s K

e s
= = .                               (56) 

Принцип действия заключается в том, что регулятор вырабаты-
вает управляющий сигнал, пропорциональный величине ошибки 
(чем больше ошибка e, тем больше управляющий сигнал U). 

 
2. Построение компьютерной модели САР с П-законом  
регулирования 

В лабораторной работе исследуется замкнутая система автоматиче-
ского регулирования, структурная схема которой приведена на рис. 65. 

 

 
Рис. 65. Структурная схема моделируемой САР: 

y – управляемая величина; yЗАД – заданное значение управляемой величины; 
e – ошибка управления; u – сигнал управления; 

U – управляющее воздействие на объект со стороны исполнительного  
устройства; F – возмущающее воздействие на объект 

 
Передаточные функции объекта управления имеют вид пере-

даточной функции апериодического звена 2-го порядка, как 
по управляющему, так и по возмущающему воздействиям, что 
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соответствует, например, математическому описанию сушильного 
шкафа, изображенного на рис. 37. Данная структурная схема, таким 
образом, представляет собой структурную схему линейной непре-
рывной системы автоматического регулирования температуры 
в сушильном шкафу.  
Передаточная функция датчика соответствует передаточной 

функции апериодического звена 1-го порядка, что характерно для 
датчиков температуры. Например, значения параметров передаточ-
ной функции Д 3,9K =  Ом/ºС, Д 20T ≈ с соответствуют термометру 
сопротивления Pt1000. Задатчиком в данном случае может высту-
пать переменное сопротивление, включаемое вместе с термосопро-
тивлением датчика в резистивную измерительную мостовую схему 
(см. рис. 34), на выходе которой вырабатывается сигнал (электри-
ческое напряжение) ошибки e(t). 
Исполнительным устройством (механизмом) может служить 

электронный усилитель мощности, на вход которого поступает сиг-
нал устройства управления (регулятора), а выходным сигналом яв-
ляется электрическая активная мощность, подаваемая на нагрева-
тельный элемент. Математическое описание исполнительного 
устройства соответствует описанию безынерционного звена: KИУ. 
Передаточная функция регулятора WРЕГ выбирается в соответст-

вии с рассматриваемым типовым линейным законом регулирова-
ния (в данном случае, П-законом). Получаем WРЕГ = KР. 
Для схемы САР, изображенной на рис. 65, выражения для W0(s), 

WОС(s), WF(s) равны: 

( ) ( ) ( )

( )

( ) ( )

ОУ
0 РЕГ ИУ 2

1 2 1 2

Д
ОС

Д

2
1 2 1 2

;
1

;
1

1 .
1F

KW s W s K
T T s T T s

K
W s

T s

W s
T T s T T s

=
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=
+

=
+ + +

 

Передаточная функция (52) ошибки регулирования САР по за-
дающему воздействию (т. е. связь ошибки регулирования e с изме-
нением задающего воздействия yЗАД) в этом случае (с учетом фор-
мулы (56)) имеет следующий вид: 
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( )
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Передаточная функция (53) ошибки регулирования САР по воз-
мущающему воздействию (связь ошибки регулирования e с изме-
нением возмущающего воздействия F) равна 

( ) ( )
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Выполните запуск пакета компьютерного моделирования 
Simulink (так, как это показано в лабораторной работе № 1). 
Введите в MATLAB заданные преподавателем значения пара-
метров передаточных функций элементов САР. Для этого в окне 
ввода команд Command Window в строке ввода введите сле-
дующие команды: 
>> clear all;   close all;   clc; 
>> global   T1   T2   K_obj % параметры объекта 
>> global   K_sens    T_sens  % параметры датчика  
>> global   K_mech  % параметры исполнительного  
% устройства (механизма) 
>> global   K_p     % коэффициент усиления регулятора 
>> T1=   ;    
>> T2 =    ; 
>> K_obj= 1;    
>> K_sens = 3.9;    
>> T_sens = 20;     
>> K_ mech = 1;    
>> K_p = 1; % начальное значение 
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После знаков равенства нужно ввести значения параметров Т1 
и Т2 в соответствии с вариантом. 
Далее на основе структурной схемы САР (рис. 65) создайте мо-

дель заданной САР в Simulink в окне редактирования модели.  
Приблизительный итоговый вид создаваемой графической мо-

дели исследуемой САР температуры в сушильном шкафу показан 
на рис. 66. 

 

 
Рис. 66. Графическая модель исследуемой САР с П-законом регулирования 

 
Для создания новой модели, состоящей из нескольких элемен-
тов, в меню окна Simulink Library Brouser выполните команду 
File→New→Model.  

1) Объект управления (сушильный шкаф) математически пред-
ставляет собой суммирующее звено, выполняющее функцию сложе-
ния двух сигналов: управляющего и возмущающего воздействий.  
В окне Simulink Library Brouser в библиотеке Simulink на 
вкладке Math Operations найдите компонент Sum, выделите его 
левой клавишей мыши и, не отпуская ее, перетащите данный 
компонент в окно редактирования модели untitled. Для задания 
имени компонента щелкните по нему один раз правой кнопкой 
мыши, во всплывающем меню выберите пункт Format→ 
→Show Name; на появившейся снизу надписи Sum щелкните 
левой клавишей мыши, в строке редактирования надписи заме-
ните надпись Sum на Оbject (Объект управления); выйдите из 
строки редактирования надписи щелчком левой клавиши мыши 
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на свободном пространстве окна untitled. Для задания требуемого 
расположения входов (сверху и слева) выполните двукратный 
щелчок левой клавишей мыши по самому компоненту, в поя-
вившемся диалоговом окне Block parameters в строке 
List of sings вместо последовательности |++ введите последова-
тельность ++|, после чего нажмите Apply и OK. 

2) Передаточная функция объекта управления по управляю-

щему воздействию 
( )
ОБ

ОУ 2
1 2 1 2 1

KW
T T s T T s

=
+ + +

.  

В окне Simulink Library Brouser в библиотеке Simulink на 
вкладке Continuous левой клавишей мыши выделите компонент 
Transfer Fcn и перетащите его в окно редактирования модели 
(расположив его слева от суммирующего компонента Оbject). 
Задайте имя нового компонента: левой клавишей мыши щелкни-
те на надписи Transfer Fcn под его изображением, войдите 
в строку редактирования надписи и замените ее на W_оу (переда-
точная функция объекта по управляющему воздействию). После 
этого следует задать саму передаточную функцию, для чего вы-
полните двойной щелчок левой клавишей мыши на изображении 
компонента, и в окне редактирования его параметров Block 
parameters; в строке Numerator (Числитель), определяющей  
коэффициенты в числителе передаточной функции, вместо 
имеющейся там единицы введите коэффициент преобразования 
объекта – [K_obj]; в строке Denominator (Знаменатель), опреде-
ляющей коэффициенты полинома в знаменателе передаточной 
функции, введите [ (T1*T2) (T1+T2) 1 ], после чего нажмите 
Apply и OK.  
Соедините компонент W_оу с суммирующим элементом 

Оbject, для чего подведите курсор мыши к компоненту W_оу 
справа (к указателю выхода), затем, нажав левую клавишу мы-
ши, соедините его с левым указателем входа компонента Оbject. 

3) Передаточная функция объекта управления по возму-

щающему воздействию 
( )О F 2

1 2 1 2

1
1

W
T T s T T s

=
+ + +

.  

Выберите компонент Transfer Fcn (см. предыдущий пункт), рас-
положите его в окне редактирования модели сверху от компонента 
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W_оу. Задайте имя компонента: W_of. Задайте передаточную 
функцию: в строке Numerator оставьте предлагаемое по умол-
чанию значение коэффициента преобразования – [1]; в строке 
Denominator введите [(T1*T2) (T1+T2) 1], после чего нажмите 
Apply и OK. Соедините компонент W_of с суммирующим эле-
ментом Оbject (с верхним входом). 

4) Исполнительное устройство (механизм). Как видно из 
структурной схемы на рис. 65, исполнительное устройство является 
безынерционным звеном – его передаточная функция равна кон-
станте: ( )ИУ ИУW s K= .  
Выберите компонент Gain (Линейное усиление), находящийся 
в библиотеке Simulink на вкладке Math Operations. Перетащите 
его в окно редактирования модели, расположив слева от W_оу. 
Задайте имя компонента: Mechanism. Щелкнув два раза левой 
кнопкой мыши на самом компоненте, откройте окно редактиро-
вания его параметров Block parameters и в строке Gain введите 
коэффициент усиления – K_mech. Соедините компонент 
Mechanism с входом компонента W_оу. На появившейся соеди-
няющей линии-стрелке щелкните правой кнопкой мыши, во 
всплывающем меню выберите пункт Signal properties, и в поя-
вившемся диалоговом окне в строке Signal name введите обо-
значение сигнала на выходе исполнительного устройства – 
U (управляющее воздействие на объект), после чего нажмите 
Apply и OK.  
Обозначение U можно расположить сверху над стрелкой путем 

перетаскивания левой клавишей мыши. 
5) Регулятор (устройство управления). Аналогично предыду-
щему выберите компонент Gain на вкладке Math Operations 
и расположите его в окне редактирования модели слева от испол-
нительного устройства. Задайте имя компонента: P-controller. 
Введите значение коэффициента усиления – K_p. Соедините ком-
понент P-controller с входом исполнительного устройства. Вве-
дите обозначение сигнала на выходе регулятора – u (сигнал 
управления). 

6) Истройство сравнения, находящее разность сигналов за-
датчика и датчика и, таким образом, вырабатывающее сигнал 
ошибки e.  
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В библиотеке Simulink на вкладке Math Operations выберите 
компонент Sum, расположите его в окне редактирования модели 
слева от элемента P-controller. Щелкнув два раза на элементе 
левой кнопкой мыши, откройте диалоговое окно задания его па-
раметров Block parameters. 
В строке List of sings вместо последовательности |++ введите 
последовательность |+–, после чего нажмите Apply и OK. При 
этом сигнал, подаваемый на нижний вход данного элемента, 
будет вычитаться из сигнала, подаваемого на вход слева. Выход 
сумматора соедините со входом элемента P-controller. Сигнал 
на выходе сумматора обозначьте e (error – сигнал ошибки ре-
гулирования). 

7) Задатчик. Компонент Gain, расположенный на вкладке 
Math Operations, перетащите в окно редактирования модели, 
поместив слева от сравнивающего устройства. Задайте имя ком-
понента: Set_value. Введите значение коэффициента преобразо-
вания K_sens. Соедините Set_value с левым входом (плюсом) 
сравнивающего устройства. Введите обозначение сигнала Rз на 
выходе задатчика Set_value. 

8) Датчик. Для представления датчика используется компо-
нент Transfer Fcn на вкладке Continuous. Расположите его 
в окне редактирования модели приблизительно под элементом 
исполнительного устройства.  
Зеркально отразите его слева направо: для этого щелкните на 
самом компоненте правой кнопкой мыши и во всплывающем 
меню выполните команду Format→Flip block. Задайте имя ком-
понента: Sensor. Задайте передаточную функцию: в строке 
Numerator введите коэффициент [K_sens]; в строке Denominator 
введите [T_sens 1], подтвердите ввод данных нажатием кнопок 
Apply и OK. Соедините выход датчика с нижним входом (мину-
сом) сумматора, при этом линию связи обозначьте как Rд.  
Ко входу датчика проведите линию связи от выхода объекта 
управления Object. 
Сохраните построенную графическую модель САР в виде файла 
с названием р_regulator.mdl, выполнив в окне редактирования 
модели команду меню File→Save As (можно также с помощью 
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мыши нажать соответствующую кнопку  на панели инстру-
ментов). 

3. Исследование показателей качества регулирования САР  
с П-законом регулирования 

Для проведения исследования зависимости показателей качест-
ва регулирования САР от значения коэффициента усиления  
П-регулятора следует получить переходные функции САР при раз-
личных значениях KР путем компьютерного моделирования.  

Переходная функция САР – это график изменения управляемой 
величины системы при ступенчатом изменении задающего либо 
возмущающего воздействий. Соответственно, рассматривают 
обычно две переходные функции САР: переходную функцию сис-
темы по задающему воздействию и переходную функцию системы 
по возмущающему воздействию. 
Для моделирования подачи на вход системы (на задатчик 

Set_value) ступенчатого задающего воздействия используется  
находящийся в библиотеке Simulink на вкладке Sources компо-
нент Step.  
Разместите компонент Step в окне редактирования модели 
слева от задатчика Set_value. Соедините выход компонента 
Step со входом задатчика. Set_value (см. рис. 66). 
Для отображения в виде графика изменений сигналов задающе-

го воздействия и управляемой величины используется находящий-
ся на вкладке Sinks компонент Scope.  
Расположите компонент Scope в окне редактирования модели. 
Первоначально компонент Scope имеет один вход, т. е. пред-
назначен для отображения графика только одного сигнала. 
Для отображения двух сигналов необходимо задать число его 
входов равным 2. Для этого левой кнопкой мыши выполните 
двойной щелчок на компоненте Scope, в результате откроется 
окно Scope, содержащее поле для отображения графика. 
В верхней части этого окна на панели инструментов выполните 

левой кнопкой мыши щелчок на кнопке Parameters   
(второй слева), в появившемся всплывающем окне задания  
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параметров в поле Number of axes введите число 2, ввод дан-
ных подтвердите нажатием Apply и OK. После этого в окне ре-
дактирования модели (компонент Scope уже имеет 2 входа) 
верхний вход Scope соедините с выходом элемента Step (за-
дающее воздействие), а нижний вход – с выходом сумматора 
Object (Объект управления). 
Задайте параметры моделирования. Для этого в меню окна  
редактирования модели выполните команду Simulation→ 
Simulation parameters. В появившемся диалоговом окне зада-
ния параметров на вкладке Solver значение Start time оставьте 
равным 0.0, значение Stop time замените на 2000.0; на вкладке 
Workspace I/O уберите галочку в поле Limit data points to last; 
ввод данных подтвердите нажатием Apply и OK. 
Запустите процесс моделирования, выполнив в меню окна ре-
дактирования модели команду Simulation→Start.  
По окончании процесса моделирования в строке состояния окна 

редактирования модели появится слово Ready (обозначающее го-
товность к новым вычислениям), а в окне Scope – отобразятся гра-
фики изменения задающего воздействия (на верхнем поле) и управ-
ляемой величины (на нижнем поле). Для более детального 
рассмотрения графиков можно увеличить окно Scope до размеров 
всего экрана, а также нажать левой кнопкой мыши на панели ин-

струментов кнопку Autoscale  (Автоматическое масштаби-
рование). 
Для анализа динамических характеристик линейных САУ 

в Simulink имеется специальный компонент – LTI Viewer. С его 
помощью можно быстро и легко рассчитывать временные (пере-
ходная функция, импульсная переходная функция, перерегулиро-
вание, время регулирования, статическую ошибку регулирования) 
и частотные (АЧХ, ФЧХ, годограф Найквиста) характеристики мо-
делируемой САУ. 
Получите с помощью компонента LTI Viewer переходную 
функцию исследуемой САУ по задающему воздействию: сначала 
в окне редактирования модели отключите компонент Step от 
входа системы (удалите линию, соединяющую выход Step 
и вход задатчика Set_value). Далее в этом же окне выполните 
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команду меню Tools→Linear analysis. В результате этого на эк-
ране появятся два новых окна: LTI Viewer – окно, в котором 
будет отображаться график переходной функции, и Model 
Inputs and Outputs – окно, содержащее входную (Input point) 
и выходную (Output point) метки для указания входной и вы-
ходной точек системы. Обе эти метки с помощью мыши пере-
тащите на свободное пространство в окно редактирования мо-
дели (см. рис. 66). После этого выход Input point соедините 
с входом задатчика, а вход Output point – с выходом объекта 
управления Object. Сохраните изменения (в том же файле).  
Далее перейдите в окно LTI Viewer, на самом окне щелкните 
правой кнопкой мыши и во всплывающем меню выберите 
пункт Plot types→Step. Для получения графика переходной 
функции САУ выполните в этом же окне команду меню 
Simulink→Get Linearizes Model.  
В результате в окне LTI Viewer появится график переходной 

функции. 
По полученному графику найдите показатели качества регули-
рования САР. 
Для определения перерегулирования σ на свободном про-

странстве окна LTI Viewer с полученным графиком следует нажать 
правую клавишу мыши и во всплывающем меню выбрать пункт 
Characteristics→Peak Response (максимальная амплитуда). 
В результате на графике будет отмечена точка, соответствующая 
максимуму переходной функции. При наведении указателя мыши 
на данную точку появится всплывающая подсказка со следующей 
информацией: значение максимума (Peak amplitude), перерегу-
лирование, выраженное в процентах (Overshoot(%)), значение 
соответствующего момента времени от начала моделирования 
(At time (sec)); 
Для определения времени регулирования tРЕГ после щелчка 

правой клавишей мыши на свободной области графика во всплы-
вающем меню нужно выбрать пункт Characteristics→ Settling 
Time (Время регулирования); 
Для определения установившегося значения выходной ве-

личины: после щелчка правой клавишей мыши на свободной об-
ласти графика во всплывающем меню следует выбрать пункт 
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Characteristics→Steady State (Установившееся значение). Затем 
необходимо определить значение статической ошибки eСТ по фор-
муле (46). 
На рис. 67 показан приблизительный вид полученного графика 

переходной функции в окне LTI Viewer с нанесенными точками 
для определения показателей качества регулирования. Для рас-
сматриваемого примера получаем следующие значения: величина 
перерегулирования σ = 25.8 %, время регулирования tРЕГ = 560 с, 
статическая ошибка eСТ = 1 – 0.796 = 0.204. 

 
Рис. 67. График переходной функции в окне LTI Viewer  

 
Для каждого значения коэффициента усиления П-регулятора Kp: 

0.5, 1, 1.5, 2, 2.5, … (исследования проводятся до тех пор, пока 
система не потеряет устойчивость) получите в окне LTI Viewer 
переходную функцию САР и определите соответствующие зна-
чения σ, tРЕГ и eСТ. Результаты отразите в табл. 7. 
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Таблица 7 

Исследование показателей качества регулирования САР  
с П-законом регулирования 

Величина Значение 

Kp 0.5 1 1.5 … 
σ, %    … 
tРЕГ, с     

eст.     

4. Исследование свойств САР с П-законом регулирования 

По данным табл. 7 постройте графики ( )pKσ = σ , ( )РЕГ РЕГ pt t K= , 

( )СТ СТ pe e K=  и определите зависимости показателей качества 
регулирования САР – перерегулирования σ, времени регулиро-
вания tрег и статической ошибки регулирования eСТ – от значения 
коэффициента усиления П-регулятора. 
Сделайте выводы о том, как изменяются значения показателей 
качества регулирования при изменении коэффициента усиления 
П-регулятора Kp. 

Содержание отчета 
1. Название лабораторной работы, цель, задание. 
2. Компьютерная модель исследуемой САР, созданная в Simulink. 
3. Результаты компьютерного моделирования (табл. 7). 
4. Графики зависимостей перерегулирования σ, времени регули-

рования tРЕГ и статической ошибки регулирования eСТ от значения 
коэффициента усиления П-регулятора: ( )pKσ = σ , ( )РЕГ РЕГ pt t K= , 

( )СТ СТ pe e K= . 
5. Выводы о свойствах САР с П-законом регулирования. 

Контрольные вопросы 
1. Дайте определение закона регулирования САР. 
2. Дайте определение пропорционального закона регулирования. 
3. Что можно сказать о наличии статической ошибки регулиро-

вания при использовании П-регулятора? 
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4. Как изменяется значение статической ошибки регулирова-
ния САР при изменении значения коэффициента усиления  
П-регулятора Kp? 

5. Как изменяется значение перерегулирования σ при изменении 
значения коэффициента усиления П-регулятора Kp? 

6. Как изменяется время регулирования САР tРЕГ при изменении 
значения коэффициента усиления П-регулятора Kp? 

 
Исходные данные по вариантам 

Вариант Т1, с Т2, с 

1 80 250 
2 100 250 
3 100 200 
4 100 300 
5 150 250 
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Лабораторная работа № 8  
ИССЛЕДОВАНИЕ СИСТЕМ С ИНТЕГРАЛЬНЫМ 
ЗАКОНОМ (И-ЗАКОНОМ) РЕГУЛИРОВАНИЯ 

Цель работы: исследовать свойства САР с И-законом регули-
рования. 
Задание: 
1. Построить компьютерную модель замкнутой САР с И-законом 

регулирования, используя пакет компьютерного моделирования 
Simulink.  

2. Исследовать зависимость показателей качества регулирования 
САР и интегрального критерия качества от значения коэффициента 
интегрирования И-регулятора.  

3. Сделать выводы о свойствах САР с И-законом регулирования. 

Аппаратура, используемая в лабораторной работе 
Работа выполняется на персональных ЭВМ с использованием 

среды компьютерного моделирования MATLAB Simulink.  
 

Выполнение работы 

1. Интегральный закон (И-закон) регулирования 
При интегральном законе регулирования сигнал ошибки e(t) 

и управляющее воздействие на объект U(t) связаны следующим 
соотношением: 

( ) ( )
0

t

IU t K e d= τ τ∫ ,                                 (57) 

где KI – некоторый постоянный коэффициент интегрирования. 
 
Соответственно, передаточная функция регулятора равна: 

( ) ( )
( )РЕГ

1
I

U s
W s K

e s s
= = .                                (58) 

Для реализации И-закона регулирования в схему САР в состав 
устройства управления либо исполнительного устройства должен 
быть введен интегрирующий элемент. Таким элементом может 
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R 

uВЫХ 

R2 

R1 
u*
ВХ 

u*
ВЫХ 

R3 

u*
ВХ 

С 

быть, например, интегрирующий усилитель, электрическая схема 
которого приведена на рис. 68, а. Сигнал на выходе такого усили-
теля пропорционален интегралу от входного сигнала: 

( ) ( )ВЫХ ВХ
0

1 t

u t u d
R C

= − τ τ∫ .                         (59) 

 
 
 

 
 

 
 

а                                                                  б 

Рис. 68. Электрические схемы интегрирующего (а)  
и инвертирующего (б) усилителя  

 
Для компенсации знака «–» в формуле (59), т. е. для того, чтобы 

входное и выходное напряжения усилителя совпадали по знаку, 
к выходу интегрирующего усилителя можно последовательно под-
ключить инвертирующий усилитель, который изменяет знак вход-
ного сигнала на противоположный: 

( ) ( )* *2
ВЫХ ВХ

1

Ru t u t
R

= − .                                 (60) 

Получаем  

( ) ( )*
ВЫХ ВХ

0

t

Iu t K u d= τ τ∫ ,                             (61) 

где 2

1
I

RK
R R C

= , с–1. 

Переходный процесс в CAP с И-регулятором характеризуется 
отсутствием статической ошибки регулирования, наибольшим зна-
чением отклонения регулируемой величины от установившегося 
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значения по сравнению с другими законами регулирования, наи-
большим временем регулирования. 
Главным достоинством интегрального регулятора является от-

сутствие статической ошибки регулирования. 
 
2. Построение компьютерной модели замкнутой САР  
с И-законом регулирования 

В лабораторной работе исследуется замкнутая система автома-
тического регулирования, структурная схема которой приведена 
на рис. 65 (см. лабораторную работу № 7). При этом передаточная 
функция регулятора WРЕГ выбирается в соответствии с рассматри-
ваемым типовым линейным законом регулирования (в данном слу-
чае, И-законом). Получаем WРЕГ = KI ·1/s.  
Для рассматриваемой САР передаточная функция ошибки регу-

лирования по задающему воздействию формула (52) при И-законе 
регулирования (с учетом формулы (58)) имеет вид 

( )

( )
( )( )( )

( )( )( )

ДОУ
ИУ 2

1 2 1 2 Д

2
1 2 1 2 Д

2
1 2 1 2 Д ИУ ОУ Д

1

1
1 1

1 1
.

1 1

e y
I

I

W s KKK K
s T T s T T s T s

s T T s T T s T s

s T T s T T s T s K K K K

= =
⋅ +

+ + + +

+ + + +
=

+ + + + +

 

Передаточная функция (53) ошибки регулирования САР по воз-
мущающему воздействию (с учетом формулы (58)) равна 

( ) ( )

( )
( )

( )( )( )

2
1 2 1 2

ДОУ
ИУ 2

1 2 1 2 Д

Д

2
1 2 1 2 Д ИУ ОУ Д

1
1

1
1 1

1
.

1 1

e F
I

I

T T s T T s
W s KKK K

s T T s T T s T s

s T s

s T T s T T s T s K K K K

+ + +
= =

⋅ +
+ + + +

+
=

+ + + + +

 

Тогда в статическом режиме после окончания процесса регули-
рования (т. е. при t → ∞  и, соответственно, 0s → ) выражения для 
Wе y(s) и Wе F(s) становятся равными нулю: 



 129 

( )
( )

0

0

0;

0.
e y s

e F s

W s

W s
→

→

=

=
 

Следовательно, ошибка регулирования в статическом режиме 
также будет равна нулю. 
Выполните запуск пакета компьютерного моделирования 

Simulink так, как это указано при описании выполнения лабора-
торной работы № 1. В окне ввода команд Command Window 
в строке ввода введите следующие команды: 
>> clear all;   close all;   clc; 
>> global  T1   T2   K_obj % параметры объекта 
>> global  K_sens    T_sens  % параметры датчика  
>> global  K_ mech  % параметры исполнительного  
% устройства (механизма) 
>> global  K_I    % коэффициент интегрирования регулятора 
>> T1=   ;    
>> T2 =    ; 
>> K_obj=  1;    
>> K_sens =  3.9;    
>> T_sens =  20;     
>> K_ mech = 1;    
>> K_I = 0.001; % начальное значение 
После знаков равенства введите заданные значения параметров 
Т1 и Т2 (по вариантам). 
Далее на основе структурной схемы САР на рис. 65 создайте 

в Simulink модель САР с И-законом регулирования. В качестве на-
чальной основы можно взять изображенную на рис. 66 модель 
САР, созданную при выполнении предыдущей лабораторной рабо-
ты № 7.  
Откройте файл модели, созданный при выполнении лаборатор-
ной работы № 7, выполнив в меню окна Simulink Library Brouser 
команду File→Open. 
В данную модель внесите следующие изменения. 
1) Удалите связь между выходом устройства сравнения и вхо-
дом компонента P-controller. 

2) Двойным щелчком левой кнопкой мыши на компоненте  
P-controller откройте окно задания его параметров. 
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В строке Gain вместо K_p введите коэффициент интегрирования 
K_I. Результат ввода подтвердите нажатием клавиш Apply и OK. 

3) Название компонента P-controller измените на Koefficient. 
4) Добавьте в модель компонент Integrator, находящийся в биб-
лиотеке Simulink на вкладке Continuous. Значок интегратора 
поместите между значками устройства сравнения и коэффициен-
та интегрирования. Выход устройства сравнения соедините со 
входом интегратора, а выход интегратора – со входом значка ко-
эффициента интегрирования. 
Приблизительный вид создаваемой модели показан на рис. 69. 

 

 
Рис. 69. Графическая модель исследуемой САР с И-законом регулирования 

 
5) Для определения интегрального критерия качества J исполь-

зуется компонент Continuous RMS (CRMS). Данный компонент 
вычисляет среднее квадратическое значение непрерывного сигнала 
f(t), поступающего на его вход: 

( )( ) ( )2

  

1 t

t T

RMS f t f d
T −

= τ τ∫ , 

где T – интервал времени, в течение которого выполняются регист-
рация сигнала f(t), т. е., в нашем случае, интервал времени модели-
рования работы САР. 
 

Добавьте в модель компонент Continuous RMS (CRMS), на-
ходящийся в библиотеке NCD Blockset на вкладке RMS Blocks. 



 131 

Вход компонента Continuous RMS подключите к выходу уст-
ройства сравнения.  
Таким образом, на вход компонента Continuous RMS будет по-

даваться сигнал ошибки регулирования e(t). В итоге значение инте-
грального критерия качества регулирования автоматически рассчи-
тывается по формуле: 

( )2

0

1 T

J e d
T

= τ τ∫ .                                  (62) 

Если время моделирования будет выбрано достаточно большим 
для того, чтобы переходный процесс закончился, то определяемый 
по формуле (62) интегральный показатель качества регулирования 
J по своему физическому смыслу будет соответствовать показате-
лю J, определяемому по формуле (49). 
Задайте интервал времени моделирования T: в окне редактиро-

вания модели выберите пункт меню Simulation→Simulation 
parameters… и в появившемся окне задания параметров модели-
рования в ячейке Stop time укажите 12000 (момент времени нача-
ла моделирования в ячейке Start time оставьте равным нулю). 
Для отображения рассчитанного числового значения показате-
ля J используется компонент Display, находящийся в библиотеке 
Simulink на вкладке Sinks. Переместите данный компонент 
в окно редактирования модели, вход компонента Display соеди-
ните с выходом компонента Continuous RMS.  
Теперь при моделировании работы САР в поле компонента 

Display будет отображаться числовое значение интегрального по-
казателя J. 

6) Сохраните измененную модель в новом файле с названием 
i_regulator.mdl. 

7) В окне редактирования модели отключите компонент Step 
от входа системы (удалите линию, соединяющую выход Step 
и вход задатчика Set_value).  
Как было показано при выполнении пункта 3 лабораторной рабо-
ты № 7, в этом же окне выполните команду меню Tools→Linear 
analysis. Из окна Model Inputs and Outputs обе метки (Input 
point и Output point) с помощью мыши перетащите на свободное 
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пространство в окно редактирования модели и соедините выход 
Input point с входом задатчика Set_value. 
Вход Output point соедините с выходом объекта управления 

Object. В окне LTI Viewer выполните команду меню Simulink→ 
→Get Linearizes Model и нанесите на график полученной 
переходной функции точки для определения перерегулирова-
ния и времени регулирования (см. пункт 3 лабораторной рабо-
ты № 7).  
Отключите элемент Input point от входа системы. 
Сохраните изменения (в том же файле). 

3. Исследование показателей качества регулирования  
для САР с И-законом регулирования 

Для каждого значения коэффициента усиления И-регулятора KI: 
0.0001, 0.0002, …, 0.0009, 0.001, 0.002, 0.003, … (исследования 
проводятся до тех пор, пока система не потеряет устойчивость) 
выполните следующие действия: 

– в окне редактирования модели подключите элемент Input 
point ко входу системы. Получите переходную функцию САР 
с помощью компонента LTI Viewer (в окне LTI Viewer выполни-
те команду меню Simulink→Get Linearizes Model). Определите 
соответствующие значения σ и tРЕГ и внесите их в табл. 8.  
Отключите элемент Input point от входа системы; 

– в окне редактирования модели подключите элемент Step ко 
входу системы. Выполните моделирование (в окне редактирова-
ния модели выполните команду меню Simulation→Start). В поле 
компонента Display будет отображено числовое значение инте-
грального показателя J, внесите его в табл. 8. Отключите элемент 
Step от входа системы.  

 
Таблица 8 

Показатели качества регулирования САР с И-законом регулирования 

Величина Значение 
KI 0.0001 0.0002 0.0003 … 0.0009 0.001 0.002 … 
J         

σ, %         
tРЕГ, с         
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4. Исследование свойств САР с И-законом регулирования  

По данным табл. 8 постройте графики ( )IJ J K= , ( )IKσ = σ ,  

( )РЕГ РЕГ It t K=  и определите зависимости интегрального крите-
рия качества регулирования J, перерегулирования σ и времени 
регулирования tРЕГ – от значения коэффициента интегрирования 
И-регулятора KI.  
Сделайте выводы о том, как изменяются значения показателей 
качества регулирования при изменении коэффициента интегри-
рования KI.  
Сравните полученные минимальные значения перерегулирова-
ния σ и времени регулирования tРЕГ для САР с И-законом регу-
лирования с соответствующими минимальными значениями σ 
и tРЕГ для САР с П-законом регулирования, исследованной в пре-
дыдущей лабораторной работе. 

Содержание отчета 

1. Название лабораторной работы, цель, задание. 
2. Компьютерная модель исследуемой САР, созданная в Simulink. 
3. Результаты компьютерного моделирования (табл. 8). 
4. Графики зависимостей перерегулирования σ, времени регули-

рования tРЕГ и интегрального критерия качества J от значения ко-
эффициента интегрирования И-регулятора: ( )IKσ=σ , ( )РЕГ РЕГ It t K= , 

( )IJ J K= . 
5. Сравнение полученных минимальных значений перерегули-

рования σ и времени регулирования tРЕГ для САР с И-законом регу-
лирования с соответствующими минимальными значениями σ и tРЕГ 
для САР с П-законом регулирования. 

6. Выводы о свойствах САР с И-законом регулирования. 

Контрольные вопросы 
1. Дайте определение интегрального закона регулирования САР. 
2. Приведите формулу интегрального квадратичного критерия 

качества регулирования J. 
3. Чему равна статическая ошибка регулирования при использо-

вании И-регулятора? 
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4. Как изменяется значение интегрального критерия качества J 
при изменении значения коэффициента усиления И-регулятора KI? 

5. Как изменяется значение перерегулирования σ при изменении 
значения коэффициента усиления И-регулятора KI? 

6. Как изменяется время регулирования tРЕГ САР при изменении 
значения коэффициента усиления И-регулятора KI? 

7. Как изменяются значения перерегулирования σ и времени ре-
гулирования tРЕГ при использовании И-регулятора по сравнению 
с соответствующими показателями для П-регулятора? 

 
Исходные данные по вариантам 

Вариант Т1, с Т2, с 

1 80 250 
2 100 250 
3 100 200 
4 100 300 
5 150 250 
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Лабораторная работа № 9 
СИНТЕЗ СИСТЕМ АВТОМАТИЧЕСКОГО 

РЕГУЛИРОВАНИЯ 
 

Цель работы: ознакомиться с методами синтеза САР. 
Задание:  
1. Построить компьютерную модель замкнутой САР с ПИД-

регулятором в качестве устройства управления, используя пакет 
компьютерного моделирования Simulink.  

2. Выполнить настройку ПИД-регулятора методом Зиглера–
Никольса.  

3. Выполнить настройку ПИД-регулятора с помощью реализо-
ванного в Simulink интерфейса компьютерной оптимизации и на-
стройки САР NCD Outport. 

Аппаратура, используемая в лабораторной работе 

Работа выполняется на персональных ЭВМ с использованием 
среды компьютерного моделирования MATLAB Simulink.  

Выполнение работы 

1. Построение компьютерной модели САР  
с ПИД-законом регулирования 

Пропорционально-интегрально-дифференциальный закон 
(ПИД-закон) 
Для обеспечения устойчивости и качества регулирования САР 

(нулевая статическая ошибка, высокое быстродействие) использу-
ют пропорционально-интегрально-дифференциальный закон регу-
лирования (ПИД-закон). 
При формировании управляющего сигнала в соответствии 

с ПИД-законом учитываются: 
§ значение сигнала ошибки; 
§ интеграл от сигнала ошибки; 
§ скорость изменения (производная) сигнала ошибки: 

( ) ( ) ( )
0

t

p I d
deU t K e t K e d K
dt

= + τ τ +∫ .                   (63) 
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Пропорциональная составляющая вырабатывает выходной 
сигнал, противодействующий отклонению регулируемой величины 
от заданного значения, наблюдаемому в данный момент времени. 
Он тем больше, чем больше это отклонение. Если входной сигнал 
равен заданному значению, то выходной равен нулю. Однако при 
использовании только пропорционального регулятора регулируе-
мая величина никогда не стабилизируется на заданном значении: 
существует статическая ошибка.  

Интегральная составляющая пропорциональна интегралу от 
сигнала рассогласования. Ее используют для устранения статиче-
ской ошибки. Она позволяет регулятору со временем учесть ста-
тическую ошибку. Если система не испытывает внешних возму-
щений, то через некоторое время регулируемая величина 
стабилизируется на заданном значении, сигнал пропорциональной 
составляющей будет равен нулю, а выходной сигнал будет полно-
стью обеспечивать интегральная составляющая. 

Дифференциальная составляющая пропорциональна темпу 
изменения сигнала рассогласования и предназначена для проти-
водействия отклонениям от целевого значения, которые прогно-
зируются в будущем. Отклонения могут быть вызваны внешними 
возмущениями или запаздыванием воздействия регулятора на 
систему. 
Устройство управления, функционирующее на основе ПИД-

закона, называется ПИД-регулятором. ПИД-регулятор был изо-
бретен в 1910 г. После появления микропроцессоров в 1980-х гг. 
развитие ПИД-регуляторов происходит нарастающими темпами. 
ПИД-регулятор относится к наиболее распространенному типу ре-
гуляторов. Около 90–95 % регуляторов, находящихся в настоящее 
время в эксплуатации, используют ПИД-закон регулирования. 
Построение компьютерной модели САР с ПИД-законом  

регулирования. В лабораторной работе исследуется замкнутая 
система автоматического регулирования, структурная схема кото-
рой приведена на рис. 65 (см. лабораторную работу № 7). При 
этом передаточная функция регулятора WРЕГ выбирается в соот-
ветствии с рассматриваемым типовым линейным законом регули-
рования (в данном случае, ПИД-законом).  
Выполните запуск пакета компьютерного моделирования 

Simulink так, как это указано при описании выполнения лабора-
торной работы № 1. 
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В окне ввода команд Command Window в строке ввода введи-
те следующие команды: 
>> clear all;   close all;   clc; 
>> global   T1   T2   K_obj % параметры объекта 
>> global   K_sens   T_sens  % параметры датчика  
>> global   K_mech  % параметры исполнительного  
% устройства (механизма) 
>> global   K_p  K_I  K_d     % коэффициенты ПИД-регулятора 
>> T1=   ;    
>> T2 =    ; 
>> K_obj= 1;    
>> K_sens = 3.9;    
>> T_sens = 20;     
>> K_mech =  1; 
>> K_p = 0; 
>> K_I = 0; 
>> K_d = 0;  
После знаков равенства нужно ввести значения параметров Т1 
и Т2 в соответствии с вариантом. 
Далее на основе структурной схемы САР на рис. 65 нужно соз-

дать в Simulink модель САР с ПИД-регулятором в качестве устрой-
ства управления. За начальную основу можно взять изображенную 
на рис. 66 модель САР, созданную при выполнении лабораторной 
работы № 7. В данной модели необходимо П-регулятор заменить 
на ПИД-регулятор.  
Откройте файл модели, созданный при выполнении лаборатор-
ной работы № 7, выполнив в меню окна Simulink Library 
Brouser команду File→Open. 
В данную модель внесите следующие изменения: 
1. Удалите компоненты P_controller, Input point, Output point. 
Удалите линию, соединяющую компонент Step и вход осцилло-
графа Scope. Двойным щелчком на значке осциллографа Scope 
откройте окно этого элемента, и в меню Parameters (кнопка 

) на вкладке General укажите Number of axes 1. Соедините 
вход осциллографа с выходом объекта управления Object. 

2. В библиотеке блоков Simulink Extras на вкладке Additional 
Linear выберите компонент PID Controller (ПИД-регулятор) 
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и перетащите его в окно редактирования модели, расположите на 
месте удаленного значка между устройством сравнения и испол-
нительным устройством. Выход устройства сравнения соедините 
со входом ПИД-регулятора, а выход ПИД-регулятора – со вхо-
дом исполнительного устройства. 

3. Сохраните созданную модель в новый файл с именем 
pid_regulator.mdl. 
Примерный вид созданной графической модели показан на рис. 70. 

 

 
Рис. 70. Графическая модель САР с ПИД-регулятором 

2. Настройка ПИД-регулятора методом Зиглера-Никольса 
Синтез САР на основе ПИД-регулятора 

В теории автоматического управления можно выделить две ха-
рактерные задачи: 

1) в заданной САУ найти и оценить переходные процессы – это 
задача анализа САУ; 

2) по заданным переходным процессам и основным показателям 
разработать САУ – это задача синтеза САУ. 
Задача синтеза САУ является гораздо более сложной по сравне-

нию с задачей анализа, так как для задачи синтеза возможно мно-
жество вариантов решений. Поэтому обычно задача синтеза САУ 
ставится ограниченно. Считается, что основная часть системы уже 
задана и требуется синтезировать устройство управления, то есть 
выбрать закон регулирования и настроить его параметры. При этом 
необходимо, чтобы обеспечивался требуемый запас устойчивости, 
точность управления в установившихся режимах и качество управ-
ления в динамических режимах. 
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Задача синтеза САР на основе ПИД-регулятора состоит в опре-
делении значений коэффициентов Kp, KI и Kd, при которых обеспе-
чивается требуемое качество регулирования САР. С появлением 
ЭВМ и развитием методов и систем компьютерного моделирования 
решение данной задачи значительно облегчилось.  
В 1942 г. был разработан метод настройки ПИД-регулятора – 

метод Зиглера-Никольса, названный по именам разработавших 
его ученых. Данный метод широко используется и в настоящее 
время.  
Суть метода Зиглера–Никольса состоит в следующем: 
1) Всем трем коэффициентам присваивается нулевое значение: 

0pK = , 0IK = , 0dK = . 
2) Значение коэффициента Kp постепенно увеличивается с неко-

торым шагом (при этом необходимо следить за тем, как изменяется 
реакция системы, т. е. вид переходной функции) до тех пор, пока 
в системе не начнут наблюдаться незатухающие колебания, т. е. 
пока система не потеряет устойчивость. 

3) Запоминается текущее значение Kp (обозначим его Ku) и из-
меряется период колебаний системы Tu. 

4) Полученные значения Ku и Tu используются для расчета всех 
параметров ПИД-регулятора по следующим формулам (для непре-
рывного ПИД-регулятора): 
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5) Для дискретных ПИД-регуляторов необходимо еще учесть 
период дискретизации Δt: 
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Основным достоинством метода Зиглера–Никольса является 
простота выполнения настройки, особенно, учитывая возможность 
компьютерного моделирования работы САР. Данный метод годит-
ся для «грубой» настройки и быстрого введения оборудования 
в эксплуатацию. 
Настройте ПИД-регулятор методом Зиглера-Никольса. 
Начальные значения коэффициентов ПИД-регулятора должны 

быть равны нулю.  
В окне редактирования модели выполните двойной щелчок ле-
вой клавишей мыши на значке PID Controller.  
В результате откроется окно задания параметров ПИД-

регулятора. В нем по умолчанию коэффициентам присвоены сле-
дующие значения: Kp = 1 (поле Proportional), KI = 1 (поле Integral), 
Kd = 0 (поле Derivative).  
В полях Proportional и Integral введите нулевые значения, по-
сле чего подтвердите ввод нажатием Apply и OK.  
Запустите процесс моделирования работы САР, выбрав для 
этого команду меню Simulation→Start.  
В результате на экране осциллографа (экран осциллографа от-

крывается двойным щелчком левой клавишей мыши на значке 
Scope) можно убедиться, что изменение выходной величины рав-
но нулю. Это естественно и объясняется тем, что выходной сигнал 
ПИД-регулятора, в соответствии с формулой (63), имеет нулевое 
значение. 
Постепенно увеличивайте значение параметра Proportional 
в ПИД-регуляторе, для каждого нового значения выполняйте 
моделирование САР и наблюдайте на экране осциллографа за 
тем, какой вид имеет график переходной функции САР. Шаг 
увеличения задает преподаватель. 
Когда система окажется на границе устойчивости и переходная 

функция САР будет иметь вид незатухающих колебаний (рис. 71), 
соответствующее значение параметра Proportional нужно за-
помнить.  
В окне ввода формул Command Window в строке ввода ко-
манд введите следующие команды: 
>> K_u =  
>> T_u =  
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После знаков равенства нужно ввести значения параметра 
Proportional (для переменной K_u) и определенного по графику 
периода незатухающих колебаний переходной функции (для пе-
ременной T_u). 
В соответствии с формулой (64) в окне ввода формул 

Command Window в строке ввода команд введите следующие 
команды: 
>> K_p = 0.6*K_u ; 
>> K_I = 2*K_u / T_u ; 
>> K_d = K_u * T_u / 8 ;  

 

 
Рис. 71. Переходная функция САР в виде незатухающих колебаний 
 

Переменные K_p, K_I, K_d введите в ПИД-регулятор в поля 
Proportional, Integral и Derivative соответственно. 
Запустите моделирование работы САР, для получившейся пе-
реходной функции по задающему воздействию определите зна-
чения показателей качества: перерегулирования σ и времени ре-
гулирования tРЕГ. Полученный график и значения показателей 
качества включите в отчет. 
Получите переходную функцию по возмущающему воздействию. 
Для этого отсоедините выход компонента Step от входа ком-
понента Set_value и соедините со входом компонента W_of.  
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Таким образом подаваемый на систему входной сигнал будет яв-
ляться возмущающим воздействием. 
Запустите моделирование работы САР, для получившейся пе-
реходной функции по возмущающему воздействию определите 
значения показателей качества: перерегулирования σ и времени 
регулирования tРЕГ. Полученный график и значения показателей 
качества включите в отчет. 
Отсоедините выход компонента Step от входа компонента 

W_of и снова соедините со входом компонента Set_value. 
Запишите в отчет значения Ku, Tu, значения коэффициентов Kp, 

KI, Kd, рассчитанные по формуле (64), и полученную передаточ-
ную функцию ПИД-регулятора.  

3. Настройка ПИД-регулятора с помощью компонента  
NCD Outport 

Инструментальный пакет Nonlinear Control Design Blockset 
(NCD Blockset) предоставляет в распоряжение пользователя графи-
ческий интерфейс для настройки параметров Simulink-моделей ди-
намических объектов, обеспечивающих желаемое качество пере-
ходных процессов.  
В окно редактирования модели перетащите компонент NCD 

Outport, который находится в библиотеке NCD Blockset. Вход 
компонента NCD Blockset соедините с выходом объекта управле-
ния Object. Двойным щелчком на пиктограмме NCD Outport от-
кройте рабочее окно данного блока.  
Рабочее окно блока NCD Outport с временными ограничениями 

по умолчанию показано на рис. 72.  
На нем изображено, что контролируемым сигналом является пе-

реходная характеристика, на которую накладываются следующие 
ограничения: 

• максимальное перерегулирование – не более 20 %; 
• время нарастания – не более 400 с; 
• время регулирования – не более 1000 с; 
• коридор для определения времени регулирования составляет 1 %; 
• длительность переходного процесса (время моделирования) – 

не более 3000 с. 
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Рис. 72. Рабочее окно блока NCD Outport 

 
Для установки других значений временных ограничений наибо-

лее просто с помощью мыши переместить вертикальные и горизон-
тальные линии ограничений в требуемое положение. Точную уста-
новку линий ограничения можно провести, выбрав требуемые 
линии с помощью щелчка левой клавиши мыши (выбранная линия 
становится белой) и выполнив в меню Edit команду Edit constraint 
(Изменить ограничение), либо щелкнув на соответствующей линии 
правой клавишей мыши. В появляющемся окне (рис. 73) редактора 
ограничений Constraint Editor, в текстовом поле Position editor 
необходимо задать координаты начальной и конечной точек пря-
мой в формате [x1, y1, x2, y2], нажав затем кнопку Done. 

 

 
Рис. 73. Окно редактора ограничений 
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В примере на рис. 73 линия ограничения начинается с точки 
с координатами (900, 0.99) и продолжается до точки с координата-
ми (3000, 0.99). Эта линия ограничивает снизу 1%-й коридор для 
определения времени регулирования (так как установившееся зна-
чение будет равно 1).  
Установите положение левой верхней границы переходного 
процесса по вертикали с 1.2 на 1.3 (соответствует перерегулиро-
ванию 30%σ = ).  
Установите время нарастания равным 1000 с (для этого распо-
ложите среднюю нижнюю линию на один уровень с левой ниж-
ней линией). 
Установите коридор для определения времени регулирования 
равным 5 %. Для этого расположите правую верхнюю линию на 
уровне 1.05, а правую нижнюю линию на уровне 0.95. 
Так, например, для установления нижней границы 5%-го кори-

дора (с учетом времени нарастания, равного 1000 с) необходимо в 
текстовое поле Position editor соответствующей линии ввести 
[1000, 0.95, 3000, 0.95], нажав затем кнопку Done. 
Далее необходимо указать настраиваемые параметры: K_p, K_I, 

K_d.  
В меню Optimization рабочего окна блока NCD Outport выбе-
рите команду Parameters. 
Это приведет к открытию диалогового окна задания оптимизи-

руемых параметров и интервала дискретизации – Optimization 
Parameters (рис. 74).  

 

 
Рис. 74. Окно задания оптимизируемых параметров блока NCD Outport 
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В текстовое поле Tunable Variables введите имя оптимизи-
руемой переменной. Если таких переменных несколько, как 
в нашем случае – три, то их имена разделяются пробелами. 
В текстовое поле Discretization Interval вводится значение ин-
тервала дискретизации при моделировании переходного процес-
са, выраженное в секундах. 
В качестве примера на рис. 71 показаны три оптимизируемых 

параметра (K_p, K_I, K_d) и установлено значение интервала дис-
кретизации, равное 5 с.  
Для подтверждения ввода нажмите кнопку Done. 
Для запуска процесса оптимизации в меню рабочего окна бло-
ка NCD Outport выберите команду Optimization→Start. 
После успешного окончания процесса оптимизации в окне ввода 

формул Command Window появится соответствующее сообщение: 
Optimization Converged Successfully (Оптимизация выполнена 
успешно). В рабочем окне блока NCD Outport будет отображен 
график переходного процесса, соответствующего оптимальным 
настройкам ПИД-регулятора.  
Оптимизированные значения коэффициентов K_p, K_I, K_d 
можно просмотреть, выполнив двойной щелчок левой клавишей 
мыши на значке соответствующей переменной в окне 
Workspace, либо в окне Command Window, введя в строке вво-
да формул следующее выражение: 
>> K_p ,  K_I ,   K_d 
Запустите моделирование работы САР, для получившейся пе-
реходной функции по задающему воздействию определите зна-
чения показателей качества – перерегулирования σ и времени ре-
гулирования tРЕГ. Полученный график и значения показателей 
качества включите в отчет. 
Получите переходную функцию по возмущающему воздей-
ствию. 
Для этого отсоедините выход компонента Step от входа ком-
понента Set_value и соедините со входом компонента W_of.  
Таким образом, подаваемый на систему входной сигнал будет 
являться возмущающим воздействием. 
Запустите моделирование работы САР, для получившейся пе-
реходной функции по возмущающему воздействию определите 
значения показателей качества – перерегулирования σ и времени 
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регулирования tРЕГ. Полученный график и значения показателей 
качества включите в отчет. 
Отсоедините выход компонента Step от входа компонента 

W_of и снова соедините со входом компонента Set_value. 
Запишите в отчет значения коэффициентов Kp, KI, Kd, получен-
ные с помощью блока NCD Outport, и передаточную функцию 
ПИД-регулятора с этими значениями.  
Сравните две полученные формулы и сделайте вывод о синтезе 
ПИД-регулятора с помощью метода Зиглера-Никольса и компо-
нента NCD Outport. 

Содержание отчета 
1. Название лабораторной работы, цель, задание. 
2. Компьютерная модель исследуемой САР с ПИД-регулятором 

в качестве устройства управления, созданная в Simulink. 
3. Результаты настройки ПИД-регулятора по методу Зиглера-

Никольса: значение коэффициента пропорциональной составляю-
щей регулятора Ku, при котором в системе наблюдаются незату-
хающие колебания переходного процесса, значение периода неза-
тухающих колебаний Tu; значения коэффициентов Kp, KI, Kd, 
рассчитанные по формуле (64).  

4. Графики переходных функций САР с оптимальными значе-
ниями параметров ПИД-регулятора, полученными по методу Зиг-
лера-Никольса, по задающему и возмущающему воздействиям 
с указанием значений показателей качества регулирования. 

5. Результаты настройки ПИД-регулятора с помощью блока 
NCD Outport: значения коэффициентов Kp, KI, Kd.  

6. Графики переходных функций САР с оптимальными значе-
ниями параметров ПИД-регулятора, полученными с помощью бло-
ка NCD Outport, по задающему и возмущающему воздействиям 
с указанием значений показателей качества регулирования. 

7. Сравнение результатов настройки ПИД-регулятора различ-
ными методами. 

Контрольные вопросы 
1. Дайте определение пропорционально-интегрально-дифферен-

циального закона регулирования САР и запишите его передаточ-
ную функцию. 
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2. В чем заключается задача синтеза САР? 
3. Приведите формулы метода Зиглера-Никольса настройки 

ПИД-регулятора. 
4. Опишите порядок настройки ПИД-регулятора с помощью 

компонента NCD Outport. 
 

Исходные данные по вариантам 

Вариант Т1, с Т2, с 
1 80 250 
2 100 250 
3 100 200 
4 100 300 
5 150 250 
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Лабораторная работа № 10 
ИССЛЕДОВАНИЕ ДВУХПОЗИЦИОННОГО 

РЕГУЛЯТОРА И ДВУХПОЗИЦИОННЫХ СИСТЕМ 
 

Цель работы: ознакомиться с принципом действия двухпози-
ционного регулятора; исследовать двухпозиционный регулятор 
на примере регулятора температуры и режимы работы двухпо-
зиционных систем на примере САР температуры сушильной  
камеры. 
Задание:  
1. Изучить принцип действия двухпозиционного регулятора. 
2. Запрограммировать измеритель-регулятор температуры 

МТ2141 как двухпозиционный регулятор температуры сушиль-
ной камеры.  

3. Снять статическую характеристику регулятора как функцию 
сопротивления датчика. По снятой характеристике рассчитать, 
действительно ли регулятор срабатывает при заданных темпера-
турах. 

4. В программе компьютерного моделирования Simulink соста-
вить компьютерную модель двухпозиционной САР температуры 
в сушильной камере и смоделировать ее работу. 

Аппаратура, используемая в лабораторной работе 
Лабораторная установка выполнена на базе цифрового измери-

теля-регулятора МТ2141, предназначенного для измерения и регу-
лирования температуры (рис. 75), магазина сопротивлений, имити-
рующего датчик температуры – термометр сопротивления. 

 

 
Рис. 75. Внешняя панель измерителя-регулятора температуры МТ2141 
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Регулятор позволяет реализовать двух- и трехпозиционные за-
коны регулирования и ПИД-закон регулирования в нелинейной 
приближенной реализации. Для этого регулятор снабжен двумя 
программируемыми каналами регулирования с релейными выхо-
дами K1, K2. 
К регулятору в качестве датчика могут быть подключены пла-

тиновые и медные термометры сопротивления 100П и 100М с но-
минальным сопротивлением при 0 ºС равным 100 Ом, термопары, 
токовые и потенциальные датчики. 
Для моделирования режимов работы позиционных САУ на 

ЭВМ используется пакет компьютерного моделирования Simulink, 
входящий в состав системы компьютерных расчетов MATLAB. 

 
Выполнение работы 

1. Принцип действия двухпозиционного регулятора 
Позиционной называют САУ, в которой управляющее воздей-

ствие на объект ступенчато изменяется в зависимости от уровня 
ошибки. 
Соответственно, позиционным называют закон регулирования, 

когда управляющее воздействие на объект принимает ряд постоян-
ных дискретных значений (изменяется ступенчато) в зависимости 
от ошибки системы. 

Двухпозиционными называются регуляторы, выходной сигнал u 
которых (сигнал управления) имеет два фиксированных значения, 
и переход с одного на другое происходит скачком. 
Позиционные регуляторы обязательно включают в себя так на-

зываемые элементы прерывного действия, а именно, релейные эле-
менты. Статические характеристики, связывающие входной и вы-
ходной сигналы наиболее распространенных релейных элементов, 
приведены на рис. 76. Реле с характеристикой на рис. 76, а назы-
вают идеальным, с характеристикой на рис. 76, б – реле с зоной 
неоднозначности (±а). 
В двухпозиционных регуляторах под входным сигналом хВХ 

понимается отклонение регулируемой величины от заданного зна-
чения хЗАД, т. е., сигнал ошибки e, а под выходным сигналом хВЫХ – 
управляющий сигнал u. 
Обычно двухпозиционные регуляторы работают следующим 

образом: полностью прекращают приток вещества или энергии 
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к объекту регулирования при превышении регулируемой величиной 
заданного уровня хЗАД и полностью восстанавливают этот приток 
при отклонении регулируемой величины от заданного уровня хЗАД 
в меньшую сторону. Сигнал управления хВЫХ имеет при этом лишь 
два значения: хВЫХ 1 и хВЫХ 2 (рис. 76). Одно из значений выходного 
сигнала двухпозиционного регулятора в этом случае соответствует 
отключенному состоянию реле, а второе – включенному. 

 

 
а                                                                          б 

Рис. 76. Статические характеристики релейных элементов:  
идеального (а) и с зоной неоднозначности (б) 

 
Примерами позиционных САУ являются системы регулирова-

ния температуры в холодильнике, температуры подошвы утюга. 
Эти системы являются двухпозиционными, поскольку управляю-
щее воздействие на объект принимает два значения. Например, 
при пониженной температуре подошвы утюга питание нагрева-
тельного элемента включается, при повышенной температуре – 
выключается. 
В сельском хозяйстве позиционное регулирование применяется 

в системах регулирования микроклимата в животноводческих по-
мещениях, регулирования температуры инкубаторов, температуры 
теплоносителя зерновых сушилок и т. д. 
Рассмотрим работу двухпозиционной САР на примере САР 

температуры сушильной камеры с одним нагревательным элемен-
том EK. Принципиальная схема двухпозиционной САР изображена 
на рис. 77, ее структурная схема – на рис. 78. 

xВХ 

xВЫХ 

xВЫХ 1 

xВЫХ 2 

0 xВХ 

xВЫХ 

xВЫХ 1 

xВЫХ 2 

0 

а а 
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Воздух в сушильной камере нагревается элементом EK. Темпе-
ратура воздуха θ регулируется двухпозиционным регулятором А. 
При включении системы температура в камере меньше заданной 

0 ЗАДθ < θ , сигнал ошибки положителен и превышает половину зо-
ны неоднозначности а: ЗАД 0e a= θ − θ > . Реле на выходе регули-
рующего блока А включается, и его замыкающий контакт А вклю-
чает магнитный пускатель KМ, который своими контактами 
запитывает нагревательный элемент EK. Начинается нагрев каме-
ры. При повышении температуры до заданной θЗАД плюс половина 
зоны неоднозначности а, когда сигнал ошибки станет равен e a= − , 
реле на выходе регулирующего блока выключится, контакт А ра-
зомкнется, магнитный пускатель KМ выключится и обесточит на-
гревательный элемент ЕK. В результате температура в сушильной 
камере начнет снижаться. Реле снова включится, когда сигнал 
ошибки станет равен e a= + . 

 

 
Рис. 77. Принципиальная схема двухпозиционной САР  

температуры сушильной камеры:  
EK – нагревательный элемент; А – регулирующий блок,  

RД – датчик (термометр сопротивления);  
А – контакт выходного реле регулирующего блока 
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KM 

A B C N 

KM 

A 
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При составлении структурной схемы нагреватель EK отнесен 
к объекту управления. Коэффициент передачи датчика перенесен 
в релейную характеристику регулирующего блока, поэтому сигнал 
ошибки e имеет размерность температуры. 

 

 
Рис. 78. Структурная схема двухпозиционной САР  

температуры сушильной камеры: 
θЗАД – заданная температура; e – сигнал ошибки; P – мощность нагревателя;  

θН – температура наружного воздуха (возмущающее воздействие);  
θF – приращение температуры в камере за счет изменения наружной температуры;  

θУ – приращение температуры в камере от работы нагревателя;  
θ – температура в камере; θД – сигнал датчика;  

2а – ширина зоны неоднозначности регулятора;  
WОУ – передаточная функция сушильной камеры по управляющему воздействию;  
WОF – передаточная функция сушильной камеры по возмущающему воздействию, 

WД – передаточная функция датчика 
 

Процесс нагрева и охлаждения воздуха в сушильной камере по-
вторяется. Таким образом, в сушильной камере устанавливается 
режим периодического нагрева и охлаждения.  
Такие установившиеся режимы работы называются автоколеба-

тельными. Процесс регулирования температуры в сушильной каме-
ре после включения САР температуры изображен на рис. 79.  
Размах автоколебаний больше ширины зоны неоднозначности 

2а, что обусловлено инерционностью датчика и объекта управле-
ния. В нашем примере за счет инерционности датчика изменение 
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сигнала ошибки e(t) отстает по времени от изменения температуры 
в камере θ(t), поэтому реле срабатывает позже. Кроме того, снижение 
(повышение) температуры начинается не сразу после срабатывания 
реле, а после того, как нагревательный элемент несколько охладит-
ся (нагреется). 

 
Рис. 79. Процесс регулирования температуры в сушильной камере,  

обеспечиваемый двухпозиционной САР 
 

При увеличении задающего воздействия (в нашем случае темпе-
ратуры θЗАД) автоколебания несколько смещаются вверх, при сни-
жении – вниз. 
При увеличении возмущающего воздействия (в нашем случае 

температуры наружного воздуха θН) – изменяется период и форма 
автоколебаний, а также скважность импульсов включе-
ния/отключения регулятора.  

Показателями качества регулирования для двухпозиционных 
САР являются максимальное отклонение регулируемой величины 
от заданного значения (в нашем примере – от заданной температу-
ры θЗАД) и частота и амплитуда автоколебаний. Быстродействие 
системы определяется временем установления автоколебаний.  

Параметрами настройки регулятора являются заданное зна-
чение регулируемой величины (в нашем примере – θЗАД) и ширина 
зоны неоднозначности 2а. 

t

θ

θЗАД 2⋅a

Переходный
процесс 

Установившийся
автоколебательный режим

2a 
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2. Программирование измерителя-регулятора температуры 
МТ2141 на двухпозиционный регулятор температуры  
сушильной камеры 

Работа прибора определяется значениями параметров, которые 
программируются оператором.  
У прибора имеется три уровня программирования: конфигура-

ционный, параметрический и рабочий. Переход от одного уровня 
ко второму осуществляется при нажатом состоянии операторной 
кнопки   .  

1.1. Для задания параметров на конфигурационном уровне про-
граммирования Conf необходимо на панели регулятора нажать 
кнопку  и удерживать ее до тех пор, пока на индикаторе прибора 
не появится сообщение Conf. 
Программируемые параметры появляются последовательно при 

нажатии операторной кнопки   . 
На данном уровне необходимо задать положение  Pnt – x1. Вы-

бор разряда производится нажатием кнопки  . 
Выбранные значения подтверждаются одновременным нажа-

тием операторных кнопок  + , причем первой нажимается 
кнопка . 
Выход из данного уровня программирования осуществляется 

одновременным нажатием кнопок   +  . 
1.2. Для задания параметров на параметрическом уровне про-

граммирования Par необходимо на панели регулятора нажать 
кнопку    и удерживать ее до тех пор, пока на индикаторе прибо-
ра не появится сообщение Par. 
Программируемые параметры появляются последовательно при 

нажатии операторной кнопки   . 
Откройте параметрический уровень программирования. Вве-
дите значение ширины зоны неоднозначности 2а для выхода K1 
(HYS1). Для этого нажимайте операторную кнопку   ,  пока на 
индикаторе прибора не появится сообщение HYS1, затем выбе-
рите численного значения ширины зоны неоднозначности нажа-
тием операторной кнопки   . Подтвердите выбранное значение 
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одновременным нажатием операторных кнопок   +  , причем 
первой нажимается кнопка  . 
Далее выберите направление регулирования. Для этого нажи-
майте операторную кнопку   , пока на индикаторе не появится 
сообщение dir. С помощью операторной кнопки  выберите на-
правление регулирования (нагрев)    и подтвердите выбор 
одновременным нажатием операторных кнопок   +  , причем 
первой нажимается кнопка   . 
Выйдите из параметрического уровня программирования, од-
новременно нажав кнопки    +  . 

1.3. На рабочем уровне задаем значение температуры θЗАД 
(центр ширины зоны неоднозначности 2а).  
Нажимайте операторную кнопку   и, не отпуская ее, нажмите 
операторную кнопку  , затем с помощью операторной кнопки  

 выберите заданное значение температуры θЗАД и зафиксируй-
те одновременным нажатием операторных кнопок   +  . 

3. Снятие статической характеристики регулятора 
В данной работе регулятор запрограммирован на термометр 

сопротивления 100М (W100 = 1,426). Это значит, что датчик при 
температуре 0ºС имеет номинальное сопротивление 100 Ом, 
а при температуре 100 ºС – сопротивление 142,6 Ом, поэтому 
номинальная статическая характеристика датчика описывается 
формулой: 

Д 100 0,426R = + θ ,                                   (66) 

где RД – сопротивление датчика, Ом; 
θ – температура, ºС. 
 
С помощью магазина сопротивлений увеличивайте значение 
сопротивления датчика вначале через 1 Ом, при приближении 
к запрограммированной температуре выключения реле K1 –  
через 0,1 Ом, и зафиксируйте значение сопротивления RД и θ, 
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при которых происходит выключение реле K1. Затем аналогич-
ным образом уменьшайте значение сопротивления магазина и 
зафиксируйте значение сопротивления RД и θ, при которых про-
исходит включение реле K1. Результаты внесите в табл. 9. 

 

Таблица 9 

Статическая характеристика двухпозиционного регулятора 

RД, Ом 100 101 102 … 

θ, ºС 0   … 

θрасч, ºС     

Состояние реле K1 +    

Постройте по данным табл. 9 статическую характеристику как 
функцию сопротивления датчика для регулирующего выхода K1, 
на ней покажите ширину зоны неоднозначности. 
Рассчитайте по экспериментальной характеристике, при каких 
температурах срабатывает регулятор, используя статическую ха-
рактеристику датчика (66). Сравните полученные значения с запро-
граммированными параметрами порогов срабатывания (θЗАД ± а). 
Сделайте выводы о соответствии запрограммированных пара-
метров расчетным значениям. 

4. Компьютерное моделирование работы САР 
Для исследования режимов работы позиционных САУ в на-

стоящее время наиболее точным, удобным и наименее трудоемким 
методом является компьютерное моделирование, в процессе кото-
рого и определяются значения параметров настройки регулятора. 
Для компьютерного моделирования работы двухпозиционной 

САР за основу возьмем структурную схему САР температуры 
в сушильной камере, изображенную на рис. 65 (см. лабораторную 
работу № 7). 
В качестве регулятора используется двухпозиционное реле, ма-

тематическое описание работы которого, в соответствии с рис. 76, 
78, имеет следующий вид: 
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                    (67) 

Для упрощения схемы будем считать, что значение коэффици-
ента передачи датчика KД учтено в релейной характеристике регу-
лирующего блока, т. е., что регулятор «настроен» на подключение 
данного конкретного датчика температуры, как это действительно 
имело место в случае регулятора МТ2141 в пунктах 2 и 3 данной 
лабораторной работы. Будем полагать, что Д ЗАД 1K K= = . Отсюда 
следует, что величина выходного сигнала датчика и задатчика – 
температура, выраженная в градусах по Цельсию. 
Таким образом, структурная схема рассматриваемой САР при-

нимает вид, показанный на рис. 80. 
Выполните запуск пакета компьютерного моделирования 

Simulink так, как это указано при описании выполнения лабора-
торной работы № 1. 
В окне ввода команд Command Window в строке ввода ввести 
следующие команды: 
>> clear all;   close all;   clc; 
>> global T_ext   % наружная температура в градусах Цельсия 
>> global T_req   % заданная температура в градусах Цельсия 
>> global  a   % полуширина зоны неоднозначности регулятора 
>> global   T1   T2   K_obj % параметры объекта 
>> global  T_sens % постоянная времени датчика 
>> global K_mech % коэффициент исполнительного устройства 
>> T_ext =  ;      T_req =   ;      
>> a =;        
>> T1=    ;    T2 =    ; 
>> K_obj = 1;    
>> T_sens = 20;   
>> K_ mech = 50;  % мощность нагревателя в ваттах 
После знаков равенства введите значения параметров (по вари-
антам). 
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Рис. 80. Структурная схема двухпозиционной САР температуры  

в сушильной камере:  
θ – управляемая величина (температура в камере);  
θЗАД – заданное значение температуры в камере;  

θД – значение температуры, показываемое датчиком; e – ошибка управления;  
u – сигнал управления; а – значение полуширины зоны неоднозначности;  

P – управляющее воздействие на объект со стороны исполнительного устройства 
(мощность нагревателя); θН – возмущающее воздействие на объект  

(изменение наружной температуры) 
 

Далее на основе структурной схемы САР на рис. 80 создадим 
в Simulink модель САР с двухпозиционным регулятором. В качест-
ве начальной основы можно взять модель САР, созданную при вы-
полнении лабораторной работы № 9. В модель необходимо внести 
следующие изменения. 

1) Удалите компоненты PID Controller, Set_value и Step. 
2) Вместо удаленного компонента PID Controller в качестве 
регулятора используйте компонент Relay, находящийся в окне 
Simulink Library Brouser в библиотеке компонентов Simulink на 
вкладке Discontinuities. Перетащите значок Relay в окно редак-
тирования модели и расположите на месте удаленного компо-
нента. Вход Relay (сигнал ошибки e) соедините с выходом срав-
нивающего устройства, выход Relay (сигнал управления u) 
соедините со входом исполнительного устройства. Двойным 
щелчком левой клавишей мыши на значке Relay откройте окно за-
дания параметров данного блока Block Parameters: Relay. В нем 
в поле Switch on point (Точка включения) введите полуширину 
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зоны неоднозначности a, в поле Switch off point (Точка отклю-
чения) введите –a. В полях Output when on (Значение на выходе 
во включенном состоянии) и Output when off (Значение на вы-
ходе в отключенном состоянии) оставьте заданные по умолча-
нию значения: 1 и 0, соответственно. Ввод данных подтвердите 
нажатием кнопок Apply и OK. 

3) Двойным щелчком левой клавишей мыши на элементе 
Sensor откройте окно задания его параметров Block 
parameters: Sensor и в поле Numerator (Числитель передаточ-
ной функции) вместо K_sens введите 1, ввод подтвердите нажа-
тием клавиш Apply и OK. 

4) В качестве начального условия можно считать, что до начала 
процесса моделирования, т. е. при 0t < , САР была выключена, 
и в момент включения САР (при 0t = ) температура внутри су-
шильной камеры была равна температуре снаружи: 0 Hθ = θ . Для 
задания начального условия используется компонент Constant 
(Источник постоянного по времени сигнала).  
Два компонента Constant (расположены на вкладке Sources 
библиотеки Simulink) поочередно перетащите мышью в окно ре-
дактирования модели и расположите один из них слева от значка 
W_of, а второй – слева от значка Sum. Первому из элементов ав-
томатически будет присвоено имя Constant, второму – 
Constant1.  
Выход элемента Constant1 соедините со входом «+» элемента 

Sum. На получившейся линии соединения щелкните правой кла-
вишей мыши и во всплывающем меню выберите команду Signal 
Properties (Свойства сигнала). В открывшемся в результате это-
го диалоговом окне в поле Signal name (Имя сигнала) введите 
Т_req (от англ. required – «требуемый»). 
Нажмите Apply и OK. Элемент Constant, таким образом, слу-
жит для ввода в систему заданного значения температуры в су-
шильной камере. Двойным щелчком левой клавиши мыши 
на элементе Constant откройте диалоговое окно задания его  
параметров  Block parameters: Constant и в поле Constant 
value (Значение постоянного сигнала) введите имя глобальной 
переменной T_req, после чего ввод подтвердите нажатием 
Apply и OK. 
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Элемент Constant будет служить для ввода в систему значения 
наружной температуры. Поэтому выход элемента Constant соеди-
ните со входом элемента W_of, на получившейся линии соединения 
задайте имя сигнала Т_ext (от англ. exterior – «наружный»). В каче-
стве значения постоянного сигнала элемента Constant1 задайте 
имя соответствующей глобальной переменной T_ext. 

6) В процессе моделирования работы САР необходимо отобра-
жать графики изменения во времени сигнала ошибки регулирова-
ния e(t), сигнала управления u(t) на выходе регулятора и темпера-
туры внутри сушильной камеры θ(t).  
Двойным щелчком левой клавиши мыши на элементе Scope 
откройте его рабочее окно. Для отображения трех графиков сиг-
налов в верхней части окна на панели инструментов выполните 

левой кнопкой мыши щелчок на кнопке Parameters  (второй 
слева), в появившемся всплывающем окне задания параметров 
в поле Number of axes введите число 3, нажмите Apply и OK.  
После этого в окне редактирования модели (компонент Scope 
уже имеет три входа) верхний вход Scope соедините с линией 
сигнала e между выходом элемента сравнения Sum и входом ре-
гулятора Relay.  
Второй вход Scope соедините с линией сигнала u между вы-
ходом регулятора Relay и входом исполнительного устройства.  
Выход элемента Object соедините с третьим входом элемента 

Scope. 
Приблизительный вид созданной графической модели иссле-

дуемой САР температуры в сушильной камере показан на рис. 81. 
Сохраните построенную графическую модель САР в файл 
с именем relay2_regulator.mdl. 
Для запуска процесса моделирования выполните команду ме-
ню Simulation→Start.  
Открыв рабочее окно элемента Scope, можно видеть соответст-

вующие графики изменения во времени сигналов e(t), u(t), θ(t). 
Для обеспечения наглядности отображения графиков можно раз-
вернуть рабочее окно Scope на весь экран, а также нажать на пане-

ли инструментов кнопку Autoscale  (автоматическое масшта-
бирование). 
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Рис. 81. Графическая модель САР с двухпозиционным регулятором 

 
Проведите моделирование работы системы для нескольких 
различных значений наружной температуры (возмущающего 
воздействия на систему), полагая, что это изменение имеет форму 
ступенчатого воздействия, т. е. что в некоторый момент времени 
наружная температура достаточно быстро изменяется на несколько 
градусов. Оцените, как изменяются графики e(t), u(t), θ(t). 
Графики поведения системы при двух различных возмущаю-
щих воздействиях e(t), u(t), θ(t) (по вариантам) включите в отчет. 
Сделайте выводы о переходных и установившемся режимах 
работы двухпозиционных систем и изменении этих режимов при 
изменении возмущающего воздействия. 

 
Содержание отчета 

1. Название лабораторной работы, цель, задание. 
2. Результаты эксперимента (табл. 9).  
3. Статическая характеристика регулятора в виде функции со-

противления датчика. 
4. Расчетные температуры срабатывания регулятора. 
5. Выводы о соответствии запрограммированных параметров 

расчетным значениям. 
6. Компьютерная модель исследуемой САР, созданная в Simulink. 
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7. Графики e(t), u(t), θ(t) поведения системы при двух различных 
возмущающих воздействиях. 

8. Выводы о переходных и установившемся режимах работы 
двухпозиционных систем и изменении этих режимов при измене-
нии возмущающего воздействия. 

 
Контрольные вопросы 

1. Дайте определение позиционного закона регулирования, двух-
позиционного закона регулирования. 

2. Назовите параметры настройки двухпозиционных регуляторов. 
3. Поясните смысл понятия «зона неоднозначности». 
4. Как называется установившийся режим в двухпозиционных 

системах? 
5. Назовите показатели качества регулирования двухпозицион-

ных САР. 
6. Как изменяются режимы работы двухпозиционных систем 

при изменении возмущающего воздействия? 
 

Исходные данные по вариантам 

Вариант 1 2 3 4 5 
Т1 80 100 100 150 150 
Т2 250 250 300 250 300 
θзад (T_req) 8 10 12 11 15 
2а 4 2 2 4 2 
θн1 (T_ext1) 4 7 7 6 0 
θн2 (T_ext2) 7 10.5 11.5 10 14 
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Лабораторная работа № 11 
ИССЛЕДОВАНИЕ ТРЕХПОЗИЦИОННОГО 

РЕГУЛЯТОРА И ТРЕХПОЗИЦИОННЫХ СИСТЕМ 
 
Цель работы: ознакомиться с принципом действия трехпози-

ционного регулятора; исследовать трехпозиционный регулятор на 
примере регулятора температуры и режимы работы трехпозицион-
ных систем на примере САР температуры сушильной камеры. 
Задание:  
1. Изучить принцип действия трехпозиционных регуляторов. 
2. Запрограммировать измеритель-регулятор температуры МТ2141 

на трехпозиционный регулятор температуры сушильной камеры. 
3. Снять статическую характеристику регулятора как функцию 

сопротивления датчика. По снятой характеристике рассчитать, 
действительно ли регулятор срабатывает при заданных темпе-
ратурах. 

4. В программе компьютерного моделирования Simulink соста-
вить компьютерную модель трехпозиционной САР температуры 
в сушильной камере и смоделировать ее работу. 

Аппаратура, используемая в лабораторной работе 

Цифровой измеритель-регулятор температуры МТ2141, предна-
значенный для измерения и регулирования температуры (см. рис. 75), 
магазин сопротивлений, имитирующий датчик температуры – тер-
мометр сопротивления, и ЭВМ для компьютерного моделирования 
режимов работы позиционных САУ с использованием пакета ком-
пьютерного моделирования Simulink, входящего в состав системы 
компьютерных расчетов MATLAB. 

Выполнение работы 

1. Трехпозиционные регуляторы 
Трехпозиционными называются регуляторы, выходной сигнал u 

которых (сигнал управления) имеет три фиксированных значения, 
а переход от одного к другому значению происходит скачком 
(рис. 82).  
Принципиальная схема трехпозиционной САР изображена на 

рис. 83, ее структурная схема изображена на рис. 84. 
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Рис. 82. Статическая характеристика трехпозиционного регулятора 
 

 
Рис. 83. Принципиальная схема трехпозиционной САР  

температуры сушильной камеры: 
EK1, ЕK2 – нагревательные элементы; RД – датчик (термометр сопротивления);  

А – регулирующий блок;  
А.1, А.2 – контакты выходных реле регулирующего блока 

 
После включения системы срабатывают оба реле регулирую-

щего блока А, поэтому пускатели KМ1 и KМ2 запитывают оба 
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нагревателя ЕK1 и ЕK2. Температура в сушильной камере быст-
ро растет.  

 

 
Рис. 84. Структурная схема трехпозиционной САР температуры  

сушильной камеры: 
θЗАД – заданная температура; e – сигнал ошибки; P – мощность нагревателя;  

θД – сигнал датчика; θН – температура наружного воздуха;  
θF – приращение температуры в камере за счет изменения наружной температуры;  

θУ – приращение температуры в камере от работы нагревателя;  
θ – температура в камере; 2а – ширина зоны нечувствительности;  

d – зоны неоднозначности (дифференциалы);   
WОУ – передаточная функция сушильной камеры по управляющему воздействию;  
WОF – передаточная функция сушильной камеры по возмущающему воздействию;    

WД – передаточная функция датчика 
 

Когда температура входит в зону нечувствительности 2а плюс 
дифференциал d, т. е. когда ( ) ( )ЗАДt a dθ ≥ θ − − , ошибка регулиро-
вания становится меньше e a d≤ − , и первое реле отключается, 
пускатель KМ1 обесточивает нагревательный элемент ЕK1. Далее 
возможны три варианта работы системы. 

1. Если мощности второго нагревательного элемента ЕK2 не 
хватает для дальнейшего повышения температуры или удер-
жания его в зоне нечувствительности (что может быть при дос-
таточно низкой наружной температуре), температура в камере на-
чинает снижаться. После выхода из зоны нечувствительности 
нагревательный элемент ЕK1 опять включится, и температура нач-
нет подниматься. В результате возникают автоколебания около 
нижней зоны неоднозначности d (рис. 85, график 1).  
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2. Если мощности второго нагревательного элемента ЕK2 хва-
тает для удержания температуры в зоне нечувствительности, 
то в системе устанавливается статический режим (рис. 85, график 2). 

3. Если мощности второго нагревателя ЕK2 хватает для даль-
нейшего повышения температуры, то после выхода температуры 
из зоны нечувствительности, т. е. при ( ) ЗАДt aθ ≥ θ + , срабатывает 
второе реле, размыкается контакт А.2 и пускатель KМ2 обесточи-
вает нагревательный элемент ЕK2. Температура начинает пони-
жаться. После входа температуры в зону нечувствительности, т. е. 
при  ( ) ЗАДt a dθ ≤ θ + − , когда ошибка становится e a d≤ − , второе 
реле выключается, контакт А.2 замыкается, пускатель запитывает 
нагревательный элемент ЕK2, температура начинает повышаться. 
Возникает режим автоколебаний около верхней зоны неоднознач-
ности d (рис. 85, график  3). 

 
Рис. 85. Процесс регулирования температуры в сушильной камере,  

 обеспечиваемый трехпозиционной системой: 
1 – режим автоколебаний около нижней зоны неоднозначности d;  

2 – статический установившийся режим;  
3 – режим автоколебаний около верхней зоны неоднозначности d 

 
В работающей системе переход из одного режима в другой про-

исходит при изменении возмущающего воздействия (в нашем при-
мере – при изменении температуры наружного воздуха). При повы-
шении θН автоколебания смещаются вверх, при понижении – вниз. 
Если система неправильно разработана или настроена, напри-

мер, при установке слишком узкой зоны нечувствительности, 
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в трехпозиционной системе могут возникать трехпозиционные ав-
токолебания (рис. 86). При этом режим работы сходен с режимом 
работы двухпозиционной системы. Как правило, такая работа 
трехпозиционной системы неприемлема. 

t

θ

2⋅
a  

 
Рис. 86. Режим трехпозиционных автоколебаний в трехпозиционной системе 

 
Параметрами настройки регулятора трехпозиционной систе-

мы являются заданное значение регулируемой величины (в нашем 
случае θЗАД) и ширина зоны нечувствительности 2а. В некоторых 
регуляторах можно также изменять дифференциал d. 

Параметрами качества регулирования являются максимальное 
отклонение регулируемой величины от заданного значения, частота 
и амплитуда автоколебаний. Быстродействие системы определяется 
временем перехода системы в установившийся режим работы. 

2. Программирование измерителя-регулятора температуры 
МТ2141 на трехпозиционный регулятор температуры  
сушильной камеры 

Трехпозиционный закон регулирования задается настройкой зон 
неоднозначности и их центров для реле K1 и K2. При этом ширина 
зоны нечувствительности равна разности θЗАД для реле K1 и K2 
плюс ширина зоны неоднозначности (дифференциал d) этих реле. 
Работа прибора определяется значениями параметров, которые 

программируются оператором. 
Выполните программирование измерителя-регулятора темпе-
ратуры МТ2141 по вариантам (см. порядок выполнения лабора-
торной работы № 10). 
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Центр неоднозначности для выхода K2 задается аналогично 
выходу K1. Разница заключается в том, что вместо кнопки  
нажимается кнопка  . 
Следует иметь в виду, что центр срабатывания реле K2 должен 

отстоять достаточно далеко от центра срабатывания реле K1. 

3. Снятие статической характеристики регулятора 
Как и в работе № 10, номинальная статическая характеристика 

датчика описывается формулой (63). 
С помощью магазина сопротивлений увеличивайте значение 
сопротивления датчика вначале через 1 Ом, при приближении 
к запрограммированным температурам выключения реле K1 и K2 – 
через 0,1 Ом, и зафиксируйте значения R12, R22, θ12, θ22, при кото-
рых происходит выключение реле K1 и K2. Затем аналогичным 
образом уменьшайте сопротивление магазина и зафиксируйте 
значения R11, R21, θ11, θ21, при которых происходит включение ре-
ле K1 и K2. Результаты внесите в табл. 10. 
Постройте статическую характеристику как функцию сопро-
тивления датчика для регулирующих выходов K1 и K2, покажи-
те на ней ширину зон нечувствительности и неоднозначности 
(дифференциалы d). 

 
Таблица 10 

Статическая характеристика трехпозиционного регулятора 

RД, Ом 100 101 102 … 
θ, ºС 0   … 
θрасч, ºС     
Состояние реле K1 +    
Состояние реле K2 +    

 
Рассчитайте по экспериментальной характеристике, при каких 
температурах срабатывает регулятор, используя статическую ха-
рактеристику датчика. Сравните полученные значения с запро-
граммированными параметрами порогов срабатывания.  
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Сделайте выводы о соответствии запрограммированных пара-
метров расчетным значениям.  

4. Компьютерное моделирование работы САР 
Для компьютерного моделирования работы трехпозиционной 

САР за основу следует взять структурную схему САР температуры 
в сушильной камере, изображенную на рис. 87. В качестве регуля-
тора используется трехпозиционное реле. 
Для упрощения схемы будем считать, что значение коэффици-

ента передачи датчика KД учтено в релейной характеристике регу-
лирующего блока, т. е., что регулятор «настроен» на подключение 
данного конкретного датчика температуры, как это действительно 
имело место в случае регулятора МТ2141 в пунктах 2 и 3 данной 
лабораторной работы т. е., будем полагать, что Д ЗАД 1K K= = .  
Отсюда следует, что величина выходного сигнала датчика и задат-
чика – температура, выраженная в градусах по Цельсию. 

 

 

Рис. 87. Структурная схема трехпозиционной САР температуры  
в сушильной камере:  

θ – управляемая величина (температура в камере);  
θЗАД – заданное значение температуры в камере;  

θД – значение температуры, показываемое датчиком; e – ошибка управления;  
u – сигнал управления; P – управляющее воздействие на объект со стороны  

исполнительного устройства (мощность нагревателя);  
θН – возмущающее воздействие на объект (изменение наружной температуры) 
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Выполните запуск пакета компьютерного моделирования 
Simulink так, как это указано при описании выполнения лабора-
торной работы № 1. 
Введите в MATLAB заданные преподавателем значения пара-
метров схемы. Для этого в окне ввода команд Command 
Window в строке ввода введите следующие команды: 
>> clear all;   close all;   clc; 
>> global T_ext   % наружная температура в градусах Цельсия 
>> global T_req   % заданная температура в градусах Цельсия 
>> global d % зона неоднозначности регулятора 
>> global a % полуширина зоны нечувствительности  
% регулятора 
>> global   T1   T2   K_obj % параметры объекта 
>> global  T_sens % постоянная времени датчика, с. 
>> global K_mech % коэффициент исполнительного устройства 
>> T_req =   ;      T_ext =  0;       
>> d =    ;    a =  ;    
>> T1=    ;   T2 =    ; 
>> K_obj = 1;    
>> T_sens = 20;   
>> K_ mech = 25;  % мощность нагревателя в ваттах 
После знаков равенства нужно ввести заданные значения па-
раметров (по вариантам). 
Далее на основе структурной схемы САР (см. рис. 84) создадим 

в Simulink модель САР с трехпозиционным регулятором. В качест-
ве начальной основы можно взять изображенную на рис. 81 модель 
САР, созданную при выполнении предыдущей лабораторной ра-
боты № 10. В данную модель необходимо внести следующие из-
менения: 

1) добавьте еще один компонент типа Relay, находящийся 
в окне Simulink Library Brouser в библиотеке компонентов 
Simulink на вкладке Discontinuities. При перетаскивании в окно 
редактирования модели новому компоненту будет автоматиче-
ски присвоено имя Relay1. 

2) удалите линию связи между выходом первого реле Relay 
и входом исполнительного устройства. Между двумя этими 
значками поместите еще один суммирующий элемент Sum, ему 
автоматически будет присвоено имя Sum1. Входы сумматора 
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Sum1 соедините с выходами реле Relay и Relay1, а выход сум-
матора – со входом исполнительного устройства, а также – со 
вторым входом элемента Scope. 
Таким образом, в данной схеме трехпозиционный регулятор  

моделируется с помощью двух двухпозиционных реле: Relay 
и Relay1. 

3) Задайте параметры настройки трехпозиционного регулятора. 
Для этого двойным щелчком левой клавишей мыши на значке 
Relay откройте окно задания параметров данного блока 
Block Parameters: Relay. В поле Switch on point (Точка вклю-
чения) введите –a + d, в поле Switch off point (Точка отключе-
ния) введите –a. В полях Output when on (Значение на выходе 
во включенном состоянии) и Output when off (Значение на вы-
ходе в отключенном состоянии) оставьте заданные по умолча-
нию значения: 1 и 0, соответственно. Ввод данных подтвердите 
нажатием кнопок Apply и OK. 
Аналогично для блока Relay1 задайте следующие параметры: 

a – для точки включения и a – d – для точки выключения. 
Приблизительный вид созданной графической модели иссле-

дуемой САР температуры в животноводческом помещении показан 
на рис. 88. 
Сохранить построенную графическую модель САР в файл 
с именем relay3_regulator.mdl. 

 

 
Рис. 88. Графическая модель САР с трехпозиционным регулятором 
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Для запуска процесса моделирования выполните команду ме-
ню Simulation→Start.  
Открыв затем рабочее окно элемента Scope, можно видеть со-

ответствующие графики изменения во времени сигналов e(t), u(t), 
θ(t). Для обеспечения наглядности отображения графиков можно 
развернуть рабочее окно Scope на весь экран, а также нажать на 

панели инструментов кнопку Autoscale  (Автоматическое 
масштабирование). 
Промоделируйте работу САР с различными возмущающими 
воздействиями. Найдите значения наружной температуры, ил-
люстрирующие три типа автоколебаний. Графики поведения 
системы при найденных возмущающих воздействиях e(t), u(t), 
θ(t) включите в отчет. 
Сделайте выводы о переходных и установившемся режимах 
работы трехпозиционных систем и изменении этих режимов при 
изменении возмущающего воздействия. 

Содержание отчета 
1. Название лабораторной работы, цель, задание. 
2. Результаты эксперимента (табл. 10).  
3. Статическая характеристика регулятора в виде функции со-

противления датчика. 
4. Расчетные температуры срабатывания регулятора. 
5. Выводы о соответствии запрограммированных параметров 

расчетным значениям. 
6. Компьютерная модель исследуемой САР, созданная в Simulink. 
7. Графики e(t), u(t), θ(t) поведения системы при трех различных 

возмущающих воздействиях, иллюстрирующие три типа автоколе-
баний. 

8. Выводы о переходных и установившемся режимах работы 
трехпозиционных систем и изменении этих режимов при измене-
нии возмущающего воздействия. 

Контрольные вопросы 
1. Дайте определение трехпозиционного закона регулирования. 
2. Назовите параметры настройки трехпозиционных регуляторов. 
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3. Поясните разницу между понятиями зона нечувствительности 
и зона неоднозначности. 

4. В каком установившемся режиме работают трехпозиционные 
системы? 

5. Назовите показатели качества регулирования трехпозицион-
ных САР. 

6. Как изменяются режимы работы трехпозиционных систем при 
изменении возмущающего воздействия? 

Исходные данные по вариантам 

Вариант 1 2 3 4 5 
Т1 80 100 100 150 150 
Т2 250 250 300 250 300 
θзад1 8 10 12 11 15 
θзад2 (T_req) 18 20 22 21 25 
2а 4 2 2 4 2 
d 0,5 0,25 0,25 0,5 0,25 
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Модуль 4. ДИСКРЕТНЫЕ, ОПТИМАЛЬНЫЕ,  
РОБАСТНЫЕ, АДАПТИВНЫЕ И ИНТЕЛЛЕКТУАЛЬНЫЕ 

СИСТЕМЫ УПРАВЛЕНИЯ  
 
 

Лабораторная работа № 12 
ИССЛЕДОВАНИЕ ЦИФРОВЫХ СИСТЕМ 
АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ 

 
Цель работы: изучить основные методы цифрового регулиро-

вания измеряемого сигнала. 
Задание:  
1. Исследовать схему блока сравнения. 
2. Исследовать работу шифратора сигнала. 
3. Исследовать работу регистра для запоминания информации АЦП. 
4. Исследовать работу измерителя температуры с цифровым вы-

ходом. 
5. Осуществить цифровое регулирование температуры.  

 
Аппаратура, используемая в лабораторной работе 

В работе используется специализированный учебный стенд 
«НТЦ-09.11 Основы автоматизации», изображенный на рис. 49 (см. 
лабораторную работу № 6). 
Для сборки исследуемых схем используются перемычки, при 

помощи которых производится коммутация соответствующих 
гнезд, выведенных на лицевую панель стенда. 
Необходимые измерения производятся с помощью сигнальных 

светодиодов, мультиметра, осциллографа. 

Выполнение работы 

1. Исследование схемы блока сравнения 
Сравнение кодов двух чисел осуществляют с помощью сравни-

вающих компараторов. На выходе компаратора появляется логическая 
единица, если сравниваемые двоичные числа А и В равны.  
Если А не равно В, то на выходе компаратора будет логический нуль. 
Для определения равенства двух переменных Х1 и Х2 используется 
логический элемент, состояние которого определяется в табл. 11. 
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Таблица 11 

Схема сравнения кодов двух двоичных чисел 

Х1 Х2 Y 

0 
0 
1 
1 

0 
1 
0 
1 

1 
0 
0 
1 

 
Такой логический элемент называется ИСКЛЮЧАЮЩИМ ИЛИ 

НЕ. Его реализация на логических элементах НЕ, И, ИЛИ показана 
на рис. 89. 

 

 
Рис. 89. Реализация логического элемента ИСКЛЮЧАЮЩЕЕ ИЛИ НЕ 

 
Если сравниваемые переменные имеют несколько разрядов, то 

подобным образом осуществляется поразрядное сравнение и схема 
компаратора примет вид, приведенный на рис. 90. 

 

 
Рис. 90. Схема компаратора на несколько разрядов 
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Соберите и исследуйте схему сравнения, представленную на 
рис. 91. 

 

 
Рис. 91. Схема сравнения, исследуемая в работе 

 
Подавая на блок схемы сравнения различные значения, со-
ставьте таблицу соответствия входных и выходных сигналов. 
Запишите формулу работы исследуемого блока сравнения. 

2. Исследование работы шифратора сигнала 
Под дискретизацией понимается преобразование непрерывных 

сигналов в дискретные. При этом используется дискретизация по 
времени и по уровню. Дискретизация по времени выполняется пу-
тем взятия отсчетов функции U(t) в определенные дискретные мо-
менты времени tк. В результате непрерывная функция U(t) заменя-
ется совокупностью мгновенных значений 

Uк = U(tк). 

Обычно моменты отсчетов выбираются на оси времени равно-
мерно, т. е.  
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tк = K∆t. 

Дискретизация по времени лежит в основе всех видов импульс-
ной модуляции. 
Дискретизация значений функции (уровня) носит название кван-

тования. Операция квантования сводится к тому, что вместо данного 
мгновенного значения сообщений U(t) передаются ближайшие зна-
чения по установленной шкале дискретных уровней (рис. 92). 

 

 
Рис. 92. Дискретизация по уровню 

 
Дискретные значения по шкале уровней выбираются равномерно: 

Uk = K∆U. 
При квантовании вносится погрешность, т. к. истинные значе-

ния функции U заменяются округленными значениями Uk.  
Погрешность ε = U – Uk является случайной величиной и прояв-

ляется на выходе как дополнительный шум, наложенный на пере-
даваемый сигнал. Дискретизация одновременно по уровню и по 
времени позволяет непрерывное сообщение преобразовать в дис-
кретное, которое затем может быть закодировано и передано мето-
дами дискретной техники. 
Достоинствами передачи сигналов путем их дискретизации яв-

ляются возможность применения кодирования для повышения  
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помехоустойчивости, удобства обработки сигналов и сопряжения 
устройств связи с цифровыми ЭВМ. 

3. Исследование работы регистра для запоминания  
информации АЦП 

Регистром памяти называется функциональный узел, предна-
значенный для приема, хранения, передачи и преобразования ин-
формации. В зависимости от способа приема информации регистры 
подразделяются на параллельные, последовательные и параллель-
но-последовательные. Основой построения регистров служат триг-
геры и логические схемы. 
На рис. 93 дана схема параллельного регистра на три разряда. 
 

 
Рис. 93. Схема параллельного трехразрядного регистра 

 
Рассмотрим принцип действия данной схемы.  
Перед приемом информации все триггеры переводятся в со-

стояние нуля подачей сигнала на вход «Уст. О». Входная инфор-
мация подается на входы элементов D1…D3 (схемы И). По сигна-
лу «Запись» эта информация появляется на выходах элементов 
D1…D3 и, воздействия на установочные выходы триггеров, пере-
ведет их в соответствующее состояние. По окончании записи 
триггеры останутся в этом состоянии независимо от входной  
информации. Для выдачи информации подается импульс на вход 



 179 

«Считывание». В этом случае на выходах элементов D4…D6  
появятся соответствующие значения сигналов. При этом этот код 
сохраняется в регистре. Параллельные регистры чаше всего ис-
пользуются для хранения информации. 
В последовательном регистре (регистре сдвига) информация 

вводится и выводится поразрядно. Регистр состоит из последова-
тельно соединенных ячеек, содержание которых под действием се-
рии тактовых импульсов перемещается от младшего разряда 
к старшему и наоборот. Наиболее широкое распространение полу-
чили параллельно-последовательные регистры (рис. 94). 

 

 
Рис. 94. Схема параллельно-последовательного регистра 

 
В таких регистрах информация может записываться как в па-

раллельном коде, так и в последовательном. Кроме того, эти реги-
стры позволяют преобразовать параллельный код в последователь-
ный и наоборот. 
Изобразите в виде таблицы взаимосвязь показаний элемента 
индикации, кодированного двоичным кодом выходного сигнала 
аналогово-цифрового преобразователя (АЦП) и значения темпе-
ратуры t ºС. 

4. Исследование работы измерителя температуры  
с цифровым выходом 

Соберите схему для аналогового измерения температуры на 
основе терморезистора и инвертирующего операционного уси-
лителя, изображенную на рис. 95. 
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Рис. 95. Схема для аналогового измерения температуры 

 
Определите температуру с помощью аналогового датчика тем-
пературы. 
Произведите преобразование выходного сигнала датчика в циф-
ровой сигнал, соединив выход схемы (см. рис. 95) с входом АЦП 
(рис. 96). 
Питание +12 В к ДУ подсоедините с помощью длинных 
проводов.  
Установите ДУ таким образом, чтобы его выходной потенциал 
был равен нулю. С помощью генератора одиночных импульсов 
ГОИ подайте управляющий импульс на АЦП и проверьте рабо-
тоспособность схемы (тумблер S9 включен). Проделайте тоже 
для нескольких ненулевых значений ДУ. 
Вместо ГОИ на управляющий вход подайте импульсы «1с». Для 
этого нужно установить соответствующую перемычку и включить 
тумблер S9, S10. Плавно вращая ДУ и используя вольтметр для 
измерения входного сигнала и индикатор для фиксирования вы-
ходного кода, составьте таблицу соответствия: входной сигнал – 
выходной код. Запишите показания семисегментного индикатора 
при кодах соответствующих числам от 10 до 16. Нарисуйте диа-
грамму работы АЦП для одного из выходных сигналов. 
Включите в разрыв между D8 и D11 регистр D13 с фильтром G1. 
На вход одновибратора подайте импульсы готовности данных 
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(вывод 16 с элемента D8). Проделайте опыты предыдущего абза-
ца. Нарисуйте временные диаграммы работы. 

 

 
Рис. 96. Схема преобразования выходного сигнала датчика в цифровой сигнал 

 
Представьте в виде таблицы взаимосвязь показаний элемента 
индикации, кодированного двоичным кодом выходного сигнала 
АЦП и значения температуры t ºС. 

5. Цифровое регулирование температуры 
Для осуществления цифрового регулирования температуры не-

обходимо замыкать и размыкать цепь тока нагрева.  
Соберите схему, изображенную на рис. 97. 
В качестве измерителя температуры с цифровым выходом ис-
пользуйте схему рис. 96.  
Запоминание информации АЦП осуществляйте с помощью ре-
гистра D13.  
Требуемую температуру задавайте с помощью шифратора D9 
в соответствии с построенной таблицей взаимосвязи показаний 
элемента индикации, кодированного двоичным кодом выходного 
сигнала АЦП, и значений температуры t ºС.  



 182 

 
Рис. 97. Схема цифрового регулирования температуры 

 
Сравнение кодов с выходов регистра D13 и выходов шифрато-
ра D9 осуществляйте с помощью схемы блока сравнения 
(см. рис. 91).  
Выходом схемы блока сравнения через элемент D1.1 и транзи-
стор VT2 коммутируйте цепь нагревательного элемента.  
Для ускорения процессов включите нагревательный элемент 
ЕK через нормально замкнутый контакт K2.3 и тумблер S3 на 
Общ. А управляющий сигнал схемы управления заведите на 
транзистор VT2, к которому подключите катушку реле K2. 
Проведите опыты по цифровому регулированию температуры. 
Опишите работу схемы. 

Содержание отчета 
1. Название лабораторной работы, цель, задание. 
2. Таблица соответствия входных и выходных сигналов блока 

сравнения и формула работы исследуемого блока сравнения.  
3. Таблица соответствия: входной сигнал – выходной код АЦП. 
4. Временные диаграммы работы АЦП. 
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5. Таблица взаимосвязи показаний элемента индикации, кодиро-
ванного двоичным кодом выходного сигнала АЦП, и значения тем-
пературы t ºС. 

6. Описание работы схемы цифрового регулирования температуры. 

Контрольные вопросы 
1. Дайте определение цифровых систем автоматического управ-

ления. 
2. Назовите достоинства и недостатки дискретной передачи сиг-

налов. 
3. Поясните принцип действия параллельного трехразрядного 

регистра. 
5. Поясните схему, используемую в работе. 
6. Как осуществляется цифровое регулирование температуры?
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